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Chapter 1: Introduction
The Fleet Operations Workspace Core (FLOW Core) is OMRON's solution for setting up, integrating and managing an autonomous mobile robot (AMR) fleet within a factory environment.
FLOW Core provides the software tools to connect the autonomous mobile robot (AMR) fleet,
the factory's manufacturing control solution, establish maps, define operational rules, and
ensure safe, consistent operation on the factory floor.
This user's guide covers the basic procedures for installing and using the FLOW Core software
to set up and manage your AMR fleet. Some advanced operating procedures are discussed in
later chapters of the guide.
The following topics provide an introduction to the Fleet Operations Workspace Core.

1.1 Fleet Operations Workspace Core Overview
The Fleet Operations Workspace (FLOW) Core is a suite of mobile-robotics software applications for programming and operating a fleet of AMRs within a factory environment.
The FLOW Core software fully integrates OMRON’s autonomous AMRs and fleet management
appliances (EM2100) to provide complete AMR fleet solutions. It incorporates specific tools to
simplify integration with factory equipment and material-movement solutions (MES and ERP
Solutions - refer to Related Manuals on page 16).
NOTE: While this manual focuses primarily on fleet applications, the tools, capabilities, and techniques explained here can be used by customers deploying
single AMRs as well.
FLOW Core software releases are coordinated to update both the AMR platforms and the fleet
management systems for optimal performance with every new release.
FLOW Core software is installed at the OMRON factory on every AMR that OMRON produces. These AMRs can operate on their own, but are most effectively used in fleets. To support fleet operations, an additional Fleet Manager appliance is necessary.
OMRON provides two Fleet Manager configurations based on its standard EM2100 appliance,
providing customers the option to purchase a Secondary unit as a backup, if desired. See Configure Paired Appliances on page 28 for setting up pairedFleet Managers.
NOTE: The EM2100 is also the platform on which the Fleet Simulator runs.
Refer to the Fleet Simulator User's Manual for information on the Fleet Simulator.
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Table 1-1. OMRON Fleet Managers
Appearance

Product Type Product Name

Model

EM2100
Platform

Primary
Fleet Manager

20271-900

EM2100
Platform

Secondary
Fleet Manager

20271-901

EM2100
Platform

Fleet Simulator

20271-903

1.2 How the Fleet Operations Workspace Components Work
Together
The figure below is a basic system architecture (for a fleet of AMRs) and illustrates the interrelationship between Fleet Operations Workspace Core’s various applications.

EM2100

SetNetGo OS

MobilePlanner

ARAMCentral

Core
SetNetGo OS
ARAM
MARC

Figure 1-1. Components Working Together (LD-60 AMR Shown)
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EM2100
The EM2100 is a network appliance, with built-in processor. It can be used to run the
FLOW Core fleet management software or the Fleet Simulator software. As a Fleet Manager, the
EM2100 coordinates the movement of up to 100 AMRs. It manages maps, AMR configurations, traffic control, and job queuing. FLOW Core licenses are activated on the Fleet Manager.
Version Information: Fleet Simulator support was added in FLOW Core version
1.1.

MobilePlanner
MobilePlanner is the graphical user interface (GUI) for communicating with and configuring
the AMR, and displaying and editing AMR map files. It is the "control center" of the Fleet Operations Workspace Core. Its user interface has the tools for all major AMR activities, such as
observing a fleet of AMRs, commanding individual AMRs to drive, creating and editing map
files, goals, and tasks, modifying AMR configurations, and more.
The AMRs use map files to determine where they are, plan navigable paths to goals, execute
tasks at programmed goals, and to control other AMR tasks.

Figure 1-2. MobilePlanner Interface
From the MobilePlanner interface, you can:
l

Connect to and drive the AMR.

l

Create maps of the environment by importing and analyzing an AMR’s scan data.

l

Edit maps by adding goals (and adding tasks to those goals), docks, forbidden areas,
and more. You can also erase stray or unwanted artifacts, combine pieces of maps, and
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make other changes.
l

Download and upload files, including maps and scan data, to and from an AMR.

l

Set the system configuration parameters for the fleet.

l

With the Fleet Manager, monitor the location and status of all AMRs in a fleet.

l

View and interact with the job queuing manager.

For details, see MobilePlanner Interface on page 51.
MobilePlanner Accounts

User accounts with limited privileges provide the user with access to a limited set of tools for
monitoring AMR and AMR job status, and allow for simple interventions in job execution
sequences. For more information, see MobilePlanner Operator Account Overview on page 54.

SetNetGo
SetNetGo is the operating system that resides on AMRs and the EM2100 appliance. You can
use the SetNetGo software to establish and configure your AMR's communication parameters,
access diagnostic information (for example, download debug info file for service provider use,
manage restore points, etc.), and perform software maintenance (upgrades). You most commonly access the SetNetGo interface through a tab in the MobilePlanner software, and then
use that interface to enable the parameters needed.

Figure 1-3. SetNetGo Interface
For details, see Overview of the SetNetGo OS on page 114.
NOTE: Optionally, you can connect to SetNetGo through a web browser. Refer
to Connecting to SetNetGo via web browser on page 115.
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ARAMCentral
As the fleet management software running on the EM2100 appliance, Advanced Robotics Automation Management (ARAMCentral) provides:
l

Centralized configuration and map management.

l

Job queuing and dispatch.

l

Traffic management.

l

Single-point of integration and communication for software clients and other automation equipment.

ARAM
The Advanced Robotics Automation Management (ARAM) software runs on the AMR's core,
and does the following:
l

l

l

Performs all the high-level, autonomous robotics functions, including obstacle avoidance, path planning, localization, and navigation, culminating in the AMR’s motion.
Manages wired and wireless Ethernet communications with off-board software, for
external monitoring, development, and systems coordination, including coordination of
a fleet of AMRs through the Fleet Manager.
Enables external monitoring and control with the MobilePlanner application.

MARC/Polo
Mobile Autonomous Robot Controller (MARC), which resides on the LD-series AMR core, manages the AMR’s speed and heading, sensor readings, emergency stop systems, bumpers, and
pendant. It also computes and reports the AMR’s odometry readings (X, Y, and heading) and
other low-level operations which it reports to ARAM.
Polo performs the same functions for the HD-1500 AMRs.

1.3 Fleet Operations Workspace Licensing
There are licensing options for both FLOW Core and advanced features. These licenses help
customers manage the costs of their AMR fleets through lower, annual subscription payments
for FLOW Core and activation of advanced features only if they provide benefits to your specific applications. The licenses currently available are listed in the following table. Contact
your OMRON representative or Sales Office for pricing.
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Table 1-2. Available Fleet Operations Workspace Licenses
Product

License
Type

Primary Fleet
Management

Secondary Fleet
Management

Product Description

Model

Subscription License, 1 Yr Fleet Operations
Operating
Workspace Core, Primary
License
License, 5 Yr Fleet Operations
Workspace Core, Primary

20271-800

Subscription License, 1 Yr Fleet Operations
Operating
Workspace Core, Secondary
License
License, 5 Yr Fleet Operations
Workspace Core, Secondary

20271-802

20271-806

20271-807

Cell Alignment
Positioning System
(CAPS)

Perpetual
Feature
License

License, High Accuracy cell align- 20271-805
ment feature for OMRON AMRs

Fleet Simulator

Perpetual
Feature
License

License, Fleet Simulator

20271-804

All of these licenses are field-upgradable. Section 7.6 shows the steps required to acquire or
update FLOW Core subscription, and Fleet Simulator and CAPS perpetual licenses.

1.4 How Can I Get Help?
For details on getting assistance with your OMRON software or hardware, you can access the
corporate website:
http://www.ia.omron.com.
If you need help beyond what is covered in the manual, contact your OMRON representative.
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Related Manuals
Manual

Description

Mobile Robot LD Safety Guide (Cat. No.
I616)

Describes safety information for OMRON LDseries AMRs.

Mobile Robot HD Safety Guide (Cat. No.
I647)

Describes safety information for OMRON HD1500 AMRs.

LD Platform OEM User's Guide (Cat. No.
I611)

Describes the installation, start-up, operation,
and maintenance of the LD-60 and LD-90
AMRs.

LD-250 Platform User's Guide (Cat. No.
I642)

Describes the installation, start-up, operation,
and maintenance of the LD-250 AMR.

HD-1500 Platform User's Manual (Cat.
No. I645)

Describes the installation, start-up, operation,
and maintenance of the HD-1500 AMR

LD Platform Peripherals Guide (Cat. No.
I613)

Covers peripherals for LD AMRs, such as the
Touchscreen, Call/Door box, and Acuity Localization options.

Mobile Robots - HD Platform Peripherals
Manual (Cat. No. I646)

Covers peripherals for HD AMRs, such as
HAPS.

EM2100 Installation Guide (Cat. No.
I634)

Describes the installation and initial configuration of an EM2100 appliance.

Fleet Operations Workspace Migration
Guide (Cat. No. I636)

Describes the procedures for migrating your
AMR from legacy to FLOW Core software, and
from an EM1100 to an EM2100.

Fleet Operations Workspace Core Integration Toolkit User's Guide (Cat. No.
I637)

Describes specific tools to simplify integration
with factory equipment and material-movement solutions such as manufacturing execution systems (MES) and equipment
resource planning (ERP) solutions.

Fleet Simulator User's Manual (Cat. No.
I641)

Describes the operation of the Fleet Simulator.

Advanced Robotics Command Language
Enterprise Manager Integration Guide
(Cat. No. I618)

Describes the Advanced Robotics Command
Language (ARCL) version for use with the
EM2100 software. ARCL is a simple text-based
command and response server used for integrating the Fleet Operations Workspace Core
platform with an external automation system.
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2.1 Safety and Regulatory
OMRON LD AMRs adhere to the following domestic and international safety regulations:
l

l

l

EN 1525 “Safety of Industrial Trucks. Driverless Trucks and their Systems”
ANSI 56.5:2012 “Safety Standard for Driverless, Automatic Guided Industrial Vehicles
and Automated Functions of Manned Industrial Vehicles”
JIS D 6802:1997 “Automated Guided Vehicle Systems - General Rules on the Safety”

OMRON's HD-1500 AMRs are evaluated to the following standards:
l

EN ISO 10218-1

l

UL 1740

l

EN 60204-1

l

EN ISO 13849-1

2.2 Warnings, Cautions, and Notes
Where needed, this user guide calls out critical, important, or emphasized text via special alert
notifications. Below are explanations of the special alert notifications used in this manual:

!

WARNING: This indicates a potentially hazardous situation which, if not
avoided, will result in minor or moderate injury, or serious injury or death.
Additionally, there may be significant property damage.

!

CAUTION: This indicates a situation which, if not avoided, could result in
minor or moderate injury or in property damage.

IMPORTANT: Important indicates information that the user needs to know to
use the system correctly.
NOTE: Notes provide supplementary information, emphasize a point or procedure, or give a tip for easier operation.
Version Information: This indicates information that only applies to certain versions of software or hardware.
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2.3 General Safety Precautions
Read the installation and operation instructions, as well as the appropriate robot user's guide
and robot safety guide before using the equipment.
l

Do not ride on the AMR.

l

Do not exceed the AMR’s maximum weight limit.

l

Limit operation to areas with no slope.

l

l

l

l

l

Do not drop the AMR, run it off a ledge, or otherwise operate it in an irresponsible manner.
Do not get the AMR wet, or expose the AMR to rain or moisture. The AMR has an IP
rating of IP20.
Do not use power extension cords with the docking station unless properly rated.
Do not run the AMR if hair, yarn, string, or any other items are wound around the
AMR’s axles or wheels.
Never access the AMR’s interior with the charger attached. Immediately disconnect the
battery after opening the battery compartment door.

l

Never short the battery’s terminals together.

l

Do not use parts (including charging docks, etc.) not authorized by OMRON

2.4 Safety Commissioning
Safety standards require testing of the AMR's safety systems by a trained and qualified person,
both before leaving the factory and again at the customer's site.
Safety commissioning is executed from the MobilePlanner main menu. Access and execute the
safety commissioning procedure from MobilePlanner by selecting Robot > Safety Commissioning.
The safety commissioning procedure is guided by on-screen prompts. The instructions that
you see will be based on the type of robot that you have connected. The procedures will test
each E-Stop and Safety Laser on the AMR, as well as the E-Stop on the pendant. Details for
running these procedures are given in each AMR user guide.

2.5 What to Do in an Emergency
Press the E-Stop button (a red push-button on a yellow background/field) and then follow the
internal procedures of your company or organization for an emergency situation. If a fire
occurs, use a type D extinguisher: foam, dry chemical, or CO2 .

2.6 Additional Safety Information
We provide more safety information in the following manual:

Mobile Robot LD Safety Guide (Cat. No. I616) and Mobile Robot
HD Safety Guide (Cat. No. I647)
The Mobile Robot LD Safety Guide (Cat. No. I616) and Mobile Robot HD Safety Guide (Cat. No.
I647) provide detailed information on safety for our AMRs. They also give resources for more
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Chapter 3: Fleet Manager Configuration and
Operation
The Fleet Manager capabilities within FLOW Core provide tools for programming and configuring individual AMRs and fleets, and for centralized job dispatch and real-time AMR monitoring within your facility.

3.1 EM2100 Configuration Overview
This section provides instructions for setting up and connecting the AMRs and Fleet Manager
to a network.
OMRON's EM2100 appliance provides the operating environment for the FLOW Core software. It will be the primary interface device to the network and any PC(s) running MobilePlanner. The EM2100 appliance comes pre-loaded with a temporary, 120 day, FLOW Core license,
which allows initial set-up, testing, and validation to begin immediately, without a full subscription license. A FLOW Core license must be purchased after the 120 day set-up period.
NOTE: The EM2100 can also run in the Fleet Simulator operating mode, with a
Fleet Simulator license. Refer to the Fleet Simulator User's Guide.

Configuration Tasks Overview
NOTE: This section assumes that you have read and followed the instructions
in the EM2100 Installation Guide (Cat. No. I634).
To configure the EM2100 appliance as a Fleet Manager, you must do the following tasks,
which are described in detail later in this guide:
l

Configure the network settings for the appliance Management Ethernet port.

l

Configure the network settings for the FLEET ETH2 Ethernet port.

l

Connect the Management and Fleet ports to the LAN.

l

Define the login information.

l

Configure each AMR to connect to the EM2100.

l

Customize each AMR, if desired.

If you install a Secondary EM2100 appliance and configure Autosync, you must also:
l

Install the same FLOW Core software version on the Secondary as is on the Primary
appliance.

l

Configure a unique IP address for the Management port.

l

Connect the Management port to the LAN.

l

Connect the FLEET ETH2 port to the LAN.
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l

Enter the Secondary Management IP address on the Primary appliance.

l

Generate and download a key from the Primary appliance.

l

Set the Secondary appliance Autosync role to Secondary.

l

Upload the key to the Secondary appliance.

l

Verify that the status of both appliances is active.

l

Create a direct network connection between the Primary and Secondary appliances.

3.2 Power Interruptions
Use the front momentary power switch to turn the EM2100 on and off. The rear power switch
should remain on unless you are uninstalling the appliance.

Power Interruptions on a Standalone EM2100
If there is an interruption to the power supply for any reason or duration, a standalone
EM2100 automatically returns to its previous power state.
l

l

A standalone appliance that was shut down and powered off when the interruption
occurred remains shut down after you restore power.
A standalone appliance that was powered on when the interruption occurred restarts
automatically after you restore power.

After recovery from a power interruption, the EM2100 saves its job queue status and recovers
the queue automatically after it restarts following a power failure. This does not apply to an
operator-initiated emergency power off. Refer to: Power Interruptions on page 23.

Power Interruptions on an Autosync Appliance
This section assumes that you configured Autosync on two EM2100 appliances and connected
each appliance to separate power circuits for redundancy. Providing that only one circuit was
affected, one appliance should remain operating normally during the power interruption. The
sequence of events and method of recovery depends on which appliance is affected:
A power interruption on the Primary appliance results in a loss of connectivity with
AMRs and MobilePlanner. You should:
l

l

Determine whether the problem is a power outage or a loss of network connectivity.
Manually reconfigure the Secondary appliance to become the Primary Appliance. Fleet
Management functions are restored but Autosync status is now disabled.
Autosync will need to be re-configured once the power issue with the original EM2100
appliance is resolved.

l

l

23

Verify that MobilePlanner and AMRs reconnect to the Fleet IP address.
Review the job queue status in MobilePlanner and verify the status of AMRs to make
sure that no jobs are incomplete.

l

Restore power to the former Primary appliance.

l

Change the former Primary appliance to a role of Secondary appliance.

Fleet Operations Workspace Core User's Manual
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A power interruption on the Secondary appliance results in no loss of connectivity
with AMRs and MobilePlanner. You should:
l

l

l

Verify that MobilePlanner and AMRs are connected to the Fleet IP address.
Review the job queue status in MobilePlanner and verify the status of AMRs to make
sure that no jobs are incomplete.
Restore power to the Secondary appliance. Autosync will be restarted if it was running
when the power was interrupted. Fleet operations should be unaffected.

If both Autosync appliances are affected by a power interruption, they both behave
as described in: Power Interruptions on a Standalone EM2100 on page 23:
l

l

l

All fleet operations are terminated during the power interruption.
Normal Active Autosync operation resumes automatically after you restore power to
both appliances.
The Primary EM2100 saves its job queue status and recovers the queue automatically
after it restarts. Autosync will reconnect automatically when power is restored.

3.3 Set the IP Address on a Client PC's Network Adapter
Use the Maintenance Ethernet port to connect a client PC to the SetNetGo operating system.
IMPORTANT: You must assign a static IP address. Do not use a DHCP server.
Configure the network adapter IPv4 address on the Client PC as follows:
1. Connect an Ethernet cable from the client PC’s Ethernet port to the Maintenance Ethernet port on the EM2100 appliance.
2. In the command field on the Windows taskbar, enter the following command to open
the Network Connections dialog: ncpa.cpl
3. Open the network properties of the PC ethernet network adapter used to connect to the
Maintenance Ethernet port on the EM2100 appliance.
4. Double-click TCP/IPv4 to open the Internet Protocol properties dialog.
5. Enter as the IP address: 1. 2. 3. 5, or any IP address in the range 1. 2. 3. 0 to 1. 2. 3. 255,
excluding 1. 2. 3. 4. (this is reserved for the Maintenance port).
6. Enter as the subnet mask: 255. 255. 255. 0.
7. Click OK to close the Internet Protocol dialog, and then click OK to close the Ethernet
Adapter dialog.
In future, you can use the Maintenance Ethernet port for emergency access to the Appliance at
IP address 1.2.3.4. (For example, if you lose the password or if there is a network IP address
conflict.)

3.4 Connect Your PC to SetNetGo on the EM2100
SetNetGo enables you to configure and manage EM2100 and AMR settings. This section
describes how to access SetNetGo through the Maintenance port to perform initial configuration.
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The user interface for SetNetGo on an EM2100 provides a different set of parameters and
options compared to SetNetGo on an AMR. The upper left of the screen shows EM2100, LD,
LD-250, or HD depending on your SetNetGo context (the device on which it runs, such as the
OMRON LD-series AMRs).

Configure Access and Security
After you connect to the Maintenance Port as described in: Set the IP Address on a Client PC's
Network Adapter on page 24 you can open the SetNetGo web interface.
Connect your browser to SetNetGo and configure SetNetGo access as follows:
1. In the SetNetGo web interface, click the Security Tab and then click SetNetGo Access
and check Enabled next to the following:
Maintenance Interface is automatically enabled.
l

Wireless Ethernet/User LAN Ethernet

l

(Optional) Remote Reboot.

2. Change the account password (default is no password) as required and click Apply.
NOTE: Passwords are limited to a maximum of 20 alphanumeric characters.
For increased security, specify a long (10+ characters) password string with both
uppercase and lowercase letters. Include several digits.

3.5 Configure Management Interface Network Settings
To configure the Management Network, you require:
l

l
l
l

A dedicated static IP address. (Do not use 1.2.3.4. That address is permanently assigned
to the Maintenance Ethernet port.)
The subnet mask for the Management network.
The IP address of the network Gateway.
The IP address of a Domain Name Server (DNS) (this is only required if any hostnames
will be used in the Fleet Manager configuration), so that the Fleet Manager can resolve
all IP addresses.

Configure the Management Interface network connections as follows:
1. In the SetNetGo web interface, click the Network tab.
2. Click Management Interface and enter the:
a. IP address.
b. Subnet mask.
c. Network Gateway IP address (typically a router).
3. Enter the IP address of your Domain Name Server (DNS), if required for devices other
than the appliance and the fleet. Otherwise, leave it as 0.0.0.0.
4. Click Apply.
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A message dialog informs you of the status of the change, and whether there is any affect on
operations such as a restart or a time delay before the change takes effect.

3.6 Configure the Operating Mode
Configure the Operating Mode as follows:
1. In the SetNetGo web interface, click the System tab.
2. Click Mode.
3. Select the operating mode in which you will be using this EM2100.
The choices will be:
l

Unconfigured (this is how the EM2100 ships)

l

Standalone Fleet Manager

l

Paired Fleet Manager

l

Fleet Simulator

If a mode is greyed out, it means that you don't have the license to support that operating mode. Refer to Licensing Tab on page 126.
4. Click Apply.
You will be shown several warning pop-ups. Respond OK to all.
The EM2100 will reboot.
At this time, Status > Home > Mode of Operation should show the operating mode
that you selected.
A message dialog informs you of the status of the change, and whether there is any effect on
operations such as a restart or a time delay before the change takes effect.

3.7 Configure the Fleet Interface Network Settings
To configure the Fleet Interface, you require:
l

l
l

A dedicated static IP address to assign to the Fleet Interface port. This IP is allowed, but
not required, to be on the same subnet as the Management IP. Do not use 1.2.3.4,
because that address is permanently assigned to the Maintenance Ethernet port.
The subnet mask for the network that your Fleet will use.
The IP address of the network Gateway.

Configure the Fleet Interface network connections as follows:
1. In the SetNetGo web interface, click the Network tab.
2. Click Fleet Interface and enter the:
a. IP address.
b. Subnet mask.
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c. Network Gateway IP address (typically a router).
3. Click Apply.
A message dialog informs you of the status of the change, and whether there is any affect on
operations such as a restart or a time delay before the change takes effect.
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3.8 Configure Paired Appliances
The default (shipped) configuration for an EM2100 is Unconfigured. The user will need to configure it as either Standalone or Paired Fleet Manager.
To create an Autosync pair, refer to Configure the Primary Appliance on page 29 and Configure the Secondary Appliance on page 30. The paired appliances then function as follows:
l

l

The Primary unit is a fully-functional EM2100, running the Fleet Operations Workspace
Core and actively controlling the fleet.
The Secondary unit is powered on, with its web interface accessible to the Primary unit.
However, the fleet management functions are inactive on the Secondary unit, and it is
inaccessible from MobilePlanner or AMRs.

The Primary Fleet Manager has two active IP addresses, while the Secondary has only one active IP address.

EM2100 Autosync — Ethernet Cabling
The following figure shows the physical connection of Ethernet cables to the appliances.

Figure 3-1. Cabling for an EM2100 Fleet Manager Pair
Callout

Description

1

EM2100 configured as a Primary appliance.

2

EM2100 configured as a Secondary appliance.

3

Ethernet cables to the LAN switch:
l
l

Primary and Secondary MGMT ETH1
Primary and Secondary FLEET ETH2

Tasks in Autosync Setup
Before you set up Autosync, make sure that you have:
l

Installed the Primary appliance and connected it to the network.

l

Configured the Maintenance Ethernet interface on the Primary appliance.
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l

Physically installed the Secondary appliance hardware, as described in the EM2100
Installation Guide.

The tasks required to set up autosync between a Primary and Secondary appliance are:
l

Configure the Primary appliance with a Fleet IP Address.

l

Enter the Secondary appliance IP Address in the Primary appliance.

l

Generate and Download the Primary key (to your PC).

l

Set the Secondary appliance Autosync role to Secondary.

l

Upload the Primary key to the Secondary appliance.

Configure the Primary Appliance
Do this only if you have two Fleet Manager appliances, and you want to configure one as a
Primary Fleet Manager. You must first configure the Management and Fleet networks and
cable the appliances.
1. In the SetNetGo web interface, click the System tab, then Mode.
2. Select Paired Fleet Manager from the drop-down menu. Click Apply.
You will get a "Confirm Appliance Mode Change" pop-up message.

Figure 3-2. Confirm Appliance Mode Change Window
3. Click OK.
You will get a second pop-up with a warning that this operation will interrupt the
fleet management.
4. Click OK.
5. Click the Pairing button that appears in the left margin of the screen.
6. From the drop-down menu next to the Pairing Role, select Primary, and click Apply.
7. Enter the IP Address of the Secondary appliance. Click Apply.
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8. You will get a message to confirm changes, saying that ARAMCentral will restart, disconnecting AMRs and clients. Click OK.
9. You will get a confirmation message that the changes were successfully applied. Click
OK.
10. Click Generate New Key to create an SSL key, or Download Existing Key, if you previously created an SSL key.
Uploading the SSL key to the Secondary appliance grants permission for the Primary
to perform RPC calls required for synchronization.
11. You are prompted for a location to save the key file. Enter a location (path) where you
want to save the file on your PC, so you can later upload it to the Secondary appliance.
12. A warning message indicates the pending disconnection of AMRs and clients. Click
OK.
Your Primary Fleet Manager is now configured to run as part of a pair.

Configure the Secondary Appliance
Do this only if you have two Fleet Manager appliances, and you want to configure one as a
Secondary Autosync appliance. You must first:
1. In the SetNetGo web interface, click System tab, then Mode.
2. From the drop-down menu choose Paired Fleet Manager and click Apply.
3. You will get a "Confirm Appliance Mode Change" pop-up message. Click OK.
4. You will get a second pop-up with a warning message that this operation will interrupt
the fleet management. Click OK.
5. A Pairing selection will appear in the left margin of the screen. Click on Pairing.

Figure 3-3. Pairing Selection, Left Bar
6. From the drop-down menu, next to the Pairing role, choose Secondary. Click Apply.
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You will get a Confirm changes message that ARAMCentral will halt, disconnecting
AMRs and clients. Click OK.
7. You will get a confirmation message that the changes successfully applied. Click OK.

Figure 3-4. Changes Successfully Applied Window
8. Click Choose File to select the Primary SSL key from your PC to chose the proper file.
Enter the name and path of the file to upload the key from the PC.
9. Click Upload.
Your appliance is now configured as a Secondary appliance.
NOTE: Although the Fleet Interface settings are saved for the Secondary appliance, the interface is inaccessible.
When the connection is complete, the Primary and Secondary appliances show a Current
Status of active.

3.9 Configure Each AMR to Connect to the Fleet Manager
Before you can use the Fleet Manager appliance to manage AMRs, you must configure each
AMR to connect to the appliance. To do so, you must connect to each AMR.
When an AMR connects to the appliance, the Fleet Operations Workspace Core overwrites the
AMR's configuration parameters with Fleet parameters.

AMR Configuration Settings
To connect an AMR to the EM2100 appliance:
1. Launch MobilePlanner on your client PC and connect to the AMR's IP address.
If this is a new AMR, its IP address will be the factory setting of 1.2.3.4 for LD-series
AMRs, and 169.254.10.15 for the HD-1500 AMR. The connection must be hard-wired,
because the AMR's wireless won't be configured yet.
2. Open the Config tab.
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3. Check Show Expert Parameters to show the advanced configuration parameters.
4. From MobilePlanner, Config select Fleet and then Fleet Manager Connection.

Figure 3-5. Fleet Manager Connection Screen
5. Check the ConnectToFleetManager checkbox.
6. Enter the IP address of the EM2100 appliance in the
FleetManagerAddress field.
NOTE: This is the Fleet IP address, not the Management IP address of the
EM2100.
7. Enter an identifier in the Identifier field. You must use unique identifiers for each AMR.
Do not change this identifier after initial setup.
Repeat these steps for each AMR that you want to add to the fleet controlled by this EM2100
Fleet Manager.

Fleet-Level Settings
From MobilePlanner, Config, on the Fleet Manager:
1. Select Fleet and then Fleet Features.
2. Check the FleetManagerGatherScans box.
This enables Fleet Operations Workspace Core to gather any scan files created by the
AMRs.
3. Back up (copy) any required maps to a storage location.
4. [OPTIONAL] Check DeleteUnusedMaps to permanently delete unnecessary map files
from each AMR.
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3.10 What to do if a Primary Fleet Manager Fails
This section applies only if you installed a second EM2100, autosynchronized with the
Primary Fleet Manager.
In event of failure:
1. Using the SetNetGo interface, connect to the Management IP address for the Secondary
Fleet Manager EM2100 appliance.
2. Click Apply (or click Reset to retain the previous values without your changes).
The AMRs automatically reconnect to the new Primary appliance.
The queue, configuration, and map data on the new Primary is identical to that of the old
Primary, prior to failure. Depending on exact network configuration, it takes between 1-3
minutes for AMRs to reconnect and resume operation.
The original (failed) Primary appliance can now be safely removed from the rack without causing disruption to the fleet. The following considerations apply:
l

l

The new Primary operates on the same Fleet IP as the old Primary appliance. Do not
reconnect the old Primary to the network without first reconfiguring it. Doing so might
cause a network IP conflict.
The failed Primary has the queue file, which is no longer current. Before putting the
failed Primary back into service, you should manually clear the queue. See Manually
Clearing (Flushing) the Entire Queue on page 200.

3.11 Remove and Replace EM2100 Appliances from Autosync
This section describes how to remove an appliance from an Autosync configuration.

Remove a Primary Fleet Manager Appliance from Autosync
You might need to remove a Primary Fleet Manager appliance from an Autosync configuration while maintaining fleet operations. For example, if the Primary appliance is generating errors that indicate a potential failure or degraded performance. This procedure
assumes that you do not make any changes to the software and data stored on the removed
appliance.
To safely remove an EM2100 Primary Fleet Manager appliance from an Autosync configuration, you must promote the Secondary appliance to the Primary role as covered in the
previous section. You can then safely remove the Primary as follows:
1. Verify that fleet operations are normal and job processing is on schedule.
2. Reconfigure the Primary appliance as a Secondary appliance. See: Configure the Secondary Appliance on page 30.
MobilePlanner and fleet AMRs might lose their network connection to the appliance.
3. Reconfigure the Secondary appliance as the Primary appliance. See: EM2100 Configuration Overview on page 22.
4. Power off the Secondary appliance.
5. The Status tab in SetNetGo will now show that Autosync for the new Primary appliance
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is disabled (it is now a standalone appliance).
6. Verify that MobilePlanner can connect to the Fleet IP, that fleet AMR operations resume,
and jobs are processed as scheduled.
To restore a removed EM2100 appliance or to replace it with a new appliance, it should be put
into the role of Secondary Fleet Manager, not Master. This will cause less disruption to the
fleet.

Remove a Secondary Fleet Manager from Autosync
You might need to remove a Secondary Fleet Manager appliance from an Autosync configuration while maintaining fleet operations. For example, if the Secondary Fleet Manager
appliance is generating errors that indicate a potential failure or degraded performance. This
operation is less disruptive than removing a Primary Fleet Manager.
IMPORTANT: This procedure assumes that you do not make any changes to
the Fleet Manager configuration or to the software and data stored on the appliance.
To remove a Secondary Fleet Manager appliance from an Autosync configuration:
1. Verify that fleet operations are normal and job processing is on schedule.
2. Power off the Secondary Fleet Manager appliance.
If a soft shutdown doesn't work, use a hard shutdown. Refer to the EM2100 Installation
Guide for details on hard- vs. soft-shutdowns.
3. Verify that MobilePlanner can connect to the Fleet IP, that fleet AMR operations continue, and that jobs are processed as scheduled.
To restore a removed Secondary Fleet Manager appliance:
1. Verify that fleet operations are normal and job processing is on schedule.
2. If you have removed any network cables, reinstall them. Configure Paired Appliances
3. Power on the Secondary Fleet Manager appliance. (This should not affect fleet operations or Ethernet connections to MobilePlanner and AMRs.)
Both appliances now indicate that Autosync is Active.
If no changes have been made to the configuration, the Secondary appliance will come
back up as a Secondary, but the Primary will be running as a Standalone.
4. Reconfigure the Primary appliance to be paired with the Secondary. See Configure the
Primary Appliance on page 29.

20569-020 Rev. D

Fleet Operations Workspace Core User's Manual

34

Chapter 4: Fleet Operations Workspace Core
Software
The Fleet Operations Workspace Core (FLOW Core) software has the tools and features to help
you get your AMR up and running quickly. This chapter covers the initial steps needed to
access your AMR with the PC and to begin using the Fleet Operations Workspace Core software.
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4.1 How Do I Begin?
Before you can start using your AMR, there are a number of initial set-up and configuration
steps you need to complete.
NOTE: It is assumed that, prior to beginning fleet programming with FLOW
Core, all AMRs and EM2100 appliances being used in the fleet have been
unpacked, installed and set-up according to their respective user guides.
Procedure

Reference

Install the MobilePlanner software on your PC.

Install the MobilePlanner Software on page
39

Connect your PC to the AMR via Ethernet cable.

Step 1: Connect Your PC to the AMR via Ethernet on page 41

Configure the AMR for wireless communication.

Step 4: Configure Your AMR's Network and
Security Settings on page 47

Establish a wireless connection to the AMR.

Step 5: Connect to the AMR Wirelessly on
page 48

Scan the AMR's environment.

Scanning the Operating Area on page 88

Convert the scan to a map.

Convert the Scan into a Map on page 89

Use MobilePlanner software to edit (erase stray
and other dynamic features from) the map.

Editing a Map File on page 93

Add docks, forbidden zones, goals, and route(s)
between goals, etc. to the map.

Working with Map Files on page 90

Save the edited map on the AMR.

Saving the Map on the AMR on page 108

Localize the AMR.

Set the AMR's Initial Location on page 111

Create some tasks, and have the AMR
begin performing them.

AMR Tasks on page 150

4.2 End-User License Agreement (EULA)
Users will be presented with and must agree to the End User License Agreement (EULA) in
order to access and use any of the FLOW Core software content and functionality.

Definitions
l

l

l
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The Click-to-Accept (CTA) EULA will pop up:
l

When the FLOW Core software is installed.

l

Whenever the FLOW Core software is updated.

l

Upon first launching SetNetGo software (Out Of the Box).

l

Whenever the SetNetGo software is updated.

l

Whenever a V2C (license) file is uploaded (first time, updates, and renewals).
New entitlements are not required when existing dongles are transferred from a failed
EM2100 or AMR to new EM2100 or AMR hardware. Therefore, no EULA is required in
these cases.

l

Whenever a new user-facing language is selected (in order to ensure delivery of the CTA
EULA in the appropriate language).

Once the CTA EULA Prompt is Triggered
1. The CTA EULA pop-up will display in the language that matches the software
installed.
2. The User must scroll through the entire End User License Agreement before the Accept
button is enabled (this button is greyed-out until then).
3. The User must check either "End User" or "Manufacturer or System Integrator" before
the Accept button is enabled.
Accepting as "End User" will stop the CTA from re-triggering upon launching the software. All other triggers will still prompt user with the CTA pop-up.
Accepting as "Manufacturer or System Integrator" will not stop the CTA from re-triggering upon launching the software. This is to ensure that the End User gets prompted
when first launching the software "out of the box".
4. The User can either click Accept, or abort the process.
Aborting the CTA EULA process will cancel and close out of the process that triggered
the CTA EULA pop-up (V2C Upload, Language Change, Software Update, Software
Install, First-Time/Out Of the Box Software Start Up).
In this case, the User can re-trigger the CTA EULA prompt by initiating one of the trigger processess listed above.
5. If the software license is activated at the factory, in the Fleet Simulator bundle for
example, the CTA EULA pop-up will be displayed and a selection must be made prior
to the Simulator performing its intended functions.
The intent here is that the Fleet Simulator should be able to connect to SetNetGo and
MobilePlanner but no configuration or simulations can be run until the user clicks the
Accept button.
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Capturing CTA Interactions
1. Every time the CTA EULA process is initiated and completed, the following data shall
be captured and logged:
l

What triggered the CTA EULA prompt (e.g "Software Update", "V2C Upload",
etc.)

l

Date/Time CTA EULA process was triggered

l

Date/Time CTA EULA process was completed

l

Whether CTA EULA was Accepted, or the process was aborted (either of these
will be considered as completed.

2. Users can access a reference log file, but will not have access to or the ability to make
changes to the source data populating these logs.
NOTE: The Click-to-Accept EULA functions only apply to the FLOW Core software. There is no impact on the Legacy MSS 4.X software.

4.3 Install the MobilePlanner Software
Before setting up a wireless connection to your AMR, you will need to install MobilePlanner
on your PC. This software is the primary interface to the Fleet Manager and AMRs, and allows
programming of the AMR fleet.

System Requirements
Verify that your PC meets the following requirements before installing MobilePlanner:
l

OS: Windows 7 (32-bit/64-bit), Windows 8 (32-bit/64-bit),or Windows 10 (32-bit/64-bit).

l

CPU: 1.5 GHz Dual-core (min).

l

RAM: 1.5 GB (min) 4 GB RAM recommended).

l

GPU: 256 MB (min).

l

HDD/SSD: At least 250 MB available space.

l

Monitor: XGA 1024 x 768.

Installing MobilePlanner
Ensure that your PC meets the system requirements, then install (or download and install)
MobilePlanner.
NOTE: The MobilePlanner software installs into a MobilePlanner5 directory.
This different install directory allows you to use the relevant MobilePlanner version with your fleet.
Version Information: Only MobilePlanner software version 5 or higher is compatible with FLOW Core. It is not compatible with OMRON fleets running on
Mobile Software Suite version 4.X or earlier. Refer to https://automation.omron.com for release notes or contact your OMRON representative for
more information.
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1. Use one of the following methods to locate and/or install the MobilePlanner software:
a. By USB drive: insert the software media (USB drive included with your AMR’s
documentation) into your PC, and browse to the USB drive to locate and install
the software.
From your EM2100: Open SetNetGo > Software > Manage Installed Software
> MobilePlanner > It can be downloaded here. (Click on the "here" link in the
EM2100 user interface, shown near the bottom of the following figure.)

Figure 4-1. Manage Software Download
b.
c. By download: Contact your OMRON representative for assistance with downloading MobilePlanner software.
To download MobilePlanner from the internet, access www.robotics.omron.com
or contact your OMRON representative.
2. Launch the installer and, when the welcome screen appears, follow the prompts in each
installation wizard window to complete the installation.
If you used SetNetGo or downloaded the software, this will usually be in your Downloads folder. The actual location is determined by the settings in the browser that you
use.
3. Click Finish when done.
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4.4 Configure the AMR’s Wireless Communications
Before you can start working with your AMR, you have to configure it for wireless communication (via WiFi) using your PC. To do this, you will first have to connect your PC to the
AMR via Ethernet cable to gain access to the AMR's wireless settings. In general, the set-up
process is as follows:
l
l
l
l
l

Connect your PC to the AMR via Ethernet
Set your PC’s IP address
Connect to SetNetGo
Configure the AMR’s network settings
Establish a wireless connection to the AMR
NOTE: The setup steps above assume that the AMR is fully-charged, powered
up, and ready. If this is not the case, please refer to your AMR’s user guide for
complete setup instructions.

Step 1: Connect Your PC to the AMR via Ethernet
To connect your PC to the AMR:
1. Open the AMR's maintenance access panel (left side, upper right corner), by pressing
the access panel’s upper left corner (see image below) into the side of the AMR.

Figure 4-2. Maintenance Door Location
2. Using a standard (pass-through) or cross-over Ethernet cable, connect your PC directly
to the AMR's maintenance Ethernet port. Refer to the following three figures. The AMR
will auto-detect the cable type.
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Figure 4-3. Maintenance Port Connection, LD-60 and LD-90

Figure 4-4. Maintenance Port Connection, LD-250

Pendant

Figure 4-5. Maintenance Port Connection, HD-1500
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Step 2: Set the IP Address on Your PC
In order to configure WiFi on your AMRs, the LD-series AMRs and the HD-1500 AMRs are
accessed differently. If you have a combination of the two, we suggest that you set up all of the
LD-series AMRs and all of the HD-1500 AMRs as two separate procedures.
LD-Series AMR IP Address Setup

Manually set your PC’s Ethernet port IP address to 1.2.3.x, where x is any number 1 - 254,
except 4 (which the AMR uses), and a Subnet mask of 255.255.255.0. No special DNS or gateway settings are needed.
NOTE: The LD-series AMR's maintenance Ethernet port is always enabled and
permanently set to IP address 1.2.3.4, with a Subnet mask of 255.255.255.0, for
direct, wired access to the on-board systems.
1. Open your PC's Network Connections window.
2. Right-click on your PC’s Local Area Connection Ethernet connection, and select Properties.

Figure 4-6. Windows Local Area Connection Properties Dialog
3. In the Local Area Connection Properties dialog box, click on the TCP/IP protocol your
network uses (for example, Internet Protocol Version 4 (TCP/IPv4)), then click Properties.
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Figure 4-7. Windows Internet Protocol Properties Dialog
4. In the TCP/IP properties dialog box, click the Use the following IP address: radio button
and enter an appropriate IP address (for example, 1.2.3.5) and Subnet mask
255.255.255.0.
5. Click OK.
6. Close the Network Connections window.
HD-1500 AMR IP Address Setup

To enable DHCP or change other TCP/IP settings (Windows 10)
1. Select Start, then select Settings > Network & Internet.
2. Do one of the following:
l

l

For a Wi-Fi network, select Wi-Fi > Manage known networks. Choose the network you want to change the settings for, then select Properties.
For an Ethernet network, select Ethernet, then select the Ethernet network you’re
connected to.

3. Under IP assignment, select Edit.
4. Under Edit IP settings, select Automatic (DHCP) or Manual.
To specify IPv4 settings manually (IPv6 is not supported)
a. Under Edit IP settings, choose Manual, then turn on either IPv4.
b. To specify an IP address, in the IP address, Subnet prefix length, and Gateway
boxes, type the IP address settings.
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c. To specify a DNS server address, in the Preferred DNS and Alternate DNS
boxes, type the addresses of the primary and secondary DNS servers.
l

l

When you select Automatic (DHCP), the IP address settings and DNS server
address setting are set automatically by your router or other access point (recommended).
When you select Manual, you can manually set your IP address settings and
DNS server address.

5. When you’re done, select Save.

Step 3: Access SetNetGo Software
The SetNetGo software lets you manage a variety of settings related to the AMR's connectivity.
You can access SetNetGo from MobilePlanner (most common), or a secure web browser (for
example, Chrome, Firefox, or Internet Explorer).
To Access SetNetGo from MobilePlanner

NOTE: Only start the following procedures if your computer is connected to the
AMR via Ethernet cable.
1. Open the MobilePlanner software.
2. For an LD-series AMR, enter 1.2.3.4 into the AMR address field, then click Connect.
For an HD-1500 AMR, enter 169.254.10.15 into the AMR address field, then click Connect.
3. Click the SetNetGo button (the large part of that icon, not the checkbox).
4. Click the SetNetGo tab.
To Access SetNetGo via Web Browser

1. Start a web browser on your computer.
2. Enter the URL https://1.2.3.4 in the address bar of the web browser.
This is the AMR’s maintenance Ethernet address. When accessing the software from a
wired maintenance Ethernet port, you do not need a username or password.

Figure 4-8. Browser Address Field
NOTE: You can ignore the certificate error that appears on the SetNetGo webpage; the error appears because the hardware is not attached to the Internet.
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The SetNetGo startup screen is shown the following figure.

Figure 4-9. SetNetGo Interface
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Step 4: Configure Your AMR's Network and Security Settings
To access your AMR remotely, you should set up a static IP address for each AMR. The
SetNetGo interface allows you to configure your hardware’s Ethernet settings, configure serial
and TCP forwarding, and upgrade the on-board software. If you are not familiar with setting
up a network or do not have an assigned IP address for the AMR, please see your system
administrator.
IMPORTANT: If you change any values in a SetNetGo screen, you must click
Apply before switching to another sub-screen, or those values will not be saved.
For example, when changing wireless Ethernet settings, be sure to click Apply
before navigating back to the dashboard.
To configure network settings, click the Network tab at the top of the SetNetGo screen.

Figure 4-10. SetNetGo Interface
Network
Menu
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Description

Wireless
Ethernet

Sets up your wireless Ethernet connection to your AMR, including
IP settings, WiFi network settings, security settings, and radio settings.

User LAN
Ethernet

This screen has user-configurable settings for interface mode, IP
address, netmask, DHCP server for accessories, and DHCP IP range.

RS-232 Port
Forwarding

Controls forwarding of serial data to a TCP port on the wireless and
internal wired Ethernet networks, where the data is re-directed to a
TCP port on an IP address accessible via the Wired Ethernet interface
(which must be set to accessory mode). There is also port-forwarding
for the two extra on-board serial ports to a TCP port on the wireless Ethernet interface.
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Network
Menu

Description

Ethernet
Forwarding

Use the settings on this screen to control TCP port forwarding from
your User LAN Ethernet interface to the wireless Ethernet interface.

Utilities

Use this screen to ping an IP address for testing and diagnostic purposes.

Set the Username and Password to secure access to the AMR

You must add one or more users, and assign usernames and passwords. Click the Security
tab, then click the Enabled radio button and populate the username/password fields (see Setting Up User Accounts on page 132).

Step 5: Connect to the AMR Wirelessly
Now that you have installed the Fleet Operations Workspace Core and configured the AMR for
wireless communications, connect to your AMR.
1. (If not already running) double-click the MobilePlanner icon on your PC desktop.

Figure 4-11. MobilePlanner Desktop Icon
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Figure 4-12. MobilePlanner Interface
NOTE: If running MobilePlanner from an Operator account, the interface
will look slightly different than above.
By default, the Fleet, Config, and Map buttons have checkmarks indicating those features will automatically load when you connect to the AMR.
2. In the Connect field, enter the IP address of the AMR, then click Connect.
3. Enter User Name and Password in the User Name and Password dialog box, then click
OK.
NOTE: If the SetNetGo button is checked, this User Name and Password
dialog appears.
A login dialog appears in which you must enter a user name, password, and AMR
server IP address.
NOTE: After connecting to the AMR the first time, MobilePlanner remembers your user name. When connecting to the AMR again, you can select
your user name from a combo box instead of having to re-enter, but you
must still enter your password.
MobilePlanner completes its connection to the AMR. At this point, there is no map to load, so
MobilePlanner opens with a blank map window.
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The MobilePlanner software is the "control center" of the Fleet Operations Workspace Core. Its
user interface has the tools for all major AMR activities, such as observing a fleet of AMRs,
commanding individual AMRs to drive, creating and editing map files, goals, and tasks, modifying AMR configurations, and more.
The following topics provide details on understanding and using the MobilePlanner features.

5.1 Overview of MobilePlanner
MobilePlanner has features you can use to scan the AMR environment, configure the AMR,
create and edit maps, and more. The interface is designed to be user-friendly and efficient,
which reduces the learning curve and the time needed for deployment.
The MobilePlanner interface supports the following languages:
l

English

l

Italian

l

French

l

Korean

l

German

l

Simplified Chinese

l

Japanese

l

Traditional Chinese

l

Spanish

Table 5-1. MobilePlanner User Interface (with Map)
NOTE: While MobilePlanner is not necessary for each AMR, you must have at
least one copy of MobilePlanner to create a map.
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From the MobilePlanner interface, you can:
l

Connect to and drive the AMR.

l

Create maps of the environment by importing and analyzing an AMR’s scan data.

l

Edit maps by adding goals (and adding tasks to those goals), docks, forbidden areas,
and more. You can also erase stray or unwanted artifacts, combine pieces of maps, and
make other changes.

l

Download and upload files, including maps and scan data, to and from an AMR.

l

Set the system configuration parameters for the fleet.

l

With the Fleet Manager, monitor the location and status of all AMRs in a fleet.

l

View and interact with the job queuing manager.

These features allow you to create a map with goals, docks, and advanced lines and areas,
and to start the AMR working in its environment.

5.2 MobilePlanner Interface
The MobilePlanner interface consists of the following main sections:
l
Toolbar: Provides quick access to connection, mode buttons (Fleet, Config, Map,
SetNetGo), file save, and undo/redo functions. Some of these items are also available
from the File and Edit menus.
l
Fleet button
l
Config button
l
Map button
l
SetNetGo button
NOTE: By default, the Fleet, Config, and Map buttons are checked, and
will open each when you launch MobilePlanner and connect to an AMR.
The following figure is an example of the MobilePlanner interface showing a map of a single
AMR, containing routes and goals. Show Robot is on, in the figure.
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2
1

3

4

5

6

Figure 5-1. Sample MobilePlanner Interface

Table 5-2. MobilePlanner Interface Description
Item

Description

1

Main Menu

2

Toolbars

3

Mode Tabs

4

Function Tabs

5

Map Window

6

Tray

Configuration (Config) Tab
There are five tabs under the Config tab: Robot Interface, Robot Operation, Robot Physical,
Fleet, and Debug. The many configuration parameters are covered in Configuring the AMR on
page 140.
Map Tab
l

When the map tab is selected, the main window displays a map of the AMR's operating space. The map consists of points and lines representing the walls, doors and
other stationary features within the environment. For more details, see The MobilePlanner Map Window on page 70.
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l

l

l

l

The Draw and Build Tabs, to the left of the map, provide map editing tools, and tools
for setting the AMR up to do tasks at goals (route building).
Robot tools are visible below the map when Show Robot is toggled on. You can use
these tools to drive, dock, adjust speed, etc. These items are also available from the
Robot menu.
To the right of the Robot tools is the Monitor icon. For details, see Using Monitor on
page 68.
The Status area, located below the map, (shown with Show Robot button toggled on)
provides information on the AMR position, temperature, odometer, and battery charge.
For details, see MobilePlanner Status and Tray Displays on page 75.

Map Features Legend

To view available map features in MobilePlanner, click Map > Legend. If Show Robot is on,
the legend also shows map items associated with the AMR, like sensor readings, paths, etc.

SetNetGo Tab
The SetNetGo tab connects to the AMR’s SetNetGo interface, and displays the various configurations associated with the AMR.
SetNetGo is the operating system residing on the AMR and EM2100. You use SetNetGo to configure and establish network communication with the AMR, download debug information,
and perform software maintenance (upgrades).

Figure 5-2. SetNetGo Interface
For details on the interface elements, see the remaining topics in this chapter.
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5.3 MobilePlanner Operator Account Overview
Some sign-ins to MobilePlanner will be restricted to an Operator account (you can also select
the MobilePlanner (Operator Mode) from the Windows Start menu).
An Operator account provides a limited set of tools for interfacing with AMRs or the Fleet
Manager. Its main window, the Fleet window, shows the status of all AMRs in your fleet and
their jobs, and allows for simple interventions in job execution sequences. Operator Mode does
not support any setup operations, and the Map, Config, and SetNetGo windows are unavailable.

MobilePlanner Operator Account Interface
Operator Mode’s simplified user interface focuses on monitoring fleet AMRs and jobs. It uses
graphical elements to represent AMR statuses, and the status of all jobs (complete, in-progress,
canceled, etc.).
To force the launch of MobilePlanner Operator Mode, click the Windows Start menu, and
select Start > All Programs > Omron > MobilePlanner5 > MobilePlanner (Operator Mode).
When MobilePlanner (Operator Mode) opens, enter the IP address of an AMR or Fleet Manager, and click Connect.

Figure 5-3. MobilePlanner Operator Mode UI
The MobilePlanner (Operator Mode) interface allows you to connect to and monitor multiple
AMRs.

MobilePlanner Operator Mode Jobs Tab
The Jobs tab displays all jobs assigned to the AMRs (listed by job ID). For debugging purposes,
you can also add a job to the currently monitored AMR by clicking the Add Job button (lower
right corner of the window), which displays the Add Job window.
NOTE: The Add Job window is not the primary method for submitting jobs to
the fleet.
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Figure 5-4. MobilePlanner Operator Mode Add Jobs window
Each job consists of multiple segments, and each segment has an associated goal. In this window, you can add or remove segments to or from a job, then submit the entire job to the
queuing manager.
In this window, you can also add another job to the current job queue, assign a Job ID, set the
job goal (double-click the field below Goal to display a drop-down list of goals), and set the
job’s priority.

Statistics Tab
The Statistics tab displays relevant statistics for your AMRs. Those statistics include:
l

l
l
l
l

l

l

FleetRobotInformation: the number of AMRs currently connected to the Fleet Manager;
their progress, and which are available and unavailable.
JobCounts: the number of completed, canceled, and modified jobs and job segments.
LastTripReset: the time (in sec), and human-readable date and time since last reset.
QueueInformation: lists information about pending and in-progress jobs.
StateInformation: information about the AMRs’ states (driving time/distance, parking
time, docking info, etc.).
TripJobCounts: statistics related to the AMRs’ job completion (number of completed,
canceled, or modified jobs/segments).
TripStateInformation: statistics about the AMRs’ trips when completing jobs (distance
driven or time spent at a particular job).

5.4 The MobilePlanner Menu
The MobilePlanner interface includes a menu bar to access to the tools for editing the AMR's
map file. It also applies to other non-map windows, provides tools for driving the AMR, initiating scans, route building, and searching the Config, and importing/exporting Config files.

Figure 5-5. Menu Bar
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The following table describes the menu bar selections.
Menu
Option

Description

File

Allows you to open a local scan or map file, a map, scan, or configuration file
on an AMR, save the map file, insert another map into the existing map file,
and download or upload a files to/from an AMR. For more details, see File
Menu on page 56.

Edit

Allows you to undo or redo your last command. For more details, see Edit
Menu on page 58.

Robot

Gives you control over various AMR activities (stop, drive, dock/undock),
allows you to monitor the AMR dashboard and/or fleet details, create custom commands, create a fleet message of the day, and reload a configuration or stop the AMR. For more details, see Robot Menu on page 59.

Map

Allows you work with and edit the displayed map file. For more details, see
Map Menu on page 60.

View

Allows you to change the units used in the map, and turn the toolbar labels
on and off. For more details, see View Menu on page 61.

Tools

Allows you to update preferences. For more details, see Tools Menu on page
62

Window

Allows you to access the different files open in the workspace and change
the way the windows in MobilePlanner are displayed. You can choose to tile
them in the workspace or have them cascade. For more details, see Window Menu on page 62.

Help

Provides help on the MobilePlanner interface. For more details, see Help
Menu on page 63.

File Menu
Menu Option

Description

Open...

Opens a dialog, to search for and select a local map or a scan file to open.

Open on Robot

Opens a submenu, which lets you select and open a file located on a particular AMR or the Fleet Manager.
l

l

Robot Host Name or IP Address opens the login page for that
AMR. This submenu shows a list of the most recently used AMRs or
Fleet Managers.
Select Robot... allows you to open the login dialog box and
choose a file located on a different AMR.

Displays the MobilePlanner Robot Login dialog box. Once you select an
AMR, you can search for and select a map or scan file (if available) to
open. You can also access the Configuration and SetNetGo software on
the AMR.
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Close

Closes the active file.

Import Config...

(Available when the Configuration Editor is selected.) Opens a dialog to
import an AMR configuration file into MobilePlanner.

Insert Map...

(Available when the Map mode tab is selected.) Opens a dialog to search
for and select a local map file to open and insert into the active map file.
Used for small changes to the physical environment that affect the AMR's
route, eliminates the need to rescan the entire workspace. See Inserting
a Map File into an Existing Map File on page 104 for more information on
this feature.

Save

Writes changes to the active file, and saves either onto an AMR (if opened
from an AMR) or disk (if opened from a PC).

Save As...

Opens the Save As dialog. Used to save the active file under a different
name and to a particular location on the local PC.
Note that you can also save to different file formats (such as JPG or SVG).
In those cases, the new file is not displayed in the editor.

Save on Robot

Opens a submenu for saving changes to a particular AMR's map file.
l

l

Robot Name or IP Address opens the login page for the AMR
associated with that IP address. This submenu lists the five most
recently used AMRs.
Select Robot... opens the login dialog box for choosing a different
AMR on which to save the map file.

If configured for the AMR, the MobilePlanner Robot Login dialog box displays. Once connected to the AMR, you can save the map file.
This menu option is only available in Map mode.
Download/Upload

Opens a submenu to transfer a file to or from a particular AMR (most commonly, a sound file to use with ‘play,’ or playBackgroundSound’).
l

l

Robot Name or IP Address opens the login page for the AMR
associated with that IP address. This submenu lists the five most
recently used AMRs.
Select Robot... opens the login dialog box for choosing a different
AMR on which to save the map file.

The MobilePlanner Robot Login dialog box displays. Once connected to the
AMR, you can upload the map file to the AMR or download a map file from
the AMR.
Exit
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Closes the application.
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Edit Menu
Menu Option
Undo

Description
Lets you undo the most recent action on the map file.
This menu option is only available in Map and Config modes.
NOTE: Undo is unavailable if you saved the map or configuration.

Redo

Lets you repeat the most recent action that you undid in the map file.
This menu option is only available in Map and Config modes.

Search

20569-020 Rev. D
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Robot Menu
Menu Option

Description

Stop

Stops the AMR when it is in motion.

Drive

Activates the Drive pad for driving the AMR in its environment.

!

CAUTION: Toggle the Manual Override to OFF to
prevent the AMR from running into anything while
you are driving it. If Manual Override mode is ON,
the map background turns yellow, indicating “use
caution” while driving.

NOTE: Even in Manual Override mode, the AMR will
avoid any obstacle detected by the navigation laser
when traveling over 300 mm/s.
NOTE: With Show Robot turned ON, you can
access AMR drive icons from the Map view.

Dock

Sends the AMR to a dock.

Undock

Releases the AMR from the dock.

Monitor

(Same as the Monitor button in the map and robot tools menu).
Allows you to view and/or configure various AMR details - battery
info, digital inputs and outputs, audio, add and execute tasks, macros, and routes.

Debug

Allows you to trace underway tasks for debugging.
NOTE: This is an advanced feature, used for debugging advanced functionality.
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Custom Commands

Allows you to create and send custom commands to the AMR. This
is used mainly for debug log file starts and stops.

Map Creation

Allows you to start and/or stop the AMR's scanning process, from
which you can build a map file.

Messages

Allows you to create custom Fleet Manager and/or Robot Messages
of the Day.

Robot Tools

Provides access to advanced AMR tools, including localizing, reloading configurations, auto-docking, and issuing shutdown commands
for a single AMR or all AMRs in the fleet.

Safety Commissioning

Allows testing and commissioning (verification of proper function)
of an AMR's on-board safety systems. Uses a wizard to test E-Stop
(tests brake activation) and Safety Laser (tests max speed limits
and obstacle detection). Per EN-1525, commissioning must be
done by specially trained people. See Safety and Regulatory Information on page 18 for details on Safety Commissioning.
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Map Menu
Menu Option

Description

Fit in Window

Adjusts the map so it all fits within the map window.

Grid

Displays the grid on in the map window. Grid line spacing is at 1 meter
intervals.
NOTE: The MobilePlanner grid is not the path planning
grid or localization grid. It is simply for reference.

Origin

Displays the X/Y coordinates of the overall map. You must zoom the
map view out to see the origin lines.

Robot Data

Allows you to control the display of various AMR-related map features
such as sonar, laser, path, and localization.

Map Data

Opens a submenu, which lets you toggle the features to view on the
active map file:
l
l
l

Rotate

Points
Lines
Lights (if using Acuity)

Opens a submenu, which lets you rotate the entire map in the map
window.
l

Rotate Right

l

Rotate Left

l

Rotate Full 180 o

l

Reset to None

You can also save the rotated map as the default orientation.
Legend
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Keeps track of all of the different features available in the map file.
Each feature is identified on the map with a different color rectangle or
line. For more details, see Map Modes on page 73.
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View Menu
Menu Option
Units

Description
Opens a submenu in which you can change map units. You can
select:
l
l
l
l

Millimeters (default)
Meters
Feet/Inches
Inches

The units apply to values displayed in the status bar, in map object
edit boxes, and when using a measuring stick. See Advanced Lines
and Areas on page 103 for details.
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Show Main Toolbar
Labels

Toggles toolbar labels ON or OFF. To hide the labels, uncheck this
menu option.

Configuration

Submenu allows user to toggle Show Deprecated Parameters.
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Tools Menu
Menu Option

Description

Preferences...

Opens a dialog box with tabs for Comm and Computer ID parameters.
l

l

Comm Tab: Allows you to select Robot Server (from
pick list), and set connection attributes for TCP/IP only,
or reuse login information when reconnecting.
Computer ID Tab: Includes a field that displays the
name of the computer on which the MobilePlanner
installation exists (e.g., "John Doe's Laptop"), and
allows you to select the goal nearest the AMR's current
position.

Click OK after making any configuration changes.
Click Reset... reverts to initial installation-like state and
resets all previous changes.
Click Cancel to stop without making any changes.

Window Menu
Menu Option

Description

Tab

Arranges the open windows in tabs, just below the main toolbar. This is the default display mode.

Tile

Arranges the open windows as tiles, open next to each other.

Cascade

Arranges the open windows in a cascade, or waterfall, formation.

1:<IPaddress>:map

Contains a list of the open map and/or configuration files, or
SetNetGo. Select from the list to make that the active window.

2:<IPaddress>:Configuration
3:<IPaddress>:SetNetGo
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Help Menu
Menu Option

Description

Fleet Operations Workspace
Core User's Guide

Allows you to open a Windows type help version of this
guide while using MobilePlanner software.

Document Library (online)

Provides link to:
http://www.ia.omron.com/products/category/robotics/mobilerobots/index.html

What's This?

Selecting this menu option, or using the shortcut Shift +
F1, and then clicking on the MobilePlanner workspace displays a pop-up containing a brief description of some features.

Open Output Log Folder

Opens the folder containing saved MobilePlanner output
logs.

About MobilePlanner...

Provides information on the current version of MobilePlanner and underlying applications/libraries.

5.5 The MobilePlanner Toolbars
There are three toolbars possible in the MobilePlanner interface:
l

The main toolbar, which is located at the top of the MobilePlanner interface.

In Map mode only:
l

l

The Map Controls toolbar is a floating toolbar, which you can move within the map
area.
The AMR toolbar, below the map.

The following sections describe each set of tools.

Main Toolbar
The MobilePlanner main toolbar is located at the top of the window, under the main menu.

Figure 5-6. Example of the Main Toolbar, SetNetGo Selected

Table 5-3. Main Toolbar Icons and Their Functions
Toolbar Icon

Description
Connects to the AMR or server at the specified IP address. Use the dropdown list to select a previously-used IP address, or type a new
IP address directly in the field.
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When an AMR or server is connected, this toggles to Disconnect.
Opens the Fleet window, which shows status and job statistics for all
AMRs in your fleet. It uses graphical icons to represent interrupted, canceled, in-progress, pending, and completed jobs. Click the checkbox to
have the Fleet window open when you connect to an AMR or Fleet Manager.
Displays the Configuration mode tab, which is used to set configuration
parameters. For details, see Configuring the AMR on page 140. Click the
checkbox to have the Config tab open when you connect to an AMR or
Fleet Manager.
Displays the Map mode tab, which is used to edit the map. For details,
see Editing a Map File on page 93. Click the checkbox to have the map
load when you connect to an AMR or Fleet Manager.
Displays the SetNetGo mode tab, which is used to access the SetNetGo
interface. For details, see Using the SetNetGo Software on page 114.
Click the checkbox to have SetNetGo open when you connect to an AMR
or Fleet Manager.
Saves changes to the active map or configuration file on the AMR.

Lets you undo the most recent action performed on the map or config
file.

Lets you restore the most recent item you undid in the map or config
file.

When MobilePlanner is in the Config mode, allows you to search all configurations for specific key words. Allows you to find parameters by
name, or search for a specific word in a parameter’s description (searching for ‘preferred’ in the example below). You can edit the Config values
in the main tab or in the search results window.
You can restrict the search to Non-Default parameters.
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Figure 5-7. Search Window - Searching for ‘Auto’

Robot and Map Toolbars
The map toolbars control the view of the map, set a goal at the AMR position, and localize the
AMR. (Localizing is telling the AMR where it is on the map of the work area.) There are two
different map toolbars available: one when the Show Robot button is toggled ON (the AMR is
displayed on the map); the other with the Show Robot button toggled OFF (the AMR is hidden
from the map).

Figure 5-8. Robot Toolbar (Show Robot ON)
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Figure 5-9. Floating Map Toolbar

Table 5-4. Robot and Map Toolbar Icons and Their Functions
Toolbar Icon

Description

Some of the following icons are available when the Show Robot button is toggled ON, but
are disabled if the AMR cannot service the request because of low state of charge, or if E-Stop
is pressed.
Stops the AMR any time you click this icon, even when navigating in
autonomous mode.

NOTE: You can also use your keyboard’s Esc key to stop the
AMR.
Sends the AMR to a point you select on the map.

Sends the AMR to a goal you select on the map.
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ON when the AMR is on a dock or heading to a dock. Also sends the AMR to a
dock.
When OFF, releases the AMR from the dock.

Opens the Drive pad, which is used to move the AMR in its environment. Be
sure that you have Manual Override toggled OFF, which prevents the AMR
from running into anything while you are driving it. Even with Manual Override turned ON, the AMR will avoid any obstacles detected by its navigation
laser when traveling over 300 mm/s.
Highlight (click on) the pop-up window, and use the mouse or the arrow
keys on the keyboard to move the AMR in the direction you want it to go.

!

CAUTION: When Manual Override is ON, the background
of the map turns yellow, indicating "use caution" while driving.

Opens the Localize Robot dialog, which is used to localize the AMR to a point
selected on the map.

Allows you to create a goal and/or door with goals, place a cart, or place a
dock at the AMR’s current location.

The Monitor robot feature is available only when the Show Robot button is
toggled on. It provides a convenient place to monitor important AMR details
(battery info, state, job counts, sensors, and queuing stats), and the status
of digital inputs/outputs. It also provides a place for sending an AMR on a
route, adjusting audio input/output volumes, and inputting Say commands
(phrases that the AMR speaks with its text-to-speech converter).
Shows the location of the AMR on the map. Several toolbar features won't
function unless this is toggled ON. Others won't function unless it is toggled
OFF. The background color of the icon turns darker when it is ON.

Centers the map on the current AMR. This is helpful when you have multiple AMRs in your workspace and you need to locate a specific AMR quickly.
It also allows you to watch the AMR as it performs tasks.
Adjusts the map view to fit in the map window.
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Zooms map out (reduced magnification, more map visible).

Zooms map in (increased magnification, more details visible).

Allows you to pan around the map.

1. Click on the Pan icon to display the Pan Map box.
2. Click on any of the four arrows of the Pan Map box to move that direction in the map.
The keyboard arrow keys perform the same function as clicking on
the Pan Map arrows.
NOTE: If Center on Robot is turned on, you cannot pan the
map window.
NOTE: You can also pan the map by clicking and holding the
right mouse button while moving the mouse around the
workspace.
The Pan Up, Pan Down, Pan Left and Pan Right icons are available when the
Pan button is turned on.

5.6 Using Monitor
The Monitor feature provides a convenient place to monitor important AMR and Fleet Manager details (battery info, state, job counts, sensors, and queuing stats), and the status of digital
inputs/outputs.
It also provides a place for sending an AMR on a route, adjusting audio input/output
volumes, and inputting Say commands (phrases that the AMR speaks with its text-to-speech
converter).
Monitor can be activated either in single AMR or Fleet mode, when you are attached to a Fleet
Manager.
The displayed data and appearance will differ, depending on whether you are connected to a
Fleet Manager or an AMR, and whether or not the Show Robot button is ON.

To Access Monitor
1. Click Monitor on the Robot toolbar to display a sub-menu with various AMR attributes
you can monitor.
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Figure 5-10. Monitor Drop-down Menu
The following table describes the various attributes you can monitor.
Item

69

Description

Dashboard

Displays an information window listing jobs (number of interrupted,
canceled, in-progress, pending, and completed) and AMRs (that
need assistance, have E-Stop pressed, busy, available, and unavailable).

Fleet Details

Lists information about AMRs in the fleet - availability, status of
assigned jobs, queuing and state information, system status, and
memory use.

Details

Lists specific details about the currently monitored AMR - battery/charge stats, path planning and following, AMR pose information, queuing statistics, system data, and wireless data.

Digital I/O

Allows you to monitor custom input/output states, and toggle output states ON (green) or OFF (black).

Audio

Controls incoming and outgoing audio volume.
Audio Incoming: MobilePlanner Out: controls the level out (for
example, 'sendSpeech').
Audio (Output): Robot Out controls the volume of speech audio files
the AMR plays.

Tasks

Lists current tasks assigned to monitored AMR, and allows you to
add them to the selected route builder list (normally a goal versus a
route).

Macros

Lists and allows immediate execution of all existing macros.
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Item
Routes

Description
Lists and allows immediate execution of all existing routes.

Adjusting Audio Levels
The robot monitor also allows you to adjust the incoming and outgoing audio levels. These
controls are shown in the following figure.

Figure 5-11. Audio Controls
You can adjust audio output level by moving the slide controls to the right (louder) or left
(quieter). You can amplify the effect of the incoming audio control setting by selecting the 2X
check box.
Making the Robot Talk

The Monitor > Audio window includes a text-to-speech feature. You can use the "Say" field to
input a word or phrase that you want the AMR to speak.
When you click the Say icon, the text is converted to synthesized speech through the text-tospeech converter.

5.7 The MobilePlanner Map Window
The MobilePlanner Map window displays the map file that you are editing. When you first
start MobilePlanner, no map is displayed until you connect to an AMR or Fleet Manager. You
can also open a map saved locally on your computer or network. For details on opening maps,
see Loading an Existing Map File on page 91.
Below is an example of the MobilePlanner interface with a map file opened. Note that the
Show Robot button is toggled OFF, which exposes the tools on the Draw function tab.
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Figure 5-12. The MobilePlanner Interface, Map Tab, Show Robot OFF
NOTE: To create the initial map, you must first use MobilePlanner to scan the
AMR's environment and then turn the scan into a map. For details, see Scanning
the Operating Area on page 88.

Map Zoom
Maps initially open zoomed out to give you an overall view of the AMR’s environment. To
quickly find the current AMR in the map, click the Show Robot button, then click Center on
Robot. The map zooms in, focused on the AMR.
NOTE: The Show Robot button must be ON to display the Center on Robot
icon.
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Map Controls
You can use the mouse or the keyboard to adjust the map view. The following table describes
the map controls.
To...

Do this...

Pan

Mouse: press and hold the right mouse button (or use the scroll wheel),
move the mouse around the workspace.
Keyboard: use the arrow keys to move right, left, up and down.
NOTE: You can’t pan the map when the Center on Robot toolbar icon is toggled ON.

Zoom in

Mouse: press the Shift key and click the right mouse button; or you can
rotate the scroll wheel forward (without the Shift key).
Keyboard: press the Shift key and the Up arrow.

Zoom
out

Mouse: press the Shift key and click the left mouse button; or you can rotate
the scroll wheel backward (without the Shift key).
Keyboard: press the Shift key and the Down arrow.

Map Features
Map features can be as simple as the static features of the environment (walls, doors, etc.) or,
depending on the features you add to the map, they can be quite intricate. In general, more
map detail improves AMR navigation.
To create a detailed map of the environment, you need to scan the environment thoroughly
and then edit the map. This is done in the MobilePlanner software. For more information on
environment scanning and map editing, refer to Scanning the Operating Area and Editing a
Map File on page 93.
The following table describes the different features shown on the map.
Map Feature

Definition
This represents the LD-60 and LD-90 AMRs. Notice
that the white arrowhead indicates the direction that
the AMR is currently facing.
This represents the Cart Transporter. Notice that the
white arrowhead indicates the direction that the AMR
is currently facing.

This represents the LD-250 AMR. Notice that the
white arrowhead indicates the direction that the AMR
is currently facing.
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Map Feature

Definition
This represents the HD-1500 AMR. Notice that the
white arrowhead indicates the direction that the AMR
is currently facing.

This is the Legacy representation of a robot. Notice
that the black line indicates the direction that the
AMR is currently facing. This may still apear in some
system maps.
The black dots and lines on the map are the walls,
doors, and other static fixtures in the environment.

The blue dots and lines are the features the AMR
"sees" with its navigation laser. Some AMRs have
additional lasers which produce different colored dots.
The yellow squares represent the location where the
AMR should go, and the black line is the direction it
should face, when it starts to dock. The dock object
should be approximately 1 to 1.5 meters in front of
the dock.
The green squares represent a goal. The line indicates
the AMR’s desired heading when it reaches the goal.
Goals are predefined locations where you can send
the AMR.
The light turquoise squares represent Standby Goals.
These can be either buffering or parking.

Map Modes
When Show Robot is on, there are several map modes which provide a different AMR function (see the following table):
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Icon

Map Mode

Definition

Send Robot

Allows you to send the AMR to a certain spot on the map.
When active, clicking on the map causes the AMR to move
to that spot.
To activate this mode, click Send Robot on the Toolbar,
then click on the map with the left mouse button to send
the AMR to that point. You can also send the AMR by holding down the Ctrl key and clicking on the map.
To specify the AMR’s desired heading when it arrives at the
designated spot, press the mouse button and drag.
To deactivate this mode, click the Send Robot icon to
toggle it off.
After you click a point on the map, the AMR (the red oval)
autonomously drives to the point you selected.

Robot Control

Allows you to drive or send the AMR using the keyboard. To
activate this mode, hold down the Ctrl key and press the
arrow keys.

Localize to Point

Allows you to localize (mark the AMR’s location) the AMR
on the map. See AMR Localization on page 228 for details.

NOTE: When Show Robot is OFF, the cursor shape indicates what your mouse
click or movement will do (see the following table). These cursors are visible
after selecting an object.

Cursor

20569-020 Rev. D

Function

Appears when
you...

Open the Edit window (double-click), or drag the object
within the map.

Double-click or
click-and-hold on an
object, other than
on a heading
marker or endpoint.

Change the heading of a goal or dock, or resize a line.

Click on the goal/dock heading
marker or either
end of a line.

Resize a rectangular object (the cursor is rotated 90°
depending on which corner you pick).

Click on a corner of
an area or sector.

Rotate the object.

Click on the heading
arrowhead of an
area.
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Map Legend
As you edit the map file, you can create goals, lines, forbidden areas, docks and many other
features in the environment. Use the Map Legend to keep track of all of the different features
that can be added to your map file.
Select Map > Legend... from the main menu to open the Map Legend window.

Figure 5-13. Map Legend (Partial)

5.8 MobilePlanner Status and Tray Displays
The status and tray displays allow you to monitor the status of the AMR (or AMRs) directly
from the software interface.

Status Information
The status of the selected (red) AMR is displayed directly beneath the map, as shown in the following figure.
NOTE: In MobilePlanner, the Status area is only visible when the Show Robot
button is toggled ON.
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Figure 5-14. Status Information
The following table describes some of the available status information.
NOTE: By default, the status area shows only a small sub-set of available AMR
details. To view other data, see Displaying Other AMR-Specific Details (below).
Status Detail

Description

RobotX and RobotY The current X and Y position of the AMR in its operating space.
RobotTh

Robot theta - the AMR’s heading (which way it’s facing), in °, measured counter-clockwise. 0 is the x axis.

TransVel

The velocity of the AMR.

RotVel

The AMR's rotational velocity (how fast it is turning).

Displaying Other AMR-Specific Details

There are many other AMR-specific parameters you can choose to display in the status area.
To view and/or add other AMR details, in the MobilePlanner main menu, select Robot > Monitor > Details.
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Figure 5-15. Robot Details Window
If you want to add a detail to the status area, click on the detail, then click the Show in Map
button (lower left corner). Or, you can right-click in the status area to Hide in Map.
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Tray Information
Below the status area, there is a tray that contains information such as connection status and
the pointer location.
NOTE: The tray information is always visible.

Figure 5-16. Tray Information
The following table describes the items available in the tray.
Tray Icons

Description
Displays the temperature reading of the current AMR.
Indicates the state of charge (in %). The icon turns yellow when the
charge begins to run low. It flashes red when the battery is low and the
AMR needs to dock.

20569-020 Rev. D

X:

Shows the X position of the pointer.

Y:

Shows the Y position of the pointer.
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Now that you have installed the MobilePlanner and set up a wireless connection to your
AMR, you are just about ready to drive the AMR around your workspace. You can drive the
AMR using either the pendant and walking around your environment, or operating it from the
MobilePlanner software. Using the mouse and keyboard, you can dock and undock the AMR
from its docking station, drive the AMR forward, backward, turn the AMR, and control its
speed.

!

CAUTION: Before attempting to drive the AMR, be sure to read the appropriate AMR user's guide and Mobile Robot Safety Guide so you are familiar
with the AMR's operation.

6.1 Before Driving the AMR
Whether you are driving the AMR with the pendant or from MobilePlanner, be sure the AMR
is not docked.

6.2 Manual Override
Autonomous Drive mode is the AMR’s default driving mode, and ensures the AMR does not
run into anything in its environment. When driving the AMR using MobilePlanner, Autonomous Drive mode prevents the AMR from entering forbidden or restricted spaces. If driving the
AMR using the pendant, you can have the AMR enter forbidden or restricted spaces, but the
AMR always obeys the lasers for obstacle avoidance.
When Manual Override is ON, the map background turns yellow (see below).
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Figure 6-1. MobilePlanner, Manual Override ON

To drive with Autonomous Drive mode OFF:
1. In the MobilePlanner main menu, click Robot > Robot Tools > Manual Override.
2. Click Yes to acknowledge the Manual Override dialog prompt.
NOTE: If you turn Autonomous Drive mode back ON when the AMR is in a
restricted or forbidden area, it will not be able to drive itself out of the restricted
area, and will require you driving it out using the pendant (which always
ignores location-dependent areas). Also, while an AMR is in a forbidden area,
even with Autonomous Drive mode still OFF, pressing the Send Robot button
will not cause the AMR to drive out of the forbidden area. You must drive the
AMR out of a forbidden area using the pendant or your PC’s arrow keys. See
Driving Using the Software Interface (Drive Pad or keyboard) on page 83.

6.3 Driving Using the Pendant
This section provides information on the pendant. Also see your AMR’s user guide.

Preparation
1. If not already done, power up the AMR (press and release the AMR’s ON button). The
full power-up sequence can take several minutes.
2. Wait for MobilePlanner and/or the AMR to indicate it is ready (via wheel lights, LCD or
touch screen).
3. Plug the pendant into the AMR’s pendant connection port.
For LD-series AMRs, this port is under an access panel on the left rear side of the AMR,
as shown in the following figure:

Figure 6-2. Connecting the Pendant to an LD-60
For the HD-1500 AMR, the pendant port is on the right side of the Operator panel, on
the rear end of the AMR.
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CAUTION: Driving the AMR with a pendant overrides the hardware
safety features (E-stop, sonar). Use caution when driving the AMR with
a pendant.

!

D
B

A
POWER
ENABLE
D

C
E

Figure 6-3. Pendant Controls
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Callout

Description

Callout

Description

A

Speed Control

D

Power Enabled LED

B

Goal Button

E

3-Position Enable Switch

C

Directional Control

l

The green LED indicates that the pendant is plugged into a live connection.

l

Squeeze and hold the trigger in, then:
o
o

l

l

l

Push the directional control forward or back to drive the AMR forward or back.
Push the directional control to the left or right to turn the AMR to the left or right.

The AMR slows to a stop when you release the trigger. To stop more quickly, continue
to hold the trigger down and pull or push the directional control to its limit in the
opposite direction of the AMR’s travel.
Speed is related to the positions of the directional control and the SPEED control.
The pendant’s GOAL button is primarily for marking positions while making a map
scan, but can be configured to perform other actions while not making a map scan.
NOTE: If driving with the pendant, proceed to Scanning the Operating Area on
page 88.

6.4 Driving Using the Software Interface (Drive Pad or keyboard)
NOTE: The Drive Pad functionality is not available for the HD-1500 AMR. The
Drive Pad display will be greyed-out. Its operation is not changed for the LD
AMRs.
Using MobilePlanner software and your PC's mouse and keyboard, you can:
l
l
l

Dock and undock the AMR from a docking station
Drive the AMR forwards, backwards, and turn
Control the AMR's speed

To drive the AMR using the software:
1. Ensure Show Robot is active, then click Center on Robot to locate the AMR (shown as
a red oval icon) in the map window (shown in the following figure).

83

Fleet Operations Workspace Core User's Manual

20569-020 Rev. D

3

2

1

Figure 6-4. AMR on Map (Show Robot Active)

Table 6-1. AMR on Map Description
Item

Description

1

Show Robot

2

Center on Robot

3

Robot (LD AMR shown)

2. Select Robot > Undock from the main menu, or click Dock (on the AMR tool bar) to
turn docking off. In the map window, you should see the AMR move away from the
docking station.
3. If the background in MobilePlanner is yellow (the AMR is not in Autonomous Drive
mode), un-check Robot > Robot Tools > Manual Override from the MobilePlanner
main menu.
4. Click Drive to display the MobilePlanner Drive pad with Speed slider (figure below).
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Figure 6-5. Drive Pad with Speed Slider
5. Highlight (click on) the map window, and use the mouse to click on the drive pad buttons, or use keyboard’s arrow keys to control the AMR’s direction. Use the speed slider
(at the bottom of the Drive pad) to control the AMR’s speed.
NOTE: If the speed slider is all the way to the left (-), the speed is set to
zero and the AMR will not move.
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Chapter 7: Scans and Maps
7.1 Map Overview
With Fleet Operations Workspace Core software, AMRs know where they are and drive from
one place to another by themselves, without a human operator. To do this, the AMR must
have a prepared map of the static features in its operating environment. MobilePlanner software makes creating maps for one, or an entire fleet of AMRs fast and easy.
Maps are one of the most important features of MobilePlanner. In MobilePlanner, a map is a
scanned representation of the floor plan in the AMR's operating space. Maps contain the static
features in the AMR's environment, such as walls, doors, permanent shelving, etc. They also
contain user-definable sectors, lines, and areas that help the AMR perform its job.

7.2 Scan Overview
The next step is to create a map of the AMR’s environment. In general, the process is as follows:
l

Read the section on scanning (see Scanning Overview on page 86), and the section on
scanning tips.

l

Read the section on driving the AMR (see AMR Driving Overview on page 80).

l

Scan the AMR’s operating space (see Scanning the Operating Area on page 88).

l

Use MobilePlanner to generate a map from the scan.

7.3 Scanning Overview
Before the AMR can perform autonomous tasks, it needs to have an accurate map of its environment. It is best to create a scan that includes as many stationary features as possible in the
workspace. After scanning, use MobilePlanner to turn the scan into a map, then begin assigning tasks to your AMR.
How Does the AMR Scan its Environment?

The AMR uses its forward laser, which scans in a 240° arc for the LD-series AMRs. The HD1500 AMR uses only its front laser, scanning in a 270° arc. Note that the HD front (and rear)
laser is not centered on the AMR.

What Gets Scanned?
Scans are on a thin horizontal plane. The scan is taken about 7.9 inches (200 mm) for the LDseries and 6.9 inches (175 mm) for the HD-1500 off the floor. So tables appear as four legs; a
pedestal appears as a single pole, minus the feet.
Distance From Walls

The AMR’s sensing range is 30 meters (about 98 feet). While scanning, keep walls within that
range as you drive throughout the workspace. For instance in a large warehouse, run the AMR
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along the outer walls as well as through the middle of the space.
Uni-directional Versus Bi-directional Scanning

Uni-directional scanning (or scanning in a single direction) works very well for hallways and
small rooms. Bi-directional scanning (or scanning in two directions) will ensure complete scanning of all features (such as vending machines or bookshelves).
Doors and Windows

When scanning environments with doors, ensure the doors are open in places where the AMR
will drive. Some glass surfaces, particularly those with dark backgrounds, reflect the range
finder signals; others don’t or reflect weakly. Consider retrofitting particularly troublesome
places with tape or other treatments to obtain proper scans. Additionally, you can designate
these features as obstacles in the map using a forbidden zone sector.
Dynamic Features

During scanning, MobilePlanner sees people walking by, swinging doors and other things
moving throughout the workspace. If a group forms during scanning, have them follow
behind (not stand in front of) the AMR’s scanner so they do not become permanent features of
your map. For an HD-1500, have them stand behind and to the left, since the laser being used
for scanning is on the front-right of the AMR. When editing the map, erase dynamic features
(like the group) to improve the map’s quality.
Docks

When scanning, scan and press the goal button to mark the AMR's dock so it can recharge
when its battery runs low.

Scanning Tips
The following general tips will help increase the AMR’s scanning accuracy, and reduce possible map errors:
l

l

l

l
l

l

l

87

Remove any features like chairs, rolling cabinets, etc. that might not be present during
normal operations.
Walk behind the AMR while scanning (and ensure others walking with the AMR also
walk behind the laser’s sensing area). With an HD-1500, walk behind and to the left of
the AMR, so that the laser (on the front right) doesn't see you.
Drive the AMR into tight corners, down small corridors, and between stationary objects
(with enough room).
Scan in multiple directions - scan clockwise for one scan, counter-clockwise for another.
If scanning rough terrain (like diamond plate flooring), drive slowly (to reduce the
chances of wheel slip) and in multiple directions. This will help minimize introducing
errors into the scan.
Open doors that might be open during normal operations, and doors the AMR will
have to drive through.
Drive the AMR through previously scanned areas.
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NOTE: Driving the AMR back through previously scanned areas, and
returning to its starting position can help minimize errors.

Scanning the Operating Area
Be sure to drive the AMR to all of the places you would expect it to go on its own. Drive all
the way around a room, not just in and out of the doorway. Turn the AMR to point into
corners and move around stationary features. In other words, be thorough!
Also, while driving the AMR, orient and stop it along the way to mark important goals (especially a dock object). Later, you can edit these and add additional goals within MobilePlanner
software.
1. If not already done, launch MobilePlanner and connect to the AMR.
NOTE: Before starting these steps, make sure the AMR is not charging. If
the AMR is docked, undock it by clicking Robot > Dock (in the
MobilePlanner main menu bar), or by clicking the Dock button in the
MobilePlanner toolbar (only visible if Show Robot is active).
2. From the MobilePlanner main menu, select: Robot > Map Creation > Start Scan.
3. Enter a name for your scan file in the New Scan Name field and click OK.
This initiates the scanning process. Notice that the AMR's LCD changes to map scanning mode.
NOTE: Before driving the AMR, make sure it is in Autonomous Drive
mode (a yellow background in MobilePlanner indicates the AMR is not in
Autonomous Drive mode). To enable Autonomous Drive mode, un-check
Robot > Robot Tools > Manual Override in the MobilePlanner main
menu bar.
4. Use the pendant and drive the AMR around its operating space.
NOTE: Be sure to drive the AMR around the entire operating area to create an accurate scan of your environment.
5. If you want to create a goal at the point where the AMR is stopped, press the pendant’s
black GOAL button to mark a goal.
6. Continue driving the AMR around until you have a thorough scan of your environment.
7. Return the AMR to its starting position.
8. After you have finished the scan, select Robot > Map Creation > Stop Scan from the
MobilePlanner menu.
The resulting scan file resides on your AMR, but not on the PC running MobilePlanner. The
file name is the name you entered for the scan with the ‘.2d’ extension. If scanning using Acuity, the file name has a ".z2d" extension, and includes additional data such as camera images
used to scan overhead lights.
NOTE: Acuity Localization is not yet supported for the HD-1500 AMR.
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Convert the Scan into a Map
After the AMR scans the operating environment, you need to turn the scan file into a map file.
To do this, open the scan file (.2d) in MobilePlanner.
NOTE: MobilePlanner can process only one scan file at a time. Opening a
second scan file disables the toolbar Start button until the first scan is finished.
1. Open the MobilePlanner software.
2. Select File > Open on Robot, then select the AMR, either from a list or by IP address.
The Open File on Robot dialog box appears.

Figure 7-1. Open File on Robot Dialog
3. Check the Scan File: checkbox, select the scan file you just created from the pulldown
list, and click Open.
A new map window and the Scan Tools toolbar appear, and the conversion (registration) process begins automatically. Initially, the map shows an AMR icon in the map
window. During file processing, the software adds scan points to the map window and
updates the AMR's position showing a blue trail to trace the AMR's previous positions.
NOTE: Be patient! Converting a large scan file can take considerable time
(and memory), and is based on the size and layout of the area being
scanned (for example, a small facility could take 20 seconds, a 20,000
square foot facility could take over an hour). If the small AMR icon in the
lower right corner of the map window is still moving, the conversion process is still underway.
NOTE: PC memory (RAM) is critical when processing a very large scan
file. Processing large scan files with insufficient RAM can significantly
degrade the performance of all applications. If this occurs, it might be
necessary to create smaller scan files and use the Map Insert feature to
assemble the pieces (refer to Inserting a Map File into an Existing Map
File on page 104 for details).
When processing is complete, the AMR icon and its trail disappear from the map window, and the scan icon in the status bar stops animating. If the map has too many stray
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objects or otherwise does not appear as you need, you can adjust the scan settings and
re-process the scan file (for details, refer to Changing the Scan Settings on page 109).
4. Save the cleaned map file locally on your PC.
5. In the Scan Tools toolbar, click Finish to complete the conversion process.
NOTE: Unless working in batch mode, you must finish converting one
scan before opening and converting another scan.
6. Edit the map file to erase (Draw pane > Eraser) stray, non-stationary objects (like chairs,
people, etc.). Add forbidden areas and sectors. Create goals and macros, and assign
tasks to your AMR. Refer to Editing a Map File on page 93.
7. Select File > Save on Robot to save the finished map file on the AMR, then select your
AMR from the MobilePlanner menu. Optionally, you can enter a Fleet Manager address
so it can be shared between multiple AMRs.
NOTE: Select Yes when prompted to make the new map the AMR’s current map so the AMR can localize, and appear on the map (when you
click Show Robot).
Map Data

The finished map consists of points and lines (vectors derived from points) representing the
walls and other real features detected by the scanning laser.

Figure 7-2. Scanned Environment

7.4 Working with Map Files
This section explains map files and how to work with them in the MobilePlanner software.
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Making a Map
Before MobilePlanner can create a map of the mobile robot’s operating space, you have to
drive the robot through the operating space as it scans the area with its laser and (if installed)
Acuity. The resulting scan file contains all the raw data for features in the space. To be usable
for mobile robot navigation, you have to have MobilePlanner convert the scan file into a map
file.
Generally, you only need to make a map when deploying your AMR for the first time in a new
environment. Occasionally you might need to rescan if the workspace undergoes extensive
structural modifications or lighting changes, cubicles added in what was open space, a new
wing to the building, or remodel of an area. For more extensive map updates, MobilePlanner
provides the tools to integrate a new map, partially or wholly, into your original application
(refer to Inserting a Map File into an Existing Map File on page 104 for details).
The best time to create a map scan is when the environment is least busy, when you can minimize the amount of time spent avoiding people and other non-stationary obstacles, and when
you can move about, opening and closing doors, without disrupting normal daily activities.
What Information is Stored in a Map File?

Map files contain four kinds of data about an operating environment that the AMR uses in
planning navigation and executing tasks:
l
l
l
l

Obstacles and features scanned by a laser, and/or overhead lights acquired by Acuity.
Objects, such as goals, forbidden lines, and sectors that control AMR behavior.
Macros and tasks associated with goals.
Data that defines properties of special goal types and available tasks.

A map file name has an extension of .map. Scan file names have an extension of .2d.
Scan files for light localization have an extension of .z2d (scan file is a zip file referred to as
the Scan Package) or .zmp (map file from scan - a zip file referred to as the Map Package).
l

l

For information on creating a map using the scanning laser, refer to Scanning the Operating Area on page 88.
For information on creating a map using Acuity for light localization, refer to Creating
the Light Map on page 235.

Loading an Existing Map File
There is no map to display when you first start up the MobilePlanner software. You must use
MobilePlanner, with ‘Map’ checked, and connect to an AMR or Fleet Manager to open a map
file to edit. Or, you can open a map saved locally on your computer or (when the Map button
is checked) open a map that is currently in use on a specific AMR. You can also open maps
on the AMR that are currently not in use.
Opening a Map saved on your PC

When you use the Map button to open and edit your map files, you can save them locally on
your computer until you are ready to upload them to the AMR. Local map information is also
written in the debug info files.
Selecting File > Open from the MobilePlanner main menu displays a dialog that lets you
search for and select a local map file to open.
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Opening a Map stored on an AMR

You can also click the Map button to edit a map file that is already in use on an AMR, which
is helpful for making quick changes to the map or the AMR's route.
1. In the MobilePlanner main menu, select File > Open on Robot to display a submenu
that lets you select a particular AMR.
2. Either choose from the displayed AMR IP addresses, or enter a new AMR IP address to
open a map on the specified AMR.
A dialog box appears in which you can choose between Configuration, Map, Scan, and
SetNetGo files.

Figure 7-3. Open File on Robot dialog
3. Check Map File to choose a map file located on the AMR.
You can use the Map File list and/or click the Advanced button to search for and select
a map file to open, as shown in the following figure:
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Figure 7-4. Open File on Robot, Advanced dialog
4. Select the map file you want to edit.
5. Click Open to load the map file into MobilePlanner.

Editing a Map File
After you create the initial map of your environment, you can use MobilePlanner to edit the
map. First, use the Eraser tool (Draw pane) to remove map features that are temporary or
moveable fixtures, such as chairs or forklifts.
Using the Drawing Tools

When editing your map file, you use the drawing tools to select and erase objects in the map,
add goals, docks, forbidden lines and areas, as well as advanced lines and areas. The drawing
tools are shown below.
NOTE: These drawing tools are inactive (grayed-out) if Show Robot is active.
The Cut icon is inactive until you select something.

93

Fleet Operations Workspace Core User's Manual

20569-020 Rev. D

Figure 7-5. MobilePlanner Draw Tab
Selecting and Erasing Objects in the Map

Use the Select button to select and highlight objects on the map. Press and hold the left mouse
button to move the object around the map window. Click the right mouse button to display a
pop-up menu that allows you to edit, duplicate, align, copy and cut the object.
NOTE: If there are overlapping objects on the screen, you can right-click on the
overlapping map objects. A sub-menu lists all objects under the cursor so you
can select the desired object.
Use the Eraser button to remove data points and lines from the map. Press and hold the left
mouse button to move the eraser over the data points or lines you want to remove. You can
adjust the size of the eraser by selecting the pull-down menu from the Eraser button. Choose
an eraser size from 5 to 1000 mm.
Cutting a Selection

Use the Cut icon (or Delete key) to remove any objects you have selected from the map.
Snapping Objects in Place

Use the Snap button to force rotate objects (goals, docks, lines, and areas) at multiples of 45°
angles. Deselect this button to draw or rotate at any angle.

Draw Tab
You can use the Draw tab to add and edit map items (for details on map editing, refer to Working with Map Files on page 90).
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NOTE: The Draw tab is only active when the Show Robot button is toggled
OFF.
The following table lists the toolbar icons and their functions.
Item

Description
Select a feature (point, line, area, etc.) on the current map.
The status bar on the bottom left side of the window displays
information about the feature you selected, such as:

Remove points or lines from the active map. Does not remove
custom/landmark objects.
1. Click on the Eraser icon.
2. Use the pull down menu to select the eraser size from
5 mm to 10000 mm.
3. Click and hold the left mouse button, while moving the
mouse over the points and lines you want to erase.
Click Goal, then click on a map location to add a goal. In the
Edit Goal dialog box you can:
l
l
l
l

label the goal
provide a description
select the type of goal (if available)
adjust the X/Y position and heading. You can adjust the
heading after placement by holding the left mouse button down, and dragging around the goal. The heading
will follow the cursor.

Click Docks, then click in the map at the new dock’s location.
In the Edit Dock dialog box you can:
l
l
l
l
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label the dock
provide a description
select the type of dock
adjust the X/Y position and heading. You can adjust the
heading after placement by holding the left mouse button down, and dragging around the dock. The heading
will follow the cursor.
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AMRs will not cross forbidden lines, or enter forbidden areas. To
add a forbidden line or area:
1. Press and hold the left mouse button.
2. Drag the mouse to create the line or area and to adjust
the size.
3. Release the mouse button (the line or area remains
selected).
4. Press and hold the left mouse button.
5. Drag the selected line/area to move its location on the
map.
6. For an area, click and hold on the heading arrowhead,
then drag to rotate the area.
Allows you to measure distances, display a measuring stick,
add Preferred or Resisted Lines, or a Map Data Line to your
map.

Place lines and rectangles to the x/y axis (or 45° angles).
Deselect this button to draw or rotate at any angle.
To temporarily toggle this button while drawing a line or rotating a rectangle, press and hold the Ctrl key. Release the Ctrl
key after making the edit.
Places special areas on the map that the AMRs will avoid entering or crossing (e.g., door swing sectors, need to enter sectors,
resisted sectors, etc. To add an advanced area to the map:
1. Press and hold the left mouse button.
2. Drag the mouse to create and size the line or area.
3. Release the mouse button (the line or area remains
selected).
4. Press and hold the left mouse button.
5. Drag the selected line/area to move its location on the
map.
6. For an area, click and hold on the heading arrowhead,
then drag to rotate the area.
Opens a submenu for adding a label to any advanced feature
on the map.
1. Click on Advanced Points, then select Label from the
submenu.

2. Click on a feature in the map you want to label, then
use the Edit Label dialog box to enter a label, provide a
description, and adjust the X/Y position and heading.

NOTE: The label box is a special text box
that does not scale when zoomed.
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Using Advanced Lines and Areas

Advanced lines and areas (in Config > Robot Operation > Map Features) control the AMR's
behavior. You can alter traffic flow, restrict the AMR from entering an area, and have the AMR
use a preferred route. For more information on creating these features and more, refer to Traffic
Management on page 202.
Advanced Lines
Advanced Line

Definition

Measuring Stick

Places a line on the map to measure distances in the map. You can
change the measurement units by selecting View > Units from the
main menu.

Preferred Line

Places a line on the map representing the path that you prefer the
AMR use.

Resisted Boundary

Places a boundary line that the AMR resists crossing. If there is no
other way around an obstacle, the AMR will cross a resisted boundary
(though at a higher cost). For more information, refer to Cost-Based
Path Planning on page 205.
You can adjust the amount of line resistance, which is preferred over
a restricted boundary.

Restricted Boundary

Places a boundary line that the AMR will avoid if possible.

Switchable Forbidden
Line

Places a boundary line that you can control with tasks or through
ARCL.

Advanced Areas
Advanced Area

Definition

Door

Places an area on the map to handle doors.

DoorSwingSector

Places a sector on the map that corresponds to a door’s swing
arc.

Door Virtual

Places a goal on the map for the AMR to drive to before entering a
door.

IgnoreLowLaser

Enables a sector in which the AMR ignores low laser readings
(e.g., for driving up and down ramps, crossing the threshold gap
in an elevator, etc.).

IgnoreSonar

Places an area on the map that will disable the sonar sensors.
This can be useful for crossing known thresholds, so the sonar
doesn’t prevent the AMR from driving over the threshold.

NOTE: If you have the low front laser, this section does not apply.
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IgnoreTiltedLaser

Instructs the AMR to ignore inputs from side-mounted lasers.

ManagedDestination

Allows use of multiple goals as a single destination to determine
AMR occupancy of the sector.

ManagedMotion

Limits the number of AMRs allowed to drive in an area (sector) at
the same time.

ManagedMotionOverride

Makes contained AMRs appear to be driving. Used primarily in constricted areas.

Movement Parameters

Places an area on the map where you can change movement
parameters, such as velocity, acceleration, and deceleration, in
real time.

Need to Enter

Places an area on the map that the AMR can drive to only if it is
already in the area or a goal that it needs to drive to is in the
area.

PathPlanningSettings

Places a sector that changes path planning settings.

PreferredDirectionLeft,
PreferredDirectionRight

Places an area on the map that directs the AMR to travel along
the right or left side of the path, unless there is an obstacle in the
way.
The AMR chooses the preferred side regardless of which way the
AMR is traveling. In other words, it follows the preferred side
whether it is traveling up the hallway or down the hallway.

PreferredDirectionRight
Single,
PreferredDirectionLeft
Single

Enable sectors that cause the AMR to prefer driving on the left or
right, in one direction only. Generally, the bi-directional PreferredDirectionRight/Left should be used instead. If two single direction sectors are placed next to each other, they must be
aligned with care so AMRs do not collide.
Using a preferred direction single tells the AMR to travel along the
right (or left) side of the path unless there is an obstacle in the
way.
The AMR chooses the preferred direction in one direction only. In
other words, the AMR will prefer to travel on the right (or left)
side only when it is traveling up the hallway.

SingleRobot

Places an area on the map that only a single AMR can be in at any
one time.

SwitchableForbiddenArea

Places an area on the map that can be controlled with tasks or
through ARCL.

TaskSector

Places an area on the map that has a task list of what the AMR
will do immediately upon entering and exiting the sector.

VolumeAdjustment

Places an area on the map where the AMR's audio output can be
changed.

20569-020 Rev. D

Fleet Operations Workspace Core User's Manual

98

Chapter 7: Scans and Maps

Adding Forbidden Lines and Areas
You can place forbidden lines and areas on the map to prevent the AMR from crossing the
line or entering a specified area.
NOTE: Forcing the AMR to cross a forbidden line or enter a forbidden area is a
special circumstance discussed in Restricting Traffic on page 215.
1. With the map active, click the Draw tab, then click Forbidden Line or Forbidden Area.
2. Click on the map where you want to place the forbidden line or area. Be sure to add forbidden lines or areas around the AMR’s work space so it doesn’t try to navigate outside
of its space.
3. Hold the left mouse button , then drag the mouse to the location you want the line or
area to end.
4. Click the right mouse button to display a pop-up menu that allows you to edit, copy or
cut the forbidden line or area.

Creating and Adding Goals and Docks
Goals are virtual destinations that the AMR drives to in its environment. Docks are locations
to which the AMR drives to prepare to recharge. You need to add both of these features to the
map for the AMR to successfully navigate through the workspace.
You can quickly add a goal or dock to the map using the Item at Robot button (robot tool bar),
which allows you to add the object at the AMR’s location. Once added, you can move goals
and docks around by clicking on them with the left mouse button, holding the button, and
dragging them to the desired location. You can also click on the heading line and drag it
around, or put it in the middle to turn the heading off.
Types of Goals

You can choose from different types of goals:
l

l

l
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Door Goal: Doors and virtual doors are spots at which the AMR positions itself before
entering or leaving a doorway (see Using a Door Goal on page 101). They appear green
on the map, and are only available if the Doors parameter is enabled (click the Config
button, then click the Robot Operation tab, then select Map Features).
Goal: This is the default goal. The X and Y positions are automatically entered based on
the location you selected on the map. Click on the check box to enable a heading and
enter a heading in degrees (you can also do this on the map by dragging the mouse
cursor - see Creating and Adding Goals and Docks on page 99.). The goal heading specifies the orientation of the AMR when it arrives at the goal.
Standby: Standby goals serve three purposes, each designed to help keep the AMRs out
of the way of traffic and regions of interest (goals, tools, etc.):
o

Buffering: waiting at a standby goal for another AMR to clear an occupied goal
or sector. Refer to Using Standby-Buffering Goals on page 102.

o

Parking: allows available AMRs to drive to a waiting area for assignment to
another goal. Other parking goals include Preferred Parking goals (also known as
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‘park at pickup/dropoff’ goals). Refer to Using Standby-Parking Goals on page
102.
o

Multi-Robot Standby (MRS): (also referred to as Taxi Line) allows (and enforces)
sequenced, orderly queuing of multiple AMRs from the same start (standby) position to the same goal. For more information, refer to Traffic Control Concepts on
page 202.

To create a goal/dock:

1. With the map active, click on Draw tab > Goal or Draw tab > Dock.
2. Click the mouse on the map where you want to locate the goal/dock. Then, while holding the left mouse button, drag the mouse around the goal/dock to set its heading.
NOTE: Place a dock object where the AMR should go to "look at" the
dock, not where the dock actually is. The dock object should be 1 to 1.5
meters in front of the dock, pointed at the dock. See the following figure.

Figure 7-6. Dock as Imaged by AMR

Figure 7-7. Edit Goal Dialog Box

Figure 7-8. Edit Dock Dialog Box

3. In the appropriate dialog box (Edit Goal or Edit Dock), enter the name of the goal/dock
you want to add to the map, for example "Reception."
4. Enter a description of this goal or dock (optional).
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5. Select the Type of goal or dock you are adding.
6. Enter the X and Y position to adjust the location.
7. Enter a heading value in degrees (required for docks, optional for goals).
8. Click OK to place the goal or dock on the map.
Using a Door Goal

The door goals appear as a green square on the map. They allow you to mark a spot for the
AMR to position itself before entering or after leaving a doorway. The following dialog box
appears when setting up a door goal.

Figure 7-9. MobilePlanner Edit Goal dialog
Click on a parameter to see its description near the bottom of the dialog box.
Door Groups

You can also add a door group, which creates the door items and their dependencies. Click on
Custom Groups > DefaultDoorWithGoals to add a door group.
Goals Using High Accuracy Positioning System (HAPS)

If your AMR has one or more optional HAPS sensors installed, you can create goals that
require the AMR to approach and position itself closely.
The most simple of these types of installations have a goal on the AMR's map, a length of
magnetic tape on the floor (the track), and one marker. The AMR's objective is to approach and
proceed down the track, and stop at the marker.
You can also install tracks with multiple locations at which the AMR stops. Each stop needs
one track, one marker, one goal per marker, and an Engage task for each goal. Refer to Engage
on page 157.
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Standby Goals

Standby goals allow you to set up buffering when an AMR’s destination is already occupied
by another AMR, and send AMRs to a parking area after completing a queuing job.
NOTE: To use standby goals, you must enable them. Click the Config button,
then click the Robot Operation tab, then click Map Features (in the left pane),
then click the checkbox for the Standby parameter.
Using Standby-Parking Goals

It’s best to place standby-parking goals in areas out of the way of traffic and other areas of
interest.
To place a Standby-Parking goal on your map, do the following:
1. With the map active, click on the Draw tab, then click on the Goals drop-down list.
2. Select the Standby goal type.
3. Place the goal(s) on the map, then change the PrimaryPurpose parameter to Parking.
4. Use at least as many Parking goals as AMRs.
Using Standby-Buffering Goals

If an AMR is waiting for another AMR to clear a goal, it will use one closest to its destination.
Best practice, then, is to place Standby-buffer goals near tools and areas of interest, in locations
that will not block AMRs leaving the goal.
To place a Standby-Buffering goal on your map, do the following:
1. With the map active, click on the Draw tab, then click on the Goals drop-down list.
2. Select the Standby goal type.
3. Place the goal(s) on the map, then change the PrimaryPurpose parameter to Buffering.
4. Use at least as many Buffering goals as the anticipated number of waiting AMRs.
Adding a Goal at the AMR’s Current Position

You can add a goal (generic, door goal, cart goal, or docking station) at the AMR’s current position as follows:
1. With Show Robot active, click the drop-down arrow on the Item at Robot button (Robot
Toolbar).
2. Select the type of goal you want to add.
If you select one of the default goals (e.g., docking station), information about that goal
is pre-populated in the dialog box.
3. If you selected a generic goal, fill in the name, description, and type then click OK. For a
default goal, click OK.
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Accessing the Docking Parameters

Docking parameters define the AMR's actions during the docking process. To access the Docking parameters, click the Config button, click the Robot Operation tab, then click Docking.

Figure 7-10. MobilePlanner Config - Robot Operations tab, Docking Parameters
NOTE: MobilePlanner software defines the various docking parameters, which
will not be repeated here. However, there are some parameters under Config >
Fleet > Fleet Docking that control docking behaviors.

Advanced Lines and Areas
MobilePlanner has tools for adding special, or advanced, features to your map that perform
the following functions:
l

l
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Advanced Areas: these are areas in which you can add doors (and their swing sector),
control speed (Fast or Slow), direct the AMR to ignore laser or sonar inputs, limit the
number of AMRs operating in the space at one time (ManagedMotion), set the AMRs’
preferred travel direction, and direct the AMRs to enter (or resist entering).
Advanced Lines: these include lines to measure distances on the map (measuring stick),
lines representing the AMR’s preferred path (preferred line), lines the AMR will resist
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crossing unless there is no other way around an obstacle (resisted boundary), lines the
AMR will avoid if possible, and lines that can act like forbidden lines (SwitchableForbiddenLine).
Adding an Advanced Area or Line

Advanced lines, points, and areas include features like closed doors, measuring sticks, switchable forbidden lines or areas, one-ways, and many more. You must enable some of these features under the Config button, Robot Operations tab, Map features (likewise, you can also
disable those you do not want to use). See Restricting Traffic on page 215.
1. With the map active, click the Draw tab, click the drop-down menu triangle for either
Advanced Lines or Advanced Areas, to display the available types, then select the type
you want to add.
2. Click on the map where you want to start placing the line or area and, while holding
the left mouse button down, drag the mouse to where you want the line or area to end.
3. If an Edit Advanced Line/Area dialog box appears, enter the needed information, then
click OK.
4. Click the right mouse button to display a pop-up menu that allows you to edit, copy
and cut the forbidden line or area.

Inserting a Map File into an Existing Map File
The Insert Map feature is helpful, if there have been small or medium changes to the AMR's
environment. You do not need to rescan the entire workspace and recreate the map file. To use
the Insert Map feature, you can scan the area of the environment that has changed, turn that
into a map, and insert it into an existing map.
In certain situations, you might want to insert only a subset of the region's data into the original map. For more information, refer to Using the Advanced Insert Option on page 107.
Inserting a Map Into an Existing Map File

In MobilePlanner, select a map to insert into an existing map.
l

Select File > Insert Map from the main menu. A dialog box appears, which lets you
search for and select a local map file to open.

The new map appears in the active map as a blue rectangle, and the Insert Map toolbar allows
you to manipulate the inserted map.
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Figure 7-11. MobilePlanner, Insert Map Tools
Using the Insert Map Toolbar

Use the Insert Map Tools to position the inserted map into the existing map. After selecting a
map section to insert, the toolbar automatically displays.

Figure 7-12. Insert Map Toolbar
The following table describes the buttons on the Insert Map Tools toolbar.
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Insert Map Toolbar Button

Description

Insert

Works on intrinsic map data (points, lines, lights, etc.), and inserts
the new map into the existing map at the blue rectangle. The
Advanced insert lets you choose a subset of the previously mentioned data, and make other adjustments like inserting user-created map items (e.g., goals, docks, sectors, etc.). See Using the
Advanced Insert Option on page 107 for details.

Cancel

Cancels the insertion.

Region

Defines the region to insert (useful if the default insert region is too
big), or to have the newly inserted area properly overlap the old
area. See Define the Insert Region on page 106.

Reset

Erases all rectangles and restarts the region definition.

Lock

Locks the inserted map at its current position in the map. This can
prevent accidental changes when panning and zooming the map.
Turn off the button to enable more changes.

90° Left/90° Right

Rotates the inserted map 90° left or right. Use the Degrees field to
set degrees of rotation (as measured from the x-axis in the
counter-clockwise direction).

Up/Down/Left/Right

Moves the inserted map up, down, left or right. Allows small adjustments to the inserted map's position.

Help

Opens help information on the insertion process.

Position the Inserted Map

You can adjust the inserted map's location and orientation to position it correctly in the existing map as follows:
1. Hold down the left mouse button and drag the inserted map like any other object.
2. Use the Insert Map Tools’ Up, Down, Left, and Right buttons to make small adjustments to the insert's position.
Adjustment size depends on the map's zoom. To make a very small adjustment, zoom in;
zoom out for a larger adjustment.
Define the Insert Region

The shaded blue rectangle is where the inserted map will replace a portion of the existing
map. By default, all black data points on the blue background will be deleted (unless doing an
advanced insert with ‘retain overlapping,’ in which they will remain).
If the default insert region is too big, click the Insert Map Tools' Region button to define a new
one. The default region clears (and becomes gray) and the insert locks at its current position.
Use the mouse to draw a set of blue rectangles over the exact area to be replaced.
You should define the insert region after moving the map insert to the correct location.
You can use Edit /Undo and Redo from the MobilePlanner main toolbar while defining the
insert region (Undo deletes the last added rectangle). To erase all rectangles and restart the
whole process, press the Insert Map Tools' Reset button.
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Complete the Insertion

After correctly positioning the map insert and defining the insert region, click Insert to finish
the insertion. It might take a few seconds for the original map to update. The process is complete when the shaded blue area disappears and the Map Insert toolbar closes.
If the resulting map is not correct, then press Edit / Undo from the MobilePlanner main toolbar
to restore the map to its original state (which might take a few seconds).
NOTE: The insertion process is not automatically resumed; you must restart it.
Using the Advanced Insert Option

Occasionally, you might want to insert only a subset of the region's data into the existing map.
To Use Advanced Options

1. In the Insert Map toolbar, left-click on the Insert button.
2. In the pulldown menu, select Advanced.

Figure 7-13. MobilePlanner, Advanced Insert Options Dialog
The dialog box has check boxes for each data type in the inserted map. To display nondata types, click the Include user-created map items... checkbox (shown checked in the
image above).
3. Click the checkbox for each data type that you want to insert. Note that any corresponding map items are displayed in blue.
4. To retain the original map data as well as the inserted data, check the Retain overlapping items . . . checkbox.
5. Click the Insert button to complete the insertion and close the dialog box.
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Saving the Map on the AMR
The scan file that came from your AMR is saved on your local PC until you explicitly save it
elsewhere.
To save the map on the AMR, from the MobilePlanner menu, select:
File > Save on Robot
Select the .map file that you just edited, and click Save to save the map onto your AMR.

7.5 After the Map
If you need to adjust the scan settings, see the next section. Otherwise, you need to localize the
AMR. Refer to Set the AMR's Initial Location on page 111.
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Changing the Scan Settings
To adjust the processing, scan, clean, and map settings, click Settings from the Scan Processing Tools toolbar.

Figure 7-14. Scan Processing Tools Toolbar
Button

Description

Start

Initiates the scan session.

Pause

Temporarily pauses the scan session.

Rewind

Rewinds the AMR’s path (blue trail) through the scanned area as shown on the
MobilePlanner map.

Step

Allows you to step through the AMR’s path, one segment at a time.

Finish

Completes the scan conversion process.

Save As

Allows you to save the newly created map with a specific name and location.

Clean

Allows you to manually remove unwanted scan points from the map.

Reset

Reset “uncleans” any cleaning work you have done on the map.

Settings

Allows you to change scan tool configurations.

Auto Fit

Scales the scan file image to the MobilePlanner map window as you add more
information.

Track

Centers the AMR in the scan image - works similarly to ‘center on robot’ in a normal map.

Help

Opens a help file to search for specific help topics.
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The Scan Settings dialog box appears as shown below.

Figure 7-15. MobilePlanner Scan Settings Dialog
The following table describes the settings available from the Scan Settings dialog box.
Processing Settings

Description

Start scan when file opened

Disable this option to prevent the scan conversion process from automatically starting when you open the
scan file in MobilePlanner. Allows you to adjust the scan
settings before conversion. To start the process, click
on the Start button from the Scan Tools toolbar.

Clean after scans registered

Disable this option to leave all scan points in the map.
Any cleaning must be done manually by pressing the
Clean button.

Prompt to save after scan complete

If this option is disabled, then the Save Map File As window is not automatically displayed.

Run in batch mode

Enable this option to process multiple scan files at the
same time.

NOTE: The files must all be of the same
type. For example, they all must be basic
scan files or all must be light localization
scan files, they cannot be a combination
of the two.
<filename>.map, overwriting any
existing files

20569-020 Rev. D

Select this option to overwrite the file name in batch
mode.
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<filename>_<currentDateTime>.map, less risk of
overwrite

Select this option to have the current date and time
added to the filename with each new scan conversion
processed in batch mode.

Scan Settings

Description

Maximum Range

Specifies the maximum distance, in mm, used for the
laser data.

Linear Error

The forward/reverse error, expressed as the average
variation (in mm) per meter of travel.

Lateral Error

The left/right error, expressed as the average variation
(in mm) per meter of travel.

Use Loop Closing

Used for open areas - indicates that the AMR has
returned to a known location. Minimum Loop Probability allows you to set how closely the current position
must match a previous scan. Default is 80%.

Use Gyro Error Model

Specifies allowable errors to correct for when registering laser scans collected during mapping.

Scan Matching Mode

Choose between Normal or Fast matching. If you select
Fast, the scan match is performed only when
MobilePlanner is in the registration phase.

Clean Settings

Description

Grid Size

Sets the size (in mm) of grid cells used to check
whether the reading represents a real map point. A
small value gives more cleaned readings; a large value
includes more points in the map.

Max Range

Sets the maximum distance (in mm) from the AMR in
which readings are considered for inclusion in the map.
This value only affects the cleaning process; it does not
affect the range used during the registration phase.

Map Settings

Description

Resolution

This adjusts the resolution of the map created from the
scan file.

Set the AMR's Initial Location
It is important to establish the AMR’s starting location, which is also known as localizing
your AMR. When you "localize to a point" on the map, you provide the AMR with location
data. This data allows the AMR to match its current location with the same location on the
map.
As the AMR attempts to find its location on the map, it provides a localization score, or confidence level. This confidence level should be 80% or better for the AMR to navigate properly.
For more detailed information on localization, refer to AMR Localization on page 228.
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To Set the AMR's Starting Location:

1. Click the Map button, then click Show Robot.
The Map tool bar displays AMR control icons.
2. Click Localize Robot.
This puts the map into localize-to-point mode (and changes the cursor to indicate the
new mode). Refer to Robot and Map Toolbars on page 65.
3. Click and hold on a spot on the map where you want the AMR located. This is where
you want the confidence threshold, or Localization Score, to be 80% or better as shown
below.
While still holding the mouse button down, drag the localization mark's direction indicator to the direction the AMR is facing. The AMR will choose the most likely pose near
the clicked location. If the initial localization does not look correct, localize the AMR
again until it appears in the correct location.

Figure 7-16. Localize to Point Dialog Box
4. Click Done when the AMR's localization score is where you want it to be.
The AMR is now localized and you have successfully set the AMR's current position.
NOTE: You must set the AMR’s current position the first time you put
the AMR in a different map.
What’s Next?

Now that your AMR is configured, you have scanned its operating space and created a
detailed map, you can do any of the following:
l
l
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To edit your map further, see Working with Map Files on page 90.
To learn about and start using MobilePlanner software, see Using MobilePlanner
Software on page 50.
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l
l

To configure your AMR, see Configuring the AMR on page 140.
If you are familiar with MobilePlanner and want to set up goals and tasks for
your AMR to perform, see Working with Macros, Tasks, and the Route Builder
on page 150

After Driving the AMR
After you're done driving the AMR, select Robot > Dock from the software main menu, or
click Dock, to return the AMR to a dock.
Auto Dock

The Config > Robot Operation > Docking > Autodock parameter is the primary control for the
AMR's automatic docking, and is normally set to True.
If the Autodock parameter is set to False, and you don't want to manually dock the AMR each
time, using the Auto Dock menu item (Main Menu > Robot > Robot Tools > Auto Dock) will
override the configuration parameter. The AMR will return to a dock when the charge is running low.
NOTE: If the Autodock parameter is set to True, you can override that behavior
by turning off automatic docking. If you do this, remember to turn it back on
when you are done, or the AMR will not recharge and eventually stop running.
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SetNetGo runs on both the AMRs and an EM2100 operating as a Fleet Manager. It sets the configurations for certain onboard systems, such as wireless communication settings.
You can access SetNetGo either from the MobilePlanner SetNetGo interface, or directly on the
AMR using a secure web-based server. If needed, your organization’s IT group can configure
your wireless Ethernet for you.

8.1 Overview of the SetNetGo OS
The SetNetGo software allows you to configure certain on-board systems, such as the Ethernet
interface settings, serial and TCP port-forwarding, and to perform systems diagnostics, such as
examining and retrieving log files.

Connecting to SetNetGo
Access SetNetGo from MobilePlanner

The recommended way to connect to the SetNetGo OS is through the SetNetGo interface in the
MobilePlanner software.
During normal operation, you access SetNetGo through the MobilePlanner software as follows:
1. Start the MobilePlanner software on your PC.
2. Enter the IP address for an AMR or your Fleet Manager, then click Connect.
3. Click anywhere in the SetNetGo selection box, to access the SetNetGo interface.

Figure 8-1. Hover Over the SetNetGo Selection Box
Hover over the selection box to reveal its boundaries. (See the cursor in the preceding figure.)
NOTE: It is not necessary to enable (check) the checkbox within the
SetNetGo selection box to open the application. The checkbox determines
whether the SetNetGo window opens automatically when you open
MobilePlanner.
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Figure 8-2. SetNetGo Interface—Status Tab, Home Screen
This is the SetNetGo home screen. It provides an overview of link status, IP addresses, and
installed software versions.
Connecting to SetNetGo via web browser

You can also access the SetNetGo software via a web browser (such as Chrome, Firefox or Internet Explorer) if, for example, your IT department is helping with network configurations, or
you don’t have access to your laptop with MobilePlanner installed on it.
NOTE: Web browser access must be enabled in SetNetGo > Security tab >
SetNetGo Access. To do this, connect one end of an Ethernet cable to your computer and the other end directly to the AMR’s Ethernet Maintenance port.
If you have an LD-series AMR, set your IP address to 1.2.3.5 with a
subnet mask of 255.255.255.0 and connect to SetNetGo Maintenance
port at the URL: https://1.2.3.4.
If you have an HD-series AMR, set the adapter to automatically
obtain an IP using DHCP and connect to SetNetGo Maintenance
port at the URL: https://169.254.10.15.
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Figure 8-3. Browser URL Address
NOTE: You can ignore the SetNetGo certificate error. Click "Continue to this
website (not recommended)." to display SetNetGo.

Figure 8-4. Browser Certificate Warning

8.2 Using the SetNetGo Interface
SetNetGo resides on the AMR and any EM2100 operating as a Fleet Manager or Fleet Simulator, and is accessible through the SetNetGo interface in MobilePlanner.
The Fleet Simulator cannot be accessed through MobilePlanner - you have to access SetNetGo
through a web interface instead.
NOTE: If you are unable to access MobilePlanner, you can still access SetNetGo
by connecting your PC directly to the AMR's Ethernet Maintenance port (using
Ethernet cable). To do this, connect one end of an Ethernet cable to your computer and the other end directly to the AMR’s Ethernet Maintenance port.
If you have an LD-series AMR set your IP address to 1.2.3.5 with a
subnet mask of 255.255.255.0 and connect to SetNetGo Maintenace
port at the URL: https://1.2.3.4.
If you have an HD-series AMR then set the adapter to automatically obtain an IP using DHCP and connect to SetNetGo Maintenace port at the URL: https://169.254.10.15
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NOTE:
The SetNetGo start-up screen, accessed from MobilePlanner, is shown below.
NOTE: The Download debug info button provides a debug file that can be used
for troubleshooting and other support requests.

Figure 8-5. SetNetGo Interface
The SetNetGo menu, shown at the top of the screen, consists of the following tabs:
Menu Option

Sub-Menu Option

Status

This menu option displays various logs and status updates. See Viewing the
Status Logs on page 121 for details.
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Description

Home

Returns you to the SetNetGo home screen.

ARAM (AMR) or
ARAMCentral
(Fleet Manager) Log

Gives the option to display the entire ARAMCentral
log, the last 200 lines, or continuous refresh displaying the last 200 lines of the ARAM log within
SetNetGo. It also allows you to view the current log
file or download of the last 7 log files.
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Network

Displays the current status of network interface, the
wireless interfaces status and the routing table.

SetNetGo Log

Displays the SetNetGo log file.

SetNetGo
Resources

Displays status of your resources, including processes currently running on the AMR or Fleet Manager, Kernel Log, Disk Usage, Memory Usage, the
Interrupts table, IO Memory usage and IO Port usage
tables, and USB Devices.

Debug Info

Downloads a .zip file containing detailed information
on system status for troubleshooting.
NOTE: Download a debug file before
requesting support.

Simulator

This heading gives access to the Fleet Simulator option. This is covered in
detail in the Fleet Simulator User's Manual (Cat. No. I641). This heading will
not be displayed if the Fleet Simulator license is not detected on the
EM2100 or if SetNetGo was accessed from MobilePlanner. SetNetGo can not
be accessed through MobilePlanner in Fleet Simulator mode.

Network

Configurations for setting up your network. See Network Tab on page 121
for details.
AMR Only
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Wireless Ethernet

These parameters allow you to enter static or
dynamic IP settings (IP Assignment and Address, Netmask, Gateway, and DNS1); select a WiFi network;
configure security settings (i.e., encryption and
authentication); and configure Radio settings, including Watchdog Timer.

User LAN Ethernet

This screen has settings for interface mode, IP
Address, Netmask, DHCP Server for Accessories, and
DHCP IP Range. If you are using an EM2100 or a network-based hardware accessory for an AMR, you
must set up a wired Ethernet port. Use Accessory
mode (default) for individual AMRs, and server mode
with an EM2100.

RS-232 Port Forwarding

Forwards a custom TCP port on the wireless Ethernet
interface to an RS-232 port on the AMR’s core. The
TCP port and serial port settings are configurable.

Ethernet Forwarding

Supports forwarding a custom TCP port on the wireless Ethernet interface to a custom TCP port on an
IP address of a device connected to the User LAN
interface. The TCP port numbers and IP address are
user-configurable.
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Fleet Manager Only
Management Interface

This page allows configuration of the Management
(MGMT) Ethernet interface with a static IP address.
The network host configured as the "Management
Interface" is the primary host for web configuration
via a browser.

Fleet Interface

This page allows configuration of the Fleet Ethernet
interface with a static IP address. The network host
configured as the "Fleet Interface" is the primary
host for all Fleet Management connections, including
use of Mobile Planner to connect with a Fleet.

AMR and Fleet Manager
Utilities

On an AMR, use this tab to ping a specific IP address,
initiate trace route (display packet path), and display
the ARP table (correlate MAC address and corresponding IP address).
On a Fleet Manager, this page permits running several network diagnostic tools on the AMR or appliance, including well known tools `ping`, `arp`, and
`traceroute`.

Software

Licensing

119

Configurations for ARAM/ARAMCentral settings (including install new software versions)
ARAM Settings or
ARAMCentral Settings

Change advanced settings for recovery, such as
reverting the configuration back to defaults.

Manage Installed
Software

This tab displays current versions of installed software, with options to view release notes, restart,
uninstall, or disable application(s), and view runtime
logs. Also allows you to download MobilePlanner, and
update the mobile software.

Configurations of existing licensing and upload/download of information for
license activation and updates.
Information

This page displays license information, including
name of the license, current status and expiration
date, for any license relative to that specific device,
either Fleet Manager or AMR.

Upload

This page allows upload and provisioning of new
licenses or license updates, which are provided by
your OMRON representative.

Download

This page allows download of license information files
for this device. This file must be provided when contacting your OMRON representative for license
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updates.
Security

Manage Fleet user accounts and AMR access.
Fleet or ARAM
Accounts

This page allows you to manage access controls that
restrict who can access the AMRs and Fleet Manager
with MobilePlanner. Allows you to specify specific
access controls for admin, operator, and viewer
access, and other users. You can also add new users
to the access list. AMR only.
This page allows configuration of Fleet Accounts,
including usernames, passwords, and permissions.
Fleet Accounts are primarily for user privilege separation and must be provided when connecting to a
Fleet Manager or AMR through MobilePlanner. Fleet
Manager only.

System

SetNetGo Access

Allows you to enable or disable Web availability via
Wireless/User LAN interface, and set access password.

Integration Toolkit

This page allows generation and regeneration of the
password required for all Integration Toolkit-provided
services. This password must be configured in order
to access fleet data through the Integration Toolkitprovided services, which include SQL via postgres,
AMQP via rabbitmq, and a REST API via HTTPS.

Manage date/time, upload new SetNetGo OS, conduct backup and restore
operations.
Date/Time

Set time, zone, and NTP Server.
NOTE: The AMRs will automatically
synchronize with a Fleet Manager. Use
NTP on the Fleet Manager or for single
AMR operations.
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Upload SetNetGo
OS

Upload and install a new SetNetGo version.

Backup/Restore
Options (AMR only)

Allows you to configure restore settings (from the
same, or a different AMR), set a new backup restore
point, or revert to a different restore point.

Reboot

Allows you to reboot the AMR's computer (core) or
EM2100 appliance. Normally not a visible option
unless enabled by checking the Remote Reboot radio
button in SetNetGo > Security > SetNetGo

NOTE: The system can store two different OS images. You can select which
version to load into each slot, and
choose which is the bootable image.
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Access.

!
Mode (EM2100
only)

CAUTION: Rebooting the AMR's core
interrupts all AMR operations, and
could cause damage to the AMR.
Rebooting the appliance will disrupt all
jobs and AMRs.

This page allows configuration of the appliance operating mode. The mode determines if the appliance
will run as a Standalone Fleet Manager, a Paired Fleet
Manager, or a Fleet Simulator.

8.3 Viewing the Status Logs
SetNetGo keeps track of various AMR activities, including ARAM, networking, and resource
use. This information is stored in status logs that you can view through SetNetGo.
To view the status logs:
1. Connect to SetNetGo through the MobilePlanner SetNetGo interface.
2. Select the Status link at the top of the SetNetGo screen.
The SetNetGo Status screen appears as shown in SetNetGo Interface on page 117.
NOTE: The Download debug info button is critical for taking a backup of
the current configuration, and providing this information when requesting
support.
The status logs you can view depend on whether you are connected to SetNetGo through a
Fleet Manager or a single AMR. Generally you can view the following type of status logs:
l
l
l
l
l

ARAM (on the AMR), ARAMCentral (on the Fleet Manager)
Network
SetNetGo Log
SetNetGo Resources
Debug Info

8.4 Network Tab
Use SetNetGo to configure the AMR's network settings. For remote access to your AMR, you
should set up a static IP address. If you are not familiar with setting up a network or do not
have an assigned IP address for the AMR, please refer to your system administrator.
NOTE: After changing a value in any SetNetGo screen, you must click Apply
before switching to another sub-screen, or those values will not be saved.
To configure your AMR's network settings:
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1. From the MobilePlanner SetNetGo interface, connect to SetNetGo.
2. Select the Network link from the top of the SetNetGo screen.
The SetNetGo Network screen appears as shown in the following figure.

Figure 8-6. SetNetGo Interface - Network Tab
Wireless Ethernet Settings

Select Network > Wireless Ethernet to set up the wireless Ethernet interface. The table below
describes the parameters that you can modify.
Wireless Ethernet Menu
Parameter Setting

Definition

IP Assignment

Select the Static radio button to set a known IP address. You
can also use DHCP, but a static IP address is recommended.

IP Address

Enter the IP address assigned to the AMR you want to access.

Netmask

Enter the Netmask.

Gateway

Enter the Gateway address.

DNS1

Enter the DNS1 address or leave it as 0.0.0.0 to disable.

WiFi Network Settings
Selected Network

20569-020 Rev. D

Displays the wireless network to which you are currently connected.
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NOTE: Clicking on a network name in the list
will automatically populate the encryption and
authentication fields.
Network list

Displays a list of available WiFi networks.

Security Settings

NOTE: The fields listed below will change based on the security method you
select, and could include username, password, private key (download or create new)/key length, hostname, and certificate (choose an existing or upload
new). If unsure about settings, ask your IT department for assistance.
Encryption

Set this to match the encryption method that is used on your
network. Options are 64-bit or 128-bit WEP, TKIP/RC4,
CCMP/AES, and TKIP/CCMP/AES.

Authentication

Set to match your authentication type. Use OPEN (default)
when using no authentication or when using WEP. Select WPAPSK for WPA Pre-shared key, PEAP-MSCHAPv2, or EAP-TLS.

Pre-Shared Key (PSK)

If using WPA/WPA2-PSK, enter the shared key in this field.

Key Type

Select from (click the radio button) Passphrase (8-63 ASCII
only), or Raw Hex (64 Hex only).

Radio Settings
Radio Mode

Select the mode that your network uses: 802.11a, 802.11b,
802.11g, 802.11n, or 802.11ac. Select Auto to allow the AMR
to choose the most suitable channel from 802.11a/b/g (may
lead to longer roam times).

Channel Set

Set to match the channels that are used at your site or leave
them all selected (default) to allow the AMR to find the most
suitable channel. Roam times will be faster if there are fewer
channels selected.

802.11b/g Channels (2.4
GHz)

Use this list to select a specific WiFi channel (1 through 13) in
the 2.4 GHz range

802.11a Channels (5 GHz)

Use this list to select a specific WiFi channel (36 through 165) in
the 5 GHz range

Wireless Log Level

Determines the level of WiFi scanning detail in log files and
debug info. Default is Normal. Set to Verbose for debugging
efforts. If set to Verbose, log files cover a much shorter period of
time. Recommend leaving at Normal.

RSSI Roam Threshold

Determines the frequency of background scanning. Default is
50. If signal strength is higher than the threshold, scanning
happens at 10X the Background Scan Interval. If signal
strength is below the threshold, scanning occurs every Back-
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ground Scan Interval seconds.
Background Scan Interval
(sec)

Works with the RSSI Roam Threshold to determine how frequently the AMR performs background scanning. Default is 3
seconds (recommend leaving at default)

Watchdog

If enabled, automatically pings the Fleet Manager (if used) or
the gateway IP address. If successive pings fail for Watchdog
Timer seconds, the AMR automatically resets the wireless interface.

Watchdog Timer (sec)

If pings to the Fleet Manager fail consecutively for Watchdog
Timer seconds, the wireless Ethernet interface automatically
resets and attempts to reestablish communications.

User LAN Ethernet Settings
User LAN Ethernet Settings
Parameter Setting

Definition

Interface Mode

Use to set up a wired accessory interface (e.g., Acuity or the
touchscreen) for the AMR. This mode allows you to connect network-based, hardware accessories to the jack. Onboard
accessories will be able to communicate with the software running on the AMR’s core, and reach the rest of the network via
the AMR’s wireless interface.

IP Address

Set the IP address for this interface. Select a subnet that does
not conflict with settings on the wireless Ethernet interface.

Netmask

Enter the Netmask.

DHCP Server for
Accessories

Disable or enable (default) a DHCP server for an accessory on
the AMR.

NOTE: You must enable this parameter for both
Acuity and the touchscreen (for more information
on these options, see the Mobile Robots - LD Platform Peripherals Guide.).
DHCP IP Range

Allows you to set the DHCP IP range for the address automatically assigned to the accessories.

Port Forwarding

If your AMR’s payload has devices connected to the User LAN or Serial (RS-232) port, you can
forward those ports and make the payload’s device accessible via WiFi. Configure both RS-232
and Ethernet port forwarding in SetNetGo in the Network tab.
RS-232 Port Forwarding

Controls forwarding serial data to a TCP port on the wireless and internal wired Ethernet networks. You can link an internal serial device and route it to an external port at a defined baud
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rate. This is useful for RS-232 devices connected to the AMR’s core, and accessing them over
WiFi.
Ethernet Forwarding

These settings forward a TCP port on the User LAN Ethernet interface to a port on the Wireless
Ethernet interface. The Internal IP Address is the IP address of the device connected to the
AMR core’s User LAN connection. Internal and External port setting route the Ethernet connection through WiFi.
Utilities

These tools allow you to view the ARP table, and ping or run a trace route to a specific IP
address.

8.5 Software Tab
The SetNetGo software tab offers choices for ARAM Settings and Manage Installed Software.

ARAMCentral/ARAM

Figure 8-7. SetNetGo, Software Tab - ARAM Settings
l

l
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ARAMCentral Settings (main software on the EM) - configure ARAMCentral’s features
(disabling ASync logging, disabling ARCL, and disaster recovery settings.
ARAM Settings (main software on the AMR) - configure ARAM’s features (disaster
recovery settings).

Fleet Operations Workspace Core User's Manual

20569-020 Rev. D

Manage Installed Software
The settings in this section allow you to view current versions and status (for example,
Enabled Running, or Disabled Not Running) of software installed on the EM2100 appliance or
AMR.

Figure 8-8. SetNetGo, Software tab - Manage Installed Software
You can also use the functions on this tab to restart, disable, install and/or uninstall
MobilePlanner software, the MARC or Polo microcontroller firmware.

8.6 Licensing Tab
The SetNetGo licensing tab allows you to get information, including license name, status, and
expiration date of any license that applies to the device you are currently connected to. It also
allows you to acquire, renew or upgrade any licenses from the field on either a Fleet Manager
or an AMR. Follow the following instructions in the given order to do so:
1. Go to the SetNetGo web interface of the Fleet Manager appliance or the AMR and open
the Licensing tab. Click on the Download option in the left pane.
2. On the download page, click the Download button.
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Figure 8-9. Licensing Download Screen
The downloaded C2V file will have the format:
1234567890-MMM-DD-YYYY.C2V

where MMM represents the first three letters of the current month, DD the day of the month,
and YYYY the current year.
NOTE: OMRON recommends that you establish a specific location and folder
in which to store these license key files, in the event that they need to be accessed
in the future. We also recommend that the C2V ID number (the first ten digits in
the C2V file name) be referenced to its particular EM2100 or AMR to ensure the
matching license key file can be quickly identified and uploaded to that EM2100
or AMR.
3. Send the C2V file to your OMRON representative or integration partner and request the
appropriate license for the Fleet Manager mode or for the AMR Advanced Feature that
you have selected. You will receive a V2C file with an ID and Date that matches the
C2V file that you submitted.
4. Confirm the file names match before proceeding. If the filenames do not match, then contact your OMRON representative or integration partner and report the issue.
5. Go to the SetNetGo web interface of the Fleet Manager or AMR. Select the Licensing tab
and choose the Upload option from the left pane.
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6. Click Choose File and select the appropriate V2C file.
7. Once the file is chosen, the SetNetGo Web UI shows the specific filename. Click Upload
File.

Figure 8-10. Licensing, Choosing a File to Upload
Now that a valid license is activated, SetNetGo will initiate the requested mode by starting the
appropriate code on your Fleet Manager or AMR.
NOTE: After a C2V file has been submitted to obtain a license, it can not be
reused. If you need another license you have to generate a new C2V file for the
request. Likewise, a V2C file can not be reused with SetNetGo, either.

8.7 Uploading, Backing up, and Restoring SetNetGo
Through MobilePlanner, you can upload (upgrade to) a new version of SetNetGo by simply
choosing the proper file.
Your upload options allow you to choose whether to upload a new version of SetNetGo into
the Boot Image A slot (which is the default image slot), or the Boot Image B slot (which you
then have to make bootable), or have versions in both slots.
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In case of a software failure, you can also restore SetNetGo from a file maintained on the same
(or a different) AMR. You can only restore to a specific restore point on an AMR (identified by
its date/time), but only from the last restore point, and only on that AMR.

8.8 Uploading a New SetNetGo OS
1. In the MobilePlanner tool bar, click the SetNetGo button, then click the System tab, then
click the Upload SetNetGo OS menu item (left-side pane).

Figure 8-11. SetNetGo, System Tab
The Upload New SetNetGo OS page, Current Versions field, contains information about
the current installed version (with option to view its release notes), and which image is
the current bootable image (Image A in the example above).
2. To install a new SetNetGo version into the Boot Image A slot, click the Choose File button, and browse to the location of the new image file. To upload a file, click the Upload
File button.
NOTE: Clicking the Upload File button will upload a new SetNetGo package, which will overwrite the existing image in the Boot Image A slot, and
ask you to confirm before proceeding.
3. Click Open when done.
4. To install a new image file into the Boot Image B slot (and make it bootable), click the
Choose File button then, when you’ve chosen the file, click the Make Bootable button.
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8.9 Backing Up and Restoring SetNetGo
As with any system, it’s a good idea to back up your system files frequently, especially after
making configuration changes. After backing up, you then have a file from which you can
restore your system back to working condition if a version becomes corrupted, if you swap
AMR cores, or add a new AMR to your fleet that’s identical to the others.
Creating a restore point

When you back up your system, the resulting file is date and time stamped with the current
day and time of backup, and becomes a specific restore point (overwriting the your previously
saved restore point).
1. In SetNetGo, click the System tab, then click the Backup/Restore Options item.
2. In the Restore-Point field, click the Backup now button.
The following advisory dialog appears.

Figure 8-12. SetNetGo Create Restore Point Dialog
3. Read the confirmation then, if sure you want to proceed, click OK.
Reverting to a Restore Point

Reverting to a previously saved backup (restore point) takes your AMR’s core back to its configuration as of the date and time of the restore point file you select. During the restore, you
will lose your connection to MobilePlanner while the restore process resets your configurations.
1. In SetNetGo, click the System tab, then click the Backup/Restore Options item then,
under the Restore-Point heading, click the Restore Now button.
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The following advisory dialog appears:

Figure 8-13. SetNetGo Confirm Restore Dialog
2. Read the confirmation then, if sure you want to proceed, click OK.
The selected file overwrites the previous settings in the AMR’s core, and the AMR disconnects from MobilePlanner. After the restore is complete, you can reconnect to the
AMR.
Restoring Settings from DebugInfo File

If you swap an AMR’s core, and want to update the new core with all of the existing configuration info from that AMR onto the new core, you would use the Restore from same robot
option. This process does not overwrite other software on the core; you should verify those software versions.
NOTE: The Restore from same robot option does not include WiFi credentials
(i.e., key, passphrase, certificates) or overwrite currently existing versions of other
software (you should determine which versions to use).
If you have a fleet of one type of AMR and are adding another AMR of that type to your fleet,
you would use the Restore from different robot option. This feature gives a quick method of
configuring the new AMR so it performs identically to the others.
NOTE: The Restore from different robot option does not change IP address or
AMR calibration data (including AMR identifier). After using this option, you
will need to re-set your AMR’s WiFi, IP address, and identifier.
1. In SetNetGo, click the System tab, then click Backup/Restore Options from the list on
the left.
2. Under the Restore Settings from DebugInfo File heading, click Choose File for either the
Restore from same robot option (see explanation above for example use case), or the
Restore from different robot option (see explanation above for example use case).
3. In the Open window, browse to and select the file you want to upload, then click Open.
4. Verify the correct file name appears next to the Choose File button, then click the
Upload button.
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An advisory dialog will be displayed, asking for your confirmation.
5. Read the confirmation and, if sure you want to proceed, click OK.
NOTE: Both of these processes creates a new restore point.

8.10 SetNetGo Recovery Mode
If your system experiences a serious software malfunction, you can recover:
1. In SetNetGo, click the System tab, then click on the Upload SetNetGo OS item.
2. At the bottom of the window in the Recovery Mode field, click the Reboot and Enter
Recovery Mode button.

Figure 8-14. SetNetGo Recovery Mode
3. If you are certain you want to proceed, click OK.
4. After the system reboots into recovery mode, power down the AMR, and follow normal
start-up procedures.

8.11 Configuring ARAM
This section covers using the SetNetGo to set up and manage accounts, and to update the
ARAM software.

Setting Up User Accounts
The SetNetGo Security tab allows you manage access control for accessing AMRs and the Fleet
Manager via MobilePlanner. This allows you to restrict users from performing specific tasks.
NOTE: At least one account must be enabled at all times. SetNetGo will enforce
this.
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1. From MobilePlanner, click the SetNetGo button, then click the Security tab.

Figure 8-15. SetNetGo Interface - Security Tab
By default, access control for connecting to AMRs and/or Fleet Manager is enabled.
2. To change the access password for the admin, operator, or viewer accounts, click the
associated Enabled radio button, then click Apply next to each modified username.
Any change to account information will force a restart of ARAMCentral or ARAM.
3. Continue to the next section to set up user accounts.
To Set Up and Manage User Accounts
1. In MobilePlanner, open SetNetGo.
2. Click on the Security tab to display the page for Fleet Accounts (on the Fleet Manager)
or ARAM Accounts (on the AMR).
3. Follow the instructions in the table below to add, delete, or edit a user account.
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To...

Perform the following steps

Add a user
account

1. Enter a Username in the Add a new user field.
2. Enter a password in the first Password field (on the same line as the
username). User names and passwords can have letters, numbers,
special Unicode marks, underscores, and periods (.). Do not use spaces
or other special characters.

3. Re-enter the same password in the Confirm Password field.
4. Click Add, and verify the new user account appears under the Username column.
Delete a
user
account

1. Click Delete in the line of the username you want to delete.
2. Click Apply to remove the user account from the list in the Username
column.

Permission Groups

For each user account, you can enable and disable access to various features in MobilePlanner.
For example, enabling FileUploading allows the user to upload and download files from
MobilePlanner to the AMR.
1. To modify account permissions for each user (for example, admin user), click Modify
Permissions (to the left, and below the Apply button) to display the Change Account Permissions page.
The example below shows account permissions page for the admin user who, by
default, has all permissions assigned. Other users have different sets. Use the side scroll
bar to see all permissions.
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Figure 8-16. Change Account Permissions Page
2. Check the box(es) for the permission(s) you want to grant to the selected user account.
You can quickly assign all permissions by clicking Select All, or click Select None to
clear all assigned permissions.
3. Click Apply to set the selected account’s permissions, and return to the ARAM
Accounts page.
Operator Account

The Operator Account, by default, has the following privileges:
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CustomCommands

l

Localize

l

Map

l

Movement

l

Motors

l

Navigation

l

NavigationInfo

l

RobotInfo
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l

SensorInfo

l

Shutdown

l

SoundFromRobot

l

SoundOutRobot

l

Stop

l

MovementUnprotected

l

QueueInfo

l

QueueModification

l

FileDownloading

Updating Fleet Operations Workspace Core
For an updated Fleet Operations Workspace Core package, contact your
OMRON representative.
To Update the Fleet Operations Workspace Core

1. In MobilePlanner, click the SetNetGo button, then click the Software tab, then click
Manage Installed Software from the left side list.
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Figure 8-17. SetNetGo Interface - Software Tab
2. Click the Choose File button to access the directory where the update file is located, and
click Open.
3. Confirm the correct file name is listed next to the Choose File button, then click Upload.

Figure 8-18. Confirm Upload Dialog
4. If you are certain you want to proceed, click OK.

Figure 8-19. Software Upload Status
The AMR will be unavailable as it goes through its restart sequence (a status window shows
restart progress).
If the installation was successful, the new Mobile Software version appears in Manage
Installed Software.
Viewing Software Packages

Clicking a package name expands the selection and shows the options for that package, which
can include:
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l

Release notes.

l

The option to enable or disable the package (if the package is executable).

l

Log files.

l

Uninstall (if available).

Restarting ARAM

ARAM automatically stops when any changes are made, but you can click the Restart button
to force ARAM to restart.
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There are hundreds of parameters you can set in MobilePlanner to customize your AMR's operation in your environment. Other sections in this manual describe localization and mapping
parameters. This section describes AMR operation parameters.
This section covers the following topics:

9.1 AMR WiFi Capabilities
OMRON’s AMRs have multiple network interfaces, including a built-in wireless communications capability to enable their autonomous operations. The on-board wireless card can
use 802.11a, 802.11b, 802.11g, 802.11n, or 802.11ac wireless standard on 2.4 GHz or 5 GHz
channels, and the AMR will automatically switch between wireless access points as it moves
through its environment.
NOTE: If the AMR has difficulty connecting to a wireless access point, switches
between 2.4 GHz and 5 GHz channels, frequently disconnects, or has weak signal strength, try disabling the 2.4 GHz channel. If the problem discontinues,
inform your IT department of your finding.
The AMRs' wireless system can use the majority of the most common personal and enterprisegrade security methods and encryption, including:
l
l
l
l
l

l

Open
64-bit or 128-bit wireless equivalent privacy (WEP)
WiFi-protected access (WPA2)-pre-shared key (PSK) ASCII or HEX passphrase
Extensible authentication protocol-tranport layer security (EAP-TLS)
Protected EAP-Microsoft challenge handshake authentication protocol version 2 (PEAPMSCHAPv2), or
Advanced encryption standard/temporal key integrity protocol/counter mode with
Cypher block chaining message authentication code protocol (AES/TKIP/CCMP) encryption.

The AMRs can also use certificates (small files containing identifying information that allows
the AMR to connect to secure networks that require explicit identification and pre-authorization for access) with the following extensions:
l
l
l

l

.pem - a privacy enhanced mail (PEM)-encoded X.509 certificate
.pem/.cer/.crt - a PEM or distinguished encoding rules (DER) encoded X.509 certificate
.p7b - a Public Key Cryptography standards (PKCS7) file containing one or more certificates (contains no private key)
.p12 - a PKCS12 file containing one or more certificates (includes private key)

Your certificate authority (CA) server generates these certificates based on a certificate request
(.csr) file. You manually install the certificates on the AMR. The AMRs can generate their own
1024-bit or 2048-bit RSA keys, or use keys generated by the CA.
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9.2 Available Options and Peripherals
The following options and peripherals are available for your AMR (for more details, see the
Peripherals Guide for your AMR):
Pendant
The pendant is an optional hand-held input device for driving the AMR. It attaches directly to
the AMR's pendant port, and has controls to move the AMR forward and backward, turn left
or right, and adjust its speed. It also has a configurable goal button for adding goals while
mapping.
Acuity
In addition to using a safety scanning laser (navigation laser) to create a map of its environment, the AMR can, with an upward-facing camera mounted on top of the platform, use
overhead light localization for navigation (the laser then provides obstacle avoidance). Called
Acuity, this peripheral add-on is ideal for dynamic environments, such as warehouses, in
which objects on the floor undergo frequent location changes. For more information on localization, see What is Localization? on page 228.
NOTE: If not installed by the factory, Acuity requires installation of the Acuity
Support Package software via the MobilePlanner software. For information, see
the Mobile Robots - LD Platform Peripherals Guide (Cat. No. I613), found in the
OMRON corporate website.
NOTE: Acuity Localization is not currently available with the HD-1500 AMR.
High Accuracy Positioning System (HAPS)
The HAPS peripheral uses a sensor (called GuideSensor_Front in the Robot Physical configuration) installed in the AMR to detect and follow magnetic tape applied to the floor. HAPS
allows you to position the AMR at pick-up and drop-off locations with a high degree of accuracy. For more information, refer to the Mobile Robots - LD Platform Peripherals Guide (Cat. No.
I613) and the Mobile Robots - HD Platform Peripherals Manual (Cat. No. I646).
Side Lasers
Certain AMRs have side lasers to detect obstacles on either side (such as overhangs, tables,
etc.) to help the AMR navigate through tight areas, such as office spaces.
Touchscreen
The Touchscreen allows interaction with the AMR at any location. You can check the AMR’s
status, send the AMR to goals, pause or release the AMR, or localize a lost AMR.
Call Buttons and Door Boxes
Call buttons issue a request for the AMR to go to the call button’s associated goal. Door Boxes
act as remote I/O, and can issue requests to open closed doors equipped with a door activator
so AMRs can pass through it. For additional information, see Mobile Robots - LD Platform Peripherals Guide.

9.3 Types of Configurations
MobilePlanner allows you to view, modify, save, and import various AMR and fleet, and
debug configurations. You can set AMR interface, operation, and physical configurations,
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EM2100 configurations (queuing tasks, fleet features, and connection), and debug configurations that control the output of debug log files.

General Configurations
General configurations include site-specific parameters for the AMR interface (A/V config, connection timeouts, language/location, speech synthesis, etc.), AMR operation (bumper settings,
docking behavior, localization settings, path planning settings, task features, etc.), EM2100 features and connection, and debug information. General configurations are consistent across
your site. If you have a fleet of AMR, the general configurations reside on the EM2100. If you
have a single AMR, the general configurations reside in the AMR’s core.

Model and Calibration Configurations
These configurations relate to the AMR itself. Model configurations include AMR model-specific parameters like movement maximums, battery information, Acuity camera configurations,
the MARC configuration, AMR type, sensor type(s) and location(s), fleet queuing tasks, etc. Calibration configurations include general physical AMR information and parameters. Model and
calibration configurations always reside in the AMR’s core.

9.4 Setting the Configuration Parameters
Configuration parameters determine the available features on your AMR. You can enable or
disable them, or assign them a value. You can set these parameters in MobilePlanner.
Using the tabs listed here, you can set parameters for everything from audio feeds, to docking,
mapping, localization, server setup, move settings, and many more.
There are five AMR parameter tabs:
l
l
l
l
l

Robot Interface
Robot Operation
Robot Physical
Fleet
Debug

Click on a tab, such as Robot Interface, to open and view its sections. Clicking on a section
name displays the individual parameters in that section. The following graphic shows the A/V
Config section selected:
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2

3

1

4

Figure 9-1. Robot Interface Pane, A/V Config Parameters (not all shown)
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Table 9-1. Robot Interface Pane Description
Item

Description
Automatic software restart if changed.

Parameter for intermediate users. It may need to be changed, but should not
have side effects (or else, very obvious side effects that are explained).

Parameter for advanced users. It might need to be changed, but not often and
any side effects are obvious and explained.
Parameters for expert users. It is likely to have side effects, which may be
subtle.

Most configuration windows in MobilePlanner software describe most of the parameters, and
most are not repeated here. Where needed, this user guide explains more complex parameters.
NOTE: [?, for more] in the description column of a parameter indicates that
more information is available by pressing the '?' key on your keyboard when that
parameter is selected. The following figure is an example.

Figure 9-2. Pop-up Window for SideClearanceAtSlowSpeed when '?' is Pressed on the Keyboard
To set a parameter, select one of the tabs in MobilePlanner, then select a Section in that tab to
see the available parameters. You can then modify the specific parameter in the parameter
table.
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In this table’s Value column, you can enter a value (numeric or text), choose a value from a
drop-down selection, or click a checkbox. Most text fields have drop-down menus for selection.
Most parameters are not stand-alone and interact with other parameters. This user’s guide discusses various parameters. For example, if you are localizing the AMR, you will find the parameters related to localization in the Using Laser Localization on page 231 section of this guide.
If you change any parameter settings, you have to click Save for those changes to take effect.
When MobilePlanner sends the update to the AMR, a small spinning icon and “Update Pending” message appear in the MobilePlanner status bar until the AMR applies the changes (at its
next idle period). You can also stop the AMR if you want the changes to be applied more
quickly.
NOTE: ARAM automatically restarts automatically after some parameter
changes.
If the parameter has a restart icon then, after ARAM writes the change, it displays the following dialog indicating the configuration change:

Figure 9-3. Robot Configuration Change

9.5 Saving and Importing the Configuration Parameters
You can save parameter settings on either an AMR or in the Fleet Manager:
1. In MobilePlanner, click the Config tab.
2. In MobilePlanner's main menu, select File > Save As, and give a file name and location
for the file on your local PC.
The Save <robot IP address> Configuration window opens.
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Figure 9-4. Save Robot Configuration Window
3. In the Save <robot IP address> window, select the type of file you want to save (General,
Robot Model, or Calibration), then either accept all checked configurations (default), or
de-select the individual configurations you do not want.
4. Click Save when done.

Importing
You can import parameter settings from your PC to either an AMR or the EM2100 appliance:
1. Select MobilePlanner > Config.
2. From the main menu, select File > Import Config ..., then select the file from your local
PC.
3. Click Save from the main toolbar.
NOTE: If ARAM restarts after saving a configuration, you will need to repeat
the above steps until the software no longer restarts.
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9.6 Managing Files
MobilePlanner allows you to manage files associated with Fleet Operations Workspace Core,
including:
l
l
l
l

raw map-scans (.2d or .z2d) files
maps (.map) files
log files
data files

Downloading, Uploading, and Saving Files
You can upload and download map, scan, log, and data files using File > Download/Upload
from the top bar. Select the AMR you want to use, and then select the file or folder on the AMR
and the file or folder on the PC that you want, and click either Upload or Download.
You can save map files using File > Save As... or, if the file already exists and you just want to
save modifications, use File > Save (Save only affects the previously saved file).
You can also simply click the Save icon in the Toolbar.
You can import a configuration file onto the current AMR using File > Import Config...
NOTE: Import Config applies to the config copy on MobilePlanner, and must be
saved before it is on the current AMR.

9.7 Setting Up Data Logging
The ARAM software can log all kinds of data into one or more files. These data logs allow you
to manipulate the data, using your own third-party data-processing software.
NOTE: Log Config is a Section of parameters you can set in MobilePlanner.
These logs are not the same as the files generated with data logging.
To set up data logging, click the Config tab, then click the Debug tab. When checked, the Show
Expert Parameters checkbox displays advanced parameters that, by default, do not appear in
the parameter list.
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Figure 9-5. MobilePlanner Config, Debug Tab (Show Expert Parameters Checked)
The Debug tab has sections for configuring debug files and setting logging parameters.
NOTE: Each section has a description of what it does (though some parameters
are not visible until you check the "Show Expert Parameters" checkbox).
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MobilePlanner gives you the flexibility to manually program a complex series of tasks for the
AMR to perform at a goal before moving on to the next goal and performing additional tasks.
Or, instead, you could create macros that include all of the tasks the AMR is to perform at a
given goal. You can add tasks and goals to macros, then use the macros within a route or several routes. In other words, macros are "reusable." You can also have individual tasks call a
macro and execute the sub tasks within the macro.
For example, you could create a macro in which the AMR heads to Goal1, speaks a phrase
and waits for a human action, after which it then heads to Goal2, where it waits for a specified
time, then heads to Goal3.
You can use the MobilePlanner software to add tasks, goals, and macros into your facility’s
map, associate tasks with routes and goals, and assemble series of goals, tasks, and macros
into routes.
This chapter discusses the following topics:

10.1 AMR Tasks
Tasks are activities that the AMR can perform, such as going to a goal or checking sensors.
The AMR executes tasks at goals to accomplish useful work, such as enabling Digital IO and
telling the AMR to move. These tasks are already available on the AMR but need to be defined
and associated with the map that you are creating.
There are both instant and non-instant tasks available for the AMR to perform. Instant tasks
allow other tasks to be started before the instant task finishes. Non-instant tasks force the next
task to wait until they are completed.
You can add tasks to goals and routes. For details, see Using the Route Builder on page 180.
IMPORTANT: Use of AMR tasks or ARCL commands to remotely or automatically re-enable motor power is not permitted. Doing so could result in unexpected AMR motion. Motor power may only be enabled by intentional, manual
action at the AMR.

Assigning Tasks
You can assign tasks to a route or goal, or use them in macros. You can find available tasks
under the Robot Tasks tab in the Source Lists pane. See Setting Up Special Tasks on page 174.
Many tasks need to have their corresponding ARAM parameters enabled to be available. For
more information on enabling ARAM parameters, refer to Configuring ARAM on page 132. If
you do not see a task displayed in the Source Lists pane, it might have previously been turned
off. To display the task, enable (or re-enable) the appropriate ARAM parameter.
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Assigning tasks

1. In MobilePlanner, click the Map button, then click the Build tab.

Figure 10-1. The Map Build Tab
2. In the Source Lists pane, click Robot Tasks tab to view tasks that are available on the
AMR.
3. In the Editable Lists pane, click the Routes, Goals, Macros, or Special tab that corresponds to where you want to assign the task.
4. To assign a task to a route, goal, macro, or special item, in the Source Lists, Robot Tasks
tab:
a. Click on the task you want to assign, and drag it over to the desired route, goal,
macro, or special item, or
b. Highlight the task, then highlight the desired goal, macro, special item or route,
and click the Add button (the arrow between the lists).
NOTE: By default, tasks added to goals become part of the goal's
"after" list (the AMR will perform the task after it arrives). The process also creates a "before" list for tasks the AMR will execute
before driving to the goal (you can also move tasks to the “before”
list).
If the task has associated parameters, the dialog box shown below (for a "sayInstant" task) opens:
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Figure 10-2. MobilePlanner Task Description Dialog
5. Click inside the Value field to add and edit each parameter's values.
For more information on using individual tasks, refer to the task type (such as wait,
driving, etc.) in the following section.

Using Instant and Non-Instant Tasks
In general, there can be only one sequence of non-instant tasks running at a time. AMRs can
start an instant task without waiting for a previous instant task to finish. Non-instant tasks
must finish before the AMR starts another task. In other words, both kinds of tasks are on the
task list, but the non-instant tasks must finish before the AMR starts next task on the list.
When an instant task runs, the task after it can start right away, without interrupting whatever
else is happening.
Instant Tasks

Instant tasks allow the next task in the list to start while the instant task is still running, so the
AMR can be running two tasks at once. The following are examples of instant tasks available
in the software. The complete list of instant tasks and descriptions are available directly in the
software.
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Instant Task

Description

ARCLSendText

Sends a given string to the ARCL server.

customOutputOff

Turns a custom output OFF.

customOutputOn

Turns a custom output ON.

playBackgroundSound

Plays a random background sound (at 'Least Important')
from a set of prefixes and suffixes (wild cards do NOT work),
waiting a length of time between sounds, optionally resuming interrupted sounds, and with the ability to stop playing in
some different circumstances.
NOTE: To interrupt this sound, set the audio
task Cancel less important to True.

playInstant

Plays a sound file and then continue while the sound plays.

popupSimple

Requests client applications to show a simple pop-up message (Client applications include MobilePlanner).

sayInstant

Speaks text with a synthetic voice.

sendSoundInstant

Sends sound from an AMR sound file to all clients and continue immediately.

sendSpeechInstant

Sends synthesized speech to all clients and continue immediately.

Non-Instant Tasks

Non-instant tasks run in their own time slot (the AMR must wait for them to complete before
starting the next task in the list).
The following are examples of non-instant tasks. The complete list of non-instant tasks and
descriptions are available directly in the software.
Non-Instant Task

Description

arbitraryServerSend

Sends the given text to a specified server and port.

cartCapture

Task to capture a cart.

cartRelease

Task to release a captured cart.

customInputsCheckAll/Any/Each

Checks whether all/any/each specified custom
inputs properly triggered and executes a macro.

deltaHeading

Changes the heading by the specified relative
amount.

followGuide

Used with HAPS - task to follow a magnetic guide
strip on the floor.

gotoRandom

Drives to a random goal (could be optionally constrained by a matching name prefix).
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Non-Instant Task

Description

laserCheckBox

Waits for something to enter the rectangular area
surrounding the AMR. Macros may be triggered
upon detection or timeout.

laserCheckEmptyBox

Waits for the rectangular area surrounding the AMR
to be empty. Macros can trigger upon detection or
timeout.

macroRepeat

Repeats the specified macro a given number of
times or until it fails.

move

Moves forward by the specified distance, provided
that no obstacles are encountered.

play

Plays a sound file and waits until it finishes playing.

say

Speaks text with a synthetic voice and waits until it
is finished.

sendSound

Sends sound from an AMR sound file to all clients,
continues when done.

sendSpeech

Sends synthesized speech to all clients.

setHeading

Turns to a specified global orientation / heading.

wait

Waits for the specified number of seconds. The wait
may be interrupted by an explicit continue command.

waitActive

Calls a macro, and optionally waits a given number
of seconds or until told to continue by command and
control.

waitIndefinitely

Waits until commanded otherwise.

To verify if a task is instant or non-instant, right-click on the task and select Description. Or,
go into ‘custom responses’ (Build tab > Editable Lists > Special tab) and click on one of them.
The non-instant tasks are grayed out, instant tasks are active. Task classification appears in
the "Class" category, as shown in the following figure.
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Figure 10-3. Task Class Category

Using a Wait Task
A wait task tells the AMR to wait a given number of seconds (or until told to continue by
another command), before continuing. A wait task is not an instant task.
1. Open the map you want to edit. For details, refer to Using MobilePlanner Software on
page 50.
NOTE: Ensure that Show Robot is OFF, or you will not be able to proceed.
2. Click the Build tab.
3. Click the Robot Tasks tab in the Source Lists pane to view the tasks currently available
on the AMR.
4. Add the Wait task to the route, goal, or macro where you want the AMR to pause before
continuing its route. Refer to Assigning Tasks on page 150 for details.
5. Enter the number of seconds you want the AMR to wait in the Value field of the
seconds to wait parameter, as shown below.
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Figure 10-4. Parameters for Wait Task
6. Click OK to close the parameter dialog box and save your changes.

Using Driving Tasks
Driving tasks cause the AMR to move about its environment, carrying out various tasks at
each goal. Driving tasks can include the following:
Task

Task Description

move

Tells the AMR to move the specified distance.

deltaHeading

Changes the AMR's heading.

setHeading

Turns the AMR toward a specified heading.

Step 1: Enable Movement Tasks

Not all available tasks are enabled by default. Before you can use those tasks, enable them in
MobilePlanner by clicking the Config button, then clicking the Robot Operation tab, then clicking Task Features. After clicking the checkboxes you want to enable, click Save to save your
changes.
The following table lists some examples of the driving and movement parameters that you can
enable.
NOTE: Some of the parameters in the following table require checking the Show
Expert Parameters checkbox.
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ARAM Parameter

Description

Engage

When used with HAPS, calls a macro when the AMR
arrives at the goal, so the AMR can be sent on a series
of tasks, such as a followGuide task to go to a marker
on the magnetic strip.

MovementParametersTempTasks

Enables tasks for temporarily changing movement
parameters.

Step 2: Assign Movement Tasks

Driving tasks are non-instant, but the MovementParametersTempTasks are.
1. Open the map you want to edit.
2. Click the Build tab to display Source and Editable Lists panes.
3. In the Source Lists pane, click the Robot Tasks tab to view available tasks.
4. Add the driving task to the route or macro (for details, see Assigning Tasks on page
150.
5. Enter the parameter values for the assigned task.

Figure 10-5. Parameters for setHeading Task
The following table shows examples of some of the task parameters and the tasks that
use them.
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Task Parameters

1

Parameter Definition

Associated Task(s)

heading

(Integer) The number of degrees to
turn the AMR. Positive values turn the
AMR left or counterclockwise. Negative
values turn the AMR right or clockwise.
For deltaHeading, if the absolute value
exceeds 360, the AMR makes at least
one full rotation.

deltaHeading, setHeading

distance

(Integer) The distance (in mm) the AMR move, move2,
should move from the current position. moveProx1

speed

(Integer) The speed (in mm/sec) the
AMR should move from the current position.

move, move2,
moveProx1

moveProx and other "Prox" tasks are not supported for the HD-1500 AMR

6. Click OK to accept the parameter value and save any changes you made.

Cell Alignment Positioning System (CAPS)
The Cell Alignment Positioning System (CAPS) is a set of advanced features that provide
improved destination alignment accuracy without requiring additional peripheral hardware
on the AMR. These features are intended for use in applications that require better alignment
accuracy than the standard solution.
CAPS now uses the PrecisionDrive task for improved alignment. Legacy versions of FLOW
CAPS used the task TriangleTargetDrive and related tasks. These can still be used, but are not
covered in this manual. Contact your OMRON representative for information on legacy tasks.
PrecisionDrive

PrecisionDrive is a software task designed to increase the final position accuracy of the
OMRON AMR platforms. It forms the basis of the Cell Alignment Positioning System (CAPS).
PrecisionDrive uses the onboard OS32 Scanning Lidar. It requires the user to place a reference
target in the operating space. The AMR will locate and drive relative to this target.
PrecisionDrive is configured using the MobilePlanner user interface. It is a robotic task that
can be scheduled before or after a map goal.
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Normal Setup

Figure 10-6. PrecisionDrive Normal Parameters
Target Shape
This dropdown controls which target the robot will locate and move relative to in the operating space. The Standard shape is the default and is defined in Standard Target on page 167.
Other shapes can be used based on need and space requirements. Users should give preference
to the Standard shape when designing and setting up an application. Both legs of the target
must be in the field-of-view of Laser_1 (the front navigation laser) at the beginning of the task
– the robot will not rotate to find the target.
NOTE: The Standard target is the only target with listed accuracy specifications.
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Final Offset X
Final Offset Y
Final Offset Angle
These three settings (X, Y, Angle) specify where the AMR will attempt to stop at the end of the
task execution. They are 2D spatial coordinates and the diagrams for setup are provided in
Standard Target on page 167.
NOTE: These values are relative to the target, not the robot. This is to simplify
setting up tasks as they correlate directly to measurements taken from the target
in geometric space.
Initial X
Initial Y
Initial Angle
These three settings (X, Y, Angle) specify the position for the AMR, from which it will attempt
to locate the target when first starting the task. From the Initial position, the AMR should be
able to see both legs of the target from the concave side. There is an associated search area to
account for real world position uncertainty after arriving at the pre-goal. These are described in
more detail under the Advanced Setup section. They are 2D spatial coordinates, and the diagrams for setup are provided in Target to Robot Coordinate Frame Transformations on page
167.
NOTE: These values are relative to the target, not the robot. This is to simplify
setting up tasks as they correlate to measurements taken from the target in geometric space.
These three parameter sets are all that are needed to successfully set up and use the PrecisionDrive task in most applications. Users should use the Normal setup whenever possible.
All other parameters (listed in the Advanced Setup section) are optimized for most use cases
with the Normal setup setting.
Parameter Mode
This parameter toggles the Normal and Advanced setting menus. Normal only shows the parameters previously described in this section. Advanced shows the parameters listed in the
Advanced Setup section that follows.
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Advanced Setup
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Figure 10-7. PrecisionDrive Advanced Parameters
Timeout
This controls the duration of the failure timeout. The timer begins at the time the task first
starts looking for the reference target. If the tasks has not reached the desired ending position
before the specified time, the system will come to a stop, and signal failure of the goal task.
Path Shape
This parameter selected the desired path to the end position.
PreAlign: This shape uses an arc-shaped path to first align with the vector path defined by the
X,Y, and Angle Final position components, then follows the rest of the way moving straight
with generally little or no final rotation required to achieve the desired final position. Some
PreAlign moves may start and end with a straight path.
Straight: This shape draws a straight line between the Initial position of the AMR and the
desired Final location. In-place rotation at the beginning and end of the straight path is performed as necessary.
Search Mode
This parameter controls the amount of initial tolerance allowed. The general guideline is that
larger tolerances are more likely to find a target, but more likely to choose the wrong item as
the target. Smaller tolerances are more likely to fail to find a target, but less likely to choose the
wrong target.
NOTE: The Search coordinate frame is relative to the target, not AMR reference
frames.
Mode

Tolerance
X

Y

Angle

Normal

500 mm

500 mm

15°

Wide

250 mm

750 mm

20°

Tall

750 mm

250 mm

20°

Minimum

200 mm

200 mm

8.5°

Max

750 mm

750 mm

30°

Rotation

350 mm

350 mm

45°

Match Mode
This parameter specifies how closely the laser data must match the selected TargetProfile.
Normal: Balanced behavior between allowing for minor match errors with a reasonable guarantee that the target was correctly matched.
Lenient: This behavior allows more error in the final line fit to decrease risk of failing the task
due to sensor noise or poor geometry. This mode should only be used when the target is in
open space to decrease the likelihood of an incorrect match.
Strict: This behavior allows very little error in final data fit, but has a higher guarantee that the
target was correctly matched. This mode should only be used when incorrect target matches
will have very detrimental effects on the application. Using this mode will result in more
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failed tasks, especially when operating large fleets as each scanning LIDAR has its own
intrinsic errors and noise profiles that affect the final match quality.
Fail Mode
This parameter controls the different failure modes that would cause the task to immediately
fail instead of attempting recovery to finish the task within the FailTime timeout.
FailOnSafetyStop: Any Safety stop (either from Estop buttons or Safety LIDAR)
will cause the task to immediately fail.
Clearance Mode and Clearance Shape
These two parameters control how the AMR deals with obstacles (both real and virtual) that
are detected in close proximity to the AMR.
Clearance Mode controls how the clearances behave.
l

Normal: uses the default settings
Approach Distance = 400 mm away from sensed obstacles

l

Variable: allows two difference clearance sets to be used
Parameter “Clearance Switch Distance” controls when, during the task, the clearances
switches from the initial clearance to the final clearance. This parameter is defined by
the distance to the final location.
This also allows control of the Approach Distance parameter.

l

Custom: allows control of the Approach Distance parameter

Clearance Shape is the footprint of the clearance.
This parameter allows control over the size of the clearances around the AMR. All of the clearances are defined from the front, rear, and side edges of the robot.
In general, clearances should be set to fairly low values (<100 mm). Clearances are a supplement to the Safety system but do not in any way replace the hardware Safety.
l

Normal: Clearances sizes and definitions are set to give a good compromise between
staying a safe distance away from the obstacle and still completing the required task.
Front Clearance
50 mm

l

Side Clearances
75 mm

20 mm

163

20 mm

Tight: Clearances sizes and definitions are set to minimize likelihood of task failure. The
AMR will be allowed to drive slowly past obstacles very close to the physical footprint
of the AMR. Using this setting will result in fewer task failures, but an increased chance
of failure upon leaving the area (AMR can get into a space that it may not be able to
extract itself from).
Front Clearance

l

Back Clearance

Side Clearances
20

Back Clearance
5 mm

Expanded: Clearances sizes and definitions are set to maximize the likelihood of being
able extract itself from the situation. The AMR will stop sooner due to the increased size
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of the clearances areas. Using this setting will result in more task failures, but an
increased chance of success upon leaving the area (AMR will stay out of a space that it
may not be able to extract itself from).
Front Clearance
100 mm
l

Side Clearances
250 mm

Back Clearance
20 mm

Custom: You can specify the area around the AMR for obstacle protection while moving
to the final location. These parameters are only visible when Clearance Shape is set to
Custom. Refer to the following figure.
Allows control over Front, Left, Right, and Back Clearances.
Negative clearances (clearances that allow obstacles internal to the defined shape of the
AMR) can also be programmatically set. Use with Caution!

PrecisionDrive Clearance Differences

NOTE: The clearances used in PrecisionDrive have a few key differences compared to other Clearance parameters within the FLOW Core software.
l

l

The slowdown/stop behavior is different. The Approach Distance controls how far away
the platform should stop instead of the Front Clearance (or Front Padding depending on
the Task). This results in allowing smaller front clearances in most applications.
Obstacles near the clearances but not within the clearances will cause the AMR platform to slow down.

Drive Mode
This parameter controls the driving behavior of the AMR.
l
l

l

l

Normal: A balanced optimization giving the best all-around driving behavior.
Precise: Minimizes Path and final error at the expense of being slower and with
increased jitter in its motion.
Fast: Minimizes time to goal at the expense of being less precise and increased jitter in
its motion.
Smooth: Minimizes motion jitter at the expense of being slower and less precise in its
motion.
Table 10-1. Drive Mode Behaviors
Precise

Fast

Smooth

Cycle Time

Increased

Decreased

Increased

Smoothness

Decreased

Decreased

Improved

Precision

Improved

Decreased

Decreased

Forward Speed
This parameter controls the maximum forward translation velocity that the AMR could
achieve during the motion. This does NOT represent the speed at which it will complete the
task - only the maximum. The Drive Mode will dictate the local speed based on the
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optimization chosen. Depending on the Drive Mode setting and the application, increasing
this parameter may have no effect on the resulting motion.
Reverse Speed
This parameter controls the maximum reverse translation velocity that the AMR could achieve
during the motion. This does NOT represent the speed at which it will complete the task - only
the maximum. The Drive Mode will dictate the local speed based on the optimization chosen.
Depending on the Drive Mode setting and the application, increasing this parameter may
have no effect on the resulting motion.
Rotational Speed
This parameter controls the maximum rotational velocity that the AMR could achieve during
the motion. This does NOT represent the speed at which it will complete the task - only the
maximum. The DriveMode will dictate the local speed based on the optimization chosen.
Depending on the DriveMode setting and the application, increasing this parameter will have
no effect on the resulting motion.
OffsetCorrection

NOTE: This feature is only available to PrecisionDrive if there is a CAPS license
available.
MobilePlanner allows a user to configure a custom offset for each AMR. The primary purpose
is to compensate for minor mechanical tolerance differences between individualvehicles across
a “uniform” fleet. Users should first verify that Laser_1 is well-aligned and in good condition
before trying to use OffsetCorrection as a quick fix for a potentially larger problem.
NOTE: This is a part of MobilePlanner > Robot Configuration > Robot Physical .
It is not a part of the PrecisionDrive task.
Only one OffsetCorrection (X, Y, and Angle) is allowed for each AMR. This will be applied to
all PrecisionDrive tasks for that AMR - it is not task- or target-specific. In most applications the
overall approach and motion generally stay consistent and a single offset (if needed) is sufficient. The OffsetCorrection is added to the final position requested in the PrecisionDrive task
(Final Offset X, Final Offset Y, and Final Offset Angle values). The OffsetCorrection values are
relative to the target using the same coordinate reference frame for the Final Offset values as
shown in Standard Target on page 167. For example, if the Final Offset X in the task is –1000,
and the individual AMR needs to have a Final Offset X of –1005, Offset X for that AMR would
be set to –5. The same approach is used for Offset Y and Offset Angle.
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Figure 10-8. OffsetCorrection Parameters
The Descriptions of the Parameters shown in the preceding figure are in the following table:
Parameter

Description

Offset X

AMR specific axial offset in mm in the coordinate system of the specified target
(used in all PrecisionDrive Tasks)

Offset Y

AMR specific lateral offset in mm in the coordinate system of the specified target
(used in all PrecisionDrive Tasks)

Offset Angle AMR specific rotational offset in degrees in the coordinate system of the specified
target (used in all PrecisionDrive Tasks)
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Standard Target

The target must be constructed to accurately reflect the dimensions shown below. The local flatness of the two segments and the 90° angle must be strictly observed for repeatable motion.
Notes for Drawing:
l
l
l

l
l

All general tolerances ISO 2768 - Class M (Medium)
Material: 5052-H32 Aluminum
Finish: Paint matte gray. Option gray Cardinal X-Press polyester TGIC powder coat,
P/N X041-GRW02871, 0.127- 0.254 mm thick (0.005 - 0.010 inches)
Deburr and break all sharp edges between 0.10 mm - 0.25 mm max.
Use minimum bend radius 1.5 max.

150 mm

1000 mm

1.6 mm

R1.5
250 mm
90°

Figure 10-9. Standard Target
Target to Robot Coordinate Frame Transformations

These examples illustrate how to set the Initialn and FinalOffsetn parameters to achieve the
desired behavior. The values shown by each AMR in the drawings represent the values that
would be set in the PrecisionDrive task for each use case.
Example 1: The graphic below shows the results of a move with a MotionProfile of Straight,
starting at (-2000, +250, Th 0) and moving to (-500, -500, Th 180). The AMR has to rotate in
place at both the Initial and Final locations. The target is a Standard target. The AMR icons are
for LD-250.
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+Y

X = -2000
Y = +250
Angle = 0.0

250 mm

90˚
1000 mm

X -2000

X -1000

0,0
+X

-Y

X = -500
Y = -500
Angle = 180.0

Example 2: The graphic below shows the results of a move with a MotionProfile of PreAlign,
starting at (-2000, -500, Th 0) and moving to (-500, 0, Th 90). The AMR only turns for a part of
the path. The target is a Standard target. The AMR icons are for LD-250.

+Y
250 mm

X = -500
Y=0
Angle = 90.0

X -2000

X -1000
X = -2000
Y = -500
Angle = 0.0

90˚
1000 mm

0,0
+X

-Y

CAPS License

CAPS is a licensed feature, and requires a license key file that must be loaded onto the AMR
before CAPS takes effect. Licenses are granted to individual AMRs, minimizing cost by
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applying this feature only to those AMRs that require the higher accuracy it provides. Contact
your OMRON representative for instructions on ordering and obtaining the license key files for
this feature.
The PrecisionDrive task can be used with or without a CAPS license. If PrecisionDrive detects
a license, its alignment accuracy will improve significantly.
With or without the CAPS license, the setup, configuration, and use of PrecisionDrive does not
change. With the license, the accuracy improves. The CAPS license is p/n 20271-805.
NOTE: The TriangleDrive version of CAPS is legacy but can still be used if a
CAPS license is detected. Contact your OMRON representative.
The relative alignment accuracy of OMRON AMRs, with and without these features, is presented in the following table:
Table 10-2. FLOW Core Goal Alignment Features
Feature

Alignment Condition
Accuracy

Standard

± 100 mm

Standard FLOW Core Feature

PrecisionDrive without CAPS
license

± 25 mm
± 2.0°

Standard FLOW Core Feature

PrecisionDrive with CAPS
license

± 8 mm
± 1.0°

Licensed Feature (CAPS)

Hign Accuracy Position System
(HAPS)

± 10 mm

Not licensed, requires optional hardware
(sensors) to work

Using Speech and Sound Tasks
Speech and sound tasks control the AMR's audio. As the AMR navigates the operating space,
it can (for example) play a sound file while driving, make a noise to alert anyone in the area
that it is entering a room, or announce what task it intends to perform next.
The speech and sound tasks combine instant and non-instant tasks, as shown in the following
table.
Instant Tasks
l
l
l
l
l

Non-instant Tasks

playInstant
sayInstant
sendSoundInstant
sendSpeechInstant
playBackgroundSound

l
l
l
l

play
say
sendSound
sendSpeech

Instant tasks send audio to the AMR as it continues on its path. Non-instant tasks cause the
AMR to wait until the speech or sound is done playing. For example, if you want the AMR to
announce that it is entering a room and then wait for a moment to allow people to get out of
its way, use the say task rather than the sayInstant task.
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The AMR speaks say tasks with a computerized voice. Play tasks play a sound file on the
AMR. Sound tasks encode a file from the AMR and send it out to all MobilePlanner instances
connected to that AMR.
To Use Speech and Sound Tasks

NOTE: Speech and sound tasks are normally enabled by default.
1. Click the Config button, then click on the Robot Interface tab, then click on A/V Config,
and enable the Audio parameter (click the checkbox). For more details, see Configuring
the AMR on page 140.
2. For sound tasks, ensure the sound file is stored on the AMR. You can use File
> Upload/Download.
3. Click the Map button, then click the Build tab.
NOTE: Ensure Show Robot is OFF, or you will not be able to draw or
edit objects in the map pane.
4. In the Source Lists pane, click the Robot Tasks tab to view tasks currently available on
the AMR.
5. Add the speech or sound task to the goal, route, or macro. For details, see Assigning
Tasks on page 150.
6. Enter the parameter values for the assigned task. If using a speech task, enter the text for
the AMR to speak in the Value field. If using a sound task, enter the name of the sound
file in the Value field. If needed, click the Browse button to search for the sound file.
7. Click OK to accept the parameter value and save any changes.
Using Sound Files with Tasks

Both the play and sound tasks use sound files. Play tasks play a file on a specified AMR. Sound
tasks encode a file from the AMR and send it out to all the MobilePlanner instances connected
to that AMR.
All sound files must be in AIFF WAVE (.wav files), .ogg files, or MP3 format.

Adjusting the Audio
You can use the MobilePlanner software to adjust the audio input and output (if turned ON),
and adjust both the software and AMR audio using the audio slide bars.
1. Click the Map button from the main window to display the map window.
2. Click the Monitor icon to display the list of available items to monitor (see below).
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Figure 10-10. MobilePlanner Monitor Drop-down Menu
3. Click Audio to display the Audio dialog.

Figure 10-11. MobilePlanner Audio Dialog Box
4. Click on the slider bar and drag it left or right to adjust output volume.
5. If desired, you can enter a text string the AMR will speak (when configured to do so).
6. Click OK when done.
Accessing and Adjusting the Audio Parameters

1. Click the Config tool, then click the Robot Interface tab.
2. Select A/V Config from the Sections column to display audio and video parameters.
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Figure 10-12. MobilePlanner A/V Configuration Page

I/O Tasks - LD-series AMRs
Digital Input/Output (I/O) provides an interface between the AMR’s equipment and sensors
and the payload which often requires power (I/O inputs and outputs can, for example, control
conveyor rollers). If you have an AMR with a conveyor payload aboard, you can use digital
I/O to turn the rollers ON and OFF, check sensor inputs, and execute one or more macros
based on a tote’s location (whether the tote is on the AMR’s conveyor or on the feed conveyor).
The LD-60, LD-90, and LD-250 AMR cores provide 16 digital inputs and 16 digital outputs,
and have a User Interface connection for creating custom user interfaces with the AMR’s EStop, ON, OFF, keyswitch, and brake-release buttons.
With MobilePlanner, you can:
l

l

l

Configure core digital inputs and outputs, and give these inputs and outputs aliases
which make it easier to use them when needed.
Create custom I/O tasks that turn payload power on or off to activate automaticallytoggled proximity sensors.
Detect single inputs and execute specific macros.

Using I/O Tasks

Custom inputs and outputs are digital inputs, outputs, and peripheral power outputs. You
make them custom by setting their input type to custom and (optionally) giving them an alias.
1. Click the Config button, click the Robot Interface tab, then click Core Digital Inputs or
Core Digital Outputs in the Sections column.
2. Configure the devices, then click Save.
3. In MobilePlanner’s main menu, click File > Open to open the map you want to edit.
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NOTE: Ensure that Show Robot is OFF, or you will not be able to proceed.
4. Click the Map button, then click the Build tab.
5. In the Source Lists pane, click the Robot Tasks tab to view the tasks currently available
on the AMR.
6. Add the task to the route, goal, or macro. See Assigning Tasks on page 150 for details.
Digital Inputs

To configure the digital inputs, click the Config button, then click the Robot Interface tab.
Tasks: customInputsCheckAll and customInputsCheckAllInstant

These tasks check whether all specified custom inputs trigger and properly execute a macro.
Parameters
timeout

Description
Duration (in sec) to check the custom inputs.

timeoutMacro Macro to invoke if no inputs are triggered before the timeout.
triggerMacro

Macro to invoke if all inputs are triggered before the timeout.

input<n>
n = 1 to 8

Names of the custom inputs to check. Prefix the names with '!' to check
the inverted value.

Tasks: customInputsCheckAny and customInputsCheckAnyInstant

These tasks check whether any of the specified custom inputs trigger and properly execute a
macro.
Parameters
timeout

Description
Duration (in sec) to check the custom inputs.

timeoutMacro Macro to invoke if no inputs are triggered before the timeout.
triggerMacro

Macro to invoke if any of the inputs are triggered before the timeout.

input<n>
n = 1 to 8

Names of the custom inputs to check. Prefix the names with '!' to check
the inverted value.

Tasks: customInputsCheckEach and customInputsCheckEachInstant

These tasks check the custom inputs and executes a particular macro for each triggered input
(on only if ‘tasksForBetterCustomIO’ is ON).

173

Fleet Operations Workspace Core User's Manual

20569-020 Rev. D

Parameters

Description

timeout

Duration (in sec) to check the custom inputs.

timeoutMacro

Macro to invoke if no inputs are triggered before the timeout.

input <n>
n = 1 to 8

Names of the custom inputs to check. Prefix the names with '!' to
check the inverted value.

input <n> macro
n = 1 to 8

Macro to invoke if input <n> is triggered before the timeout.

Digital Outputs

To configure the digital outputs in MobilePlanner software, click the Config button, then click
the Robot Interface tab.
Task: customOutputOff

This task turns off the specified custom output.
Parameters
output

Description
Name of the custom output to turn OFF.

Task: customOutputOn

This task turns on the specified custom output.
Parameters
output

Description
Name of the custom output to turn ON.

I/O Tasks - HD-1500 AMRs
If I/O tasks need to be configured for the HD-1500 AMR, contact your OMRON representative.

Setting Up Special Tasks
You can set up and use tasks for the AMR to perform in certain situations, such when docking
or at every goal. You can also make the AMR say a phrase when an specific event occurs (e.g.,
when path planning is failing, replanning has happened, or the AMR failed at a goal, etc.).
These Special tasks allow you to define custom responses to events that the AMR might
encounter.
Special tasks can include:
l
l
l
l

Performing a task before or after every goal.
Performing a task at a dock.
Custom responses.
Queuing Manager tasks.
NOTE: Special events don't have to be unusual. Going to a Goal or Point can be
a special event.
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To Customize AMR Operation:

1. In MobilePlanner, click the Map button, then click the Build tab.
2. In the Editable Lists pane, click on the Special tab.
Since you cannot assign a goal to a Special task, the Goals tab is grayed out. Also, selecting one of the special events in the Special tab only enables instant tasks. All custom
responses have to be instant, but other lists in this tab can allow non-instant tasks.

Figure 10-13. Build Tab Lists - Details
3. In the Source Lists pane, highlight a task from the Robot Tasks tab and drag it to the
desired special event in the Special tab.
NOTE: Most custom responses (e.g., Dock responses) have to be instant;
all others can be non-instant.
Custom Responses

You can customize the AMR's operation using the Custom Responses found in the Special tab.
The predefined conditions or events that trigger a custom response include:
NOTE: The following list is not an exhaustive list. The Custom Responses
defined for a particular AMR depend on the parameters that you enabled or disabled. For configuration details, see Setting the Configuration Parameters on page
142.
l
l
l
l
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Fault responses.
Localization.
Path Planning (Failed, replanning).
‘sayInstant’ tasks (such as ‘excuse me’).
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l

l
l

Bumping into something (has four sub-events, based on what the AMR is doing when
the bump occurs).
Map Creation (has two sub-events, for starting and stopping a scan).
Patrolling a route (has four sub-events).

Using custom responses, you can make the AMR talk when it encounters one of these events,
and tell the people around the AMR what to expect.
All custom responses must contain instant tasks, such as sayInstant. Although the conditions
that trigger a custom response are predefined for the AMR, you can customize the AMR's operation by adding one or more instant tasks to these events. For example, if the AMR bumps
something in front of it, the AMR can respond appropriately (for example, the AMR could
speak a phrase when it bumps into something).
Events automatically trigger the custom responses that make the AMR respond to its environment.
If there is no task associated with a specific Custom Response, the AMR will not do anything
special when that condition occurs.
Performing a Task Before/After Every Goal

Special tasks can include instant and non-instant tasks the AMR performs before the AMR
departs for a goal or after it reaches any goal.
Drag instant tasks from the Source Lists pane to either event in the Special tab in the Editable
Lists pane.
NOTE: You can override these tasks for specific goals within specific routes by
un-checking the before/after this goal checkbox.
Performing a Task at a Dock

Special tasks can include instant tasks the AMR performs when docking. The AMR already
has a set of defined docking events, including:
l
l
l
l
l
l
l
l

Forced dock
Idle dock
Requested dock
Driving to dock
Driving into dock/docked
Dock now unforced
Dock now forced
Undocking/undocked

You can add instant tasks to these docking events (e.g., have the AMR announce it is going to
dock because it is ‘idle.’). Drag instant tasks from the Source Lists pane to the appropriate
event in the Special tab in the Editable Lists pane.
Queuing Manager List

AMRs can perform a variety of special tasks when they reach goals. For example, you can use
the JobTypeCheck task to specify different macros depending on whether a goal is pickup,
dropoff, or neither. Other examples of special tasks include:

20569-020 Rev. D

Fleet Operations Workspace Core User's Manual

176

Chapter 10: Working with Macros, Tasks, and the Route Builder

l
l

Before/After Pickup
Before/After Dropoff

Drag instant tasks from Source Lists to a queue-related event in the Special (Editable Lists
pane).
Editing a Special Task in the Editable Lists Pane

1. Right-click on the task you want to edit.
2. In the pop-up window, click Edit.
If the task has associated parameters, the following dialog box opens:

Figure 10-14. MobilePlanner Parameter Description Dialog
Click in the Value field to add and edit the parameter’s value . Click on a parameter to
see its description.
3. Click OK when done.
Copying a Special Task from the Editable Lists Pane

1. Right-click on the task you want to copy.
2. In the pop-up window, clicking Duplicate creates a copy of the task.
3. Drag the copied task anywhere within the current tab.
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Deleting a Special Task from the Editable Lists Pane

1. Right-click on the task you want to delete.
2. In the pop-up window, click Cut (or press the Delete key) to remove the selected task.

Editing a Task
To edit a task, from the Editable Lists pane:
1. Right-click on the task you want to edit.
2. In the pop-up window, click Edit.
3. Click inside the Value field to edit the value for each parameter.
NOTE: You can reorder or move tasks to another goal/macro/route by dragging
them there.
Copying a Task

To copy a task, from the Editable Lists pane:
1. Right-click on the task you want to copy.
2. In the pop-up window, clicking Duplicate adds a copy of the task.
3. Drag the copied task to any position within the current tab.
Deleting a Task

To delete a task, from the Editable Lists pane:
1. Right-click on the task you want to delete (or click, the press the Delete key).
2. In the pop-up window, clicking Cut removes the selected task.

10.2 AMR Jobs Overview
Jobs are basic activities for the AMR(s) to execute. ARCL and protocols within the Integration
Toolkit (ITK) can send job requests to the Fleet Manager for assignment to an AMR.
NOTE: Jobs are the recommended method for commanding the AMR or fleet of
AMRs.
Jobs typically have one or two job segments (if queueMulti is enabled). All segments are classified either as PICKUP or DROPOFF.
l

l

PICKUP: A PICKUP job request tells the Fleet Manager that any available, appropriate
AMR can be assigned a PICKUP task.
DROPOFF: A DROPOFF job request tells the Fleet Manager that only a specific AMR
can be assigned a DROPOFF task.

Once the Fleet Manager receives the job request from ARCL or the ITK, it assigns a job ID and
unique job segment ID (or, you can optionally assign a job ID).
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Job Priorities

MobilePlanner prioritizes submitted job requests either by Non-First-In-First-Out (Non-FIFO) or
First-In-First-Out (FIFO) priority. The requestor can specify the job priority, or jobs can use the
default value for queuePickup, queuePickupDropoff, and queueDropoff commands. You can
enable this in Config > Fleet tab > Fleet Features, FleetQueuingConsumptionMethod.
l

l

Non-FIFO: Non-FIFO executes the highest priority jobs first, followed by lower priority
jobs. Its goal is to minimize the AMRs’ driving distance.
FIFO: In FIFO, the system prioritizes jobs by which was submitted first, second, and so
forth.

The default PICKUP priority is 10, and the default DROPOFF priority is 20. You can expedite a
job by raising the pickup priority, while keeping the dropoff priority the same. For example,
l

queuePickupDropoff goal1 goal2 10 20

l

queuePickupDropoff goal3 goal 4 10 20

l

queuePickupDropoff goal5 goal6 11 20

If you queued all of the above jobs at the same time, the third job’s higher priority means the
AMR will execute the third job before jobs 1 and 2. Otherwise, job1 or job2 will start.
Job vs. Job Segment

All submitted jobs carry a specific JobID (also referred to as the “job). Each part of a job is a
‘job segment,’ even if the job has multiple parts to it (for example, a Pickup-Dropoff sequence).
Custom Job ID

MobilePlanner uses the jobID to track the status of a request. A job ID must be unique among
active jobs. Active jobs can share a jobID with previously completed or cancelled jobID still in
the system. You can use a custom job ID that matches some other information in your automation system when submitting the pickup or pickupDropoff request.
Basic Job Commands

The following are some basic example job commands:
l

l

l

“queuePickup goal1”: submits a request to send any available AMR to “goal1.”
“queuePickupDropoff goal1 goal2”: requests that any available AMR first drives to
“goal1,” then, once completed, drives to “goal2.”
“queueCancel jobid JOB7”: immediately cancels job7, regardless of whether an AMR is
performing that job.

Basic Job-Supporting ARCL Commands

The following ARCL commands support job queuing:
NOTE: In ARCL command syntax, commands are not case sensitive, values in
angle brackets < > are required, and values in braces [ ] are optional. Refer to the
Advanced Robotics Command Language Reference Guide (Cat. No. I617) for more
information.
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l

l

queuepickup <goal_name> [priority] [job_id]
queuepickupdropoff <PICKUPgoal_name><DROPOFFgoal_name> [PICKUPpriority]
[job_id]

l

queuecancel <canceltype> <cancelvalue> [echo_string] [reason]

l

queuedropoff <goal_name> [priority] [job_id]

l

queuequery <querytype> <queryvalue> [echo_string]

l

queueshow [echo_string]

Refer to the Fleet Operations Workspace Core Integration Toolkit User's Guide (Cat. No. I637)
for information about using RabbitMQ, REST, or SQL to submit jobs.

10.3 Using the Route Builder
With MobilePlanner Route Builder, you can set up tasks for the AMR to perform and goals for
it to drive to. You can also customize AMR operation and build routes for the AMR to follow.
All of this information is embedded into the map file. Once you download the map file to the
AMR, you can use MobilePlanner to drive the AMR in its operating environment, and perform
tasks.
NOTE: Jobs are preferred over routes in industrial environments.
Use the Route Builder to set up the following:
l

l

l

l

l

Tasks: Activities that the AMR can perform, such as going to a goal or checking
sensors. Tasks give the AMR useful work to perform. These tasks are already available
on the AMR, but need to be defined and associated with the map that you are creating.
Goals: Virtual destinations that the AMR drives to in its environment. These goals are
defined in the map, and represent real-world places in the operating environment.
Macros: Containers for sequences of tasks and goals. Once these macros are created, you
can select the macro, rather than all of the individual tasks and goals, for the AMR to
perform. You only have to define a macro once, but can use it as many times as necessary. You can also use macro templates, which are special macros that can accept
simple parameters. You define parameter types when you create a new macro template,
and specify the values when you use the template in another macro, route, etc.
Custom responses: Actions such as making the AMR talk (e.g., when its path is
blocked, fails the path, or does global replanning, etc.), performing a particular or
sequence of tasks at all goals, when docking, or when a special event (such as a bump
or E-Stop) occurs.
Routes: A "to do" list or a series of tasks, goals, or macros for the AMR to follow. An
AMR can execute a route continuously, unlike macros.

The Route Builder Interface
MobilePlanner’s Route Builder allows you to set up macros, tasks, goals, and routes for the
AMR to follow.
Click the Map button, then click the Build tab.
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The Route Builder (Build tab) appears in the window, as shown in the following figure.

Figure 10-15. The MobilePlanner Map Workspace with the Route Builder Open
The Route Builder Elements

The Route Builder has two panes: Source Lists and Editable Lists. Each section uses tabs to
switch between the different available options.

Figure 10-16. The Route Builder Elements
The Source Lists pane lists available AMR tasks, goals, and macros you can add to new
routes, goals, macros, and special tasks.
The Editable Lists pane displays routes, goals, macros, or special tasks. The tabs allow you to
switch between the different types of objects that you can build.
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You can drag Source Lists objects into any of the Editable Lists routes (or macros) you are
working on, or use the arrow icon between the lists.
Source Lists: Robot Tasks, Goals, and Macros Tabs

The tabs in the Source Lists pane display the tasks, goals, and macros you can use in building
new routes, adding tasks to goals, and building macros and special tasks.
NOTE: Some of the Robot Tasks listed below need to be specifically enabled by
clicking the Config button, then clicking the Robot Operation tab, and the Task
Features section.
l

l

l

Robot Tasks: Lists the tasks available for creating new objects (routes, macros, etc.) on
the map. Tasks are AMR and accessory-related operations, such as moving the AMR,
talking, or playing a sound. These tasks are already available on the AMR, however
you must include them in one of the Editable List items for the AMR to know when and
where to perform them. For more information on using tasks refer to AMR Tasks on
page 150.
Goals: Lists the goals available for creating routes or macros. Goals are locations on the
map that are destinations for the AMR. For more information on using goals, see Creating and Adding Goals and Docks on page 99.
Macros: Lists available macros which you can add to tasks or goals. Macros are
reusable containers for multiple tasks. For more information refer to Creating Macros on
page 185.

For detailed information about a task, goal, or macro, right-click on the item and select Description.

Figure 10-17. Accessing the Task Description
Click on the task parameter to read a brief description of the selected task. The figure below
shows an arbitraryServerSend task. To set up different tasks and their parameters, refer to the
specific task (Using Audio Tasks, for example).
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Figure 10-18. arbitraryServerSend Task Description
Editable Lists: Routes, Goals, Macros, and Special Tabs
l

l

l

l

Routes: Lists created routes, and allows you to build new routes. For details, see Creating Routes on page 193.
Goals: Lists created goals or destinations. You can add tasks for the AMR to perform at
the specified goal. For more information on using goals, refer to Creating and Adding
Goals and Docks on page 99.
Macros: Lists created and defined macros, and allows you to create new macros. Refer
to Creating Macros on page 185 for more information.
Special: Used to customize AMR operation. Custom tasks allow you to have the AMR
perform certain activities at every goal or at a dock. They also allow you to program the
AMR to take special actions when specific events happen. For more information, refer to
Setting Up Special Tasks on page 174.

Macros
Macros are reusable sequences of tasks that have their parameters set when you add them to
the macro. So every time you use a macro, the tasks inside use the same settings. Macros are
extremely effective if you have groups of tasks that you need to repeat in multiple places.
For example, you might have an AMR delivering parts to various places. At each of the multiple delivery locations, it needs to navigate to each, pause, announce its arrival, wait for the
part recipient to retrieve the part, then move on to the next delivery site. Instead of manually
programming each of these tasks at each goal, you can use macros to replicate this same functionality across multiple goals.
You can create macros in Editable Lists (in the Build pane) by clicking the New button. Then,
drag the appropriate tasks from the Robot Tasks list (under Source Lists) into the macro in the
desired point. After adding the tasks to the macro, you can reorder and reconfigure them as
needed.
Macro Templates

Macro templates are simple, text-only features for adding simple parameters to macros.
Allowed parameters for macro templates are named $1 to $9. They do not allow variables or
expressions.
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To create a macro template, click the Map button, Build tab, then use the New dropdown
menu directly below the Editable Lists pane and select Macro Template.
For details, see Macro Templates on page 188.

The Build Tab
The Build tab allows you to create macros, and add tasks for the AMR to perform.
To display the route building tools, click the Build tab. The Build tools, shown in the following
figure, are displayed on the left side of the map window. The Build tab displays two scrollable
panes, each using tabs to organize the lists available for use.

Figure 10-19. The Source Lists and Editable Lists Pane
The following table lists the toolbar icons and describes their functions.
Item

Description

Source Lists pane

Contains lists of AMR tasks and goals that you can use to create
macros or routes for the AMR to navigate. You can also put macros in other macros as well. To view the different lists, select
the appropriate tab.

Editable Lists pane

Contains lists of all current routes, goals, and macros. You can
also add new tasks the existing lists that tell the AMR what to
do in certain circumstances, such as after reaching a goal,
when docking, and when specific event occur, such as bumping
into something.
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Item

Description
If the MobilePlanner workspace is filled with multiple windows
and some tabs are not visible, move between tabs using the
arrows.

New Route/Macro Button

Creates a new route and/or macro (depending on the window
in which you are working), and adds it to the Routes tab.

Pick Goal Button

When ON and a route is selected, lets you click goals on the
map, to add to the route. After adding the goals to the route,
you can drag the goals up/down to set their order.

For more information on creating tasks, goals, routes and macros, see Using the Route Builder
on page 180.

Creating Macros
Macros are containers that hold a series of tasks, goals, and other macros. After you create a
macro, you can reuse it as many times as needed. Macros can hold goals and use tasks with
conditionals, and they can be embedded within macros and other tasks. As a result, macros
are very versatile.
To Create a Macro:

1. Click the Map button, then click on the Build tab.
The Source and Editable Lists appear on the left side of the map.
2. Under Editable Lists, click the Macros tab.
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Figure 10-20. MobilePlanner Build Tools - Macros Tab
3. Click on the New button an the bottom of the Editable Lists pane.
This adds a new macro to the Macros tab which, by default, has the name "Macro1."
This new macro name increments by 1 with each new added macro. See Renaming the
Macro on page 188 for directions on changing the macro name.
4. Highlight a task from the Robot Tasks list and either drag it to the desired macro in the
Macros tab or click the Add arrow (between the two panes).
The new macro expands with each added task, as shown the following figure.

Figure 10-21. Macro Detail
5. Click the Goals tab to access the goals available to add to the macro, then drag the
desired goal into the new macro you are creating. You can also pick a goal from the displayed map to add to the macro (see Picking a Goal from the Map on page 187 for
details).
6. Click the Macros tab to access existing macros. You can then drag an existing macro
into the new macro.
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The macro below shows an example of tasks, a goal, and a macro named "Greeting" added to
the new Macro1 macro.

Figure 10-22. Macro Details
Using the Add Button

In addition to dragging a task, you can use the arrow (Add) button to add a task to the macro.
1. Click on the Macros tab in the Editable Lists pane.
2. Highlight the macro to which you want to add a task, goal, or macro.
3. Click on the Robot Tasks, Goals, or Macros tab from the Source Lists pane.
4. Select the task, goal or macro you want to add to the new macro.
5. Click the Add button to add the task, goal, or macro.
If parameters are associated with the task, a dialog box appears that allows you to
adjust parameters appropriately.
For specific parameter information, refer to the task type (such as a wait task) for more
information.
Picking a Goal from the Map

You can add goals to macros by clicking the goal on the map. This allows you to add multiple
goals within the same vicinity.
1. Be sure that the goals you want to add to the macro are visible in the map window. For
details, see Using MobilePlanner Software on page 50.
2. From the Editable Lists pane, select the Macros tab, then select the appropriate place in
the desired macro to add the goal.
3. Click the Pick Goal button at the bottom of the pane (next to the New button).
4. In the map, click on the goal to add the goal to the macro (you can select multiple goals
without having to click on the Pick Goal button each time).

187

Fleet Operations Workspace Core User's Manual

20569-020 Rev. D

To Move the Goal within the Macro:

1. Click on the goal name in the macro list.
2. Drag it to the position you want the goal to be.
Renaming the Macro

1. Right-click on the macro you want to rename.
2. In the pop-up window, click Rename to change the macro name to editable text.
3. Type in the new name for the macro.
Copying a Macro

1. Right-click on the macro you want to copy.
2. In the pop-up, click Duplicate with the left mouse button.
A copy of the macro appears in the Macros tab.
Deleting a Macro

1. Click the macro then hit the Delete key, or
2. Right-click on the macro you want to delete then, in the pop-up window, click Cut with
the left mouse button to delete the selected macro.

Macro Templates
Using macro templates, you can easily add a variable to a set of tasks. This makes reusing
macros or task sets with slight differences (depending on the goal or application) fast and
easy. For example, you can create macro templates for changing wait times, status to wait
with, line to log, activating a different IO, etc.
NOTE: To use macro templates, you must have (at minimum) MobilePlanner
4.4.0 and ARAM 4.8. If you are using a map created under an older version of
MobilePlanner, you will need to update it. After updating, it will not be backwards compatible with older MobilePlanner versions.
To update your map

1. In MobilePlanner’s main menu, click on Tools > Update Map Features.
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Figure 10-23. Update Map Dialog
2. Read the notes and information in the pop-up window, then click Continue to update
the map.
3. After updating the map, you will need to save and reload the map.
Macro Templates and Grouped Items will then be available for use, and there will also
be a few default group items like door goals, docks, and cart transporters.
Creating a New Macro Template

1. In the Build pane, Editable Lists, click on the Macros tab, then click the New button
drop-down arrow, and select Macro Template.

Figure 10-24. New Macro Template Dialog
2. Enter a name and description for the template, and set variable number(s), type(s), and
descriptions.
Types can be Text, Integer, Double, or Boolean.
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Allowed Value

Text (or
String)

Any letters or numbers

Zero

Integer

Number without decimal

Zero
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Double

Number either with or without a decimal

Zero

Boolean

True or False

False

3. Enter up to nine parameters in the macro template.
Parameter names use ‘$1’ to ‘$9.’ You can enter a text description of each ‘$#’ variable
in the Description field.
4. Add tasks to the template.
Add ‘$#’ to call a variable (‘#’ is limited to previously defined parameters).
5. To add the new macro template, drag and drop from the Source list into the Editable
list.

Custom Groups
Using custom groups, you can define a reusable group of complex map objects, such as goals,
sectors, etc. This allows you to place repeatable tasks (e.g., cart goals) on your map quickly and
consistently, which helps to speed up application building time. Custom groups can interface
with macro templates. Once created, you can add grouped items from the build tab as you
would an advanced area.
Notes on using custom groups:
l
l

l

l

You cannot edit or delete custom group definitions.
You cannot modify originally selected map items, and they do not automatically
become members of a new group instance.
You cannot nest groups. The software ignores groups already in the original selection
list.
You cannot ungroup groups (i.e., you cannot convert them to top-level objects).

Custom groups also contain all tasks and macros (which you can individually edit) from
every goal and sector that you included in the group.
Creating a New Custom Group

NOTE: Update the map format, then create a backup of your map before creating the custom group.
1. Ensure Show Robot is OFF.
2. Highlight all map objects (goals, sectors, etc.) you want to include in the group.
3. Right-click on the map location that is the group’s anchor point (its origin), and select
Advanced > Create Custom Group.
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Figure 10-25. Create Custom Group Explanation Dialog
4. Read the information in the pop-up, then click Continue to create the custom group.

Figure 10-26. Create Custom Group Dialog
5. Enter the custom group’s name and description.
6. Click OK.
The new group will appear under the Custom Groups button drop-down menu in the
Draw pane.
To edit a single item in the group, right-click and select the component you want to edit.
Adding a Grouped Item

After you create a grouped item, you can add it to the map as follows:
1. Verify that Show Robot is OFF.
2. In the Draw tab, click the Custom Groups drop-down arrow, and select a grouped item.
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3. Move the cursor (appears as a ‘pencil’) to the grouped item’s intended location, and
click to place the item on the map.

Figure 10-27. Add Grouped Item Dialog
4. Click OK to add the grouped item.

Adding New Goals to the AMR’s Current Location
MobilePlanner software's AMR monitor allows you to interact with the AMR (for example,
you can move the AMR to a new location or goal, then add a new goal where the AMR is located).
1. Drive the AMR to the location where you want to add a goal or task (for details, see
AMR Driving Overview on page 80).
2. When the AMR is at the desired position, click the Item at Robot button (in the toolbar),
and select Create Goal.
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Figure 10-28. Edit Goal Dialog
3. In the Edit Goal dialog, enter the information, then click OK.

Creating Routes
A route is essentially a "to do" list for the AMR. It is a series of ordered tasks, goals, and macros for the AMR to complete. Tasks are AMR and accessory-related operations, such as talking
or playing a sound, reading inputs, and triggering outputs.
Building Your Route

To build routes for the AMR, simply drag a task, goal, or macro from the Source Lists to the
Editable Lists > Routes tab, as described in the following procedure.
To Build a New Route:

1. Click the Build tab to display the Route Builder.
2. Click on the Routes tab in the Editable Lists pane.
3. Click on the New button on the bottom of the Editable Lists pane to add a new route to
the Routes tab.
The default name for this new route is "Route1," and each new route name increments
by 1. See Renaming the Route on page 194 for details on renaming a route.
4. Highlight a task from the Robot Tasks tab (in the Source List pane) and drag it to the
desired route in the Routes tab.
The new route expands with each added task, as shown below.

Figure 10-29. Route Detail
5. Click the Goals tab to access the goals available to add to the route, then drag the
desired goal into the new route you are building. You can also pick a goal from the displayed map to add to the route, see Picking a Goal From the Map on page 194 for
details.
6. Click the Macros tab to access the macros available to add to the route, then drag the
desired macro into the new route you are building.
Using the Add Button

In addition to dragging a task, goal or macro into your route, you can use the arrow button to
add the task to the route.
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1. Click on the Routes tab in the Editable Lists pane.
2. Highlight the route to which you want to add a task, goal or macro.
3. Click on the Robot Tasks, Goals or Macros tab from the Source Lists pane.
4. Select the task, goal or macro you want to add to the route.
5. Click the Add button to add the task, goal or macro to the route.
If parameters are associated with the task, a dialog box appears in which you can
adjust parameters appropriately. For specific parameter information, refer to the task
type (such as a wait task) for more information.
Picking a Goal From the Map

You can add goals to routes simply by clicking the goal on the map. This allows you to easily
add multiple goals to the route that are in the same vicinity on the map.
1. Be sure that the goals you want to add to the route are visible in the map window (see
Using MobilePlanner Software on page 50 for details on using the workspace).
2. From the Editable Lists pane, select the Routes tab.
3. Click on the Pick Goal button at the bottom of the pane.
4. Highlight the route in which you want to add the goal.
5. In the map, click on the goal you want to add to the route.
This adds the goal to the route. You can select multiple goals without having to click on
the Pick Goal button each time.
To Move the Goal within the Route:

1. Click on the goal name in the route list.
2. Drag it to the desired position.
Renaming the Route

1. Right-click on the route you want to rename.
2. In the pop-up window, select Rename to change the highlighted route to editable text.
3. Type in the new name for the route.
Copying a Route

1. Right-click on the route you want to copy.
2. In the pop-up window, select Duplicate with the left mouse button.
A copy of the route is displayed in the Routes tab.

20569-020 Rev. D

Fleet Operations Workspace Core User's Manual

194

Chapter 10: Working with Macros, Tasks, and the Route Builder

Deleting a Route

1. Right-click on the route you want to delete.
2. In the pop-up window, select Cut (or use the Delete key) with the left mouse button to
delete the selected route.

10.4 Managing Queuing
This section describes how to manage AMR job queues.

Queuing and Job Definitions
l

l

l

l

l

l

l

Job - a single command issued to the Fleet Manager, consisting of one or more related,
ordered moves (job segments). Each job has a unique job ID.
Job segment - one discreet move assigned to an AMR. A segment consists of a single
goal name, and you can define it as either a PICKUP or a DROPOFF job segment. The
goals might have tasks that are assigned to the AMR, which count as part of the job segment. Each job segment has a unique ID.
Queue - a collection of requested jobs and job segments, stored on the Fleet Manager,
that are either assigned or waiting to be assigned to AMRs.
Assigned Job - a job segment becomes assigned after the Fleet Manager has allocated an
AMR to perform the job. A job segment transitions from Pending to InProgress after
assignment.
Pickup - a job segment that ends at a goal so that a payload is loaded onto the AMR. If
the first segment of a job is a PICKUP, then the Fleet Manager assigns this job to
whichever AMR it decides is most appropriate.
Dropoff - a job segment that ends at a goal so that a payload is removed from the
AMR. A DROPOFF segment is handled only by the required AMR.
Required Robot - certain job segments are serviced only by a specific AMR. For
example, the DROPOFF segment of a PICKUP-DROPOFF job must be handled by the
same AMR that performed the pickup. Thus, whichever AMR handles the initial
PICKUP job is the required AMR for the DROPOFF.

The Fleet Manager enables you to queue jobs. It can accept multiple requests for AMRs, and
then select the best AMR for each job, based on the criteria you specify. It sends the selected
AMR to the requested location. It tracks the status of jobs and AMRs as they perform their
assigned jobs.
The requests that are queued include:
l

a request for any AMR to be sent for a pickup (PICKUP) for which the delivery destination (DROPOFF) is not yet known (queuePickup ARCL command).
It is assumed that the delivery destination is communicated directly to the AMR that
responds, prior to completion of the pickup.

l
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a request that a specific AMR drive to a particular goal (DROPOFF) (queueDropoff
ARCL command).
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This is communicated directly to the AMR, but is queued and tracked by the Fleet Manager.
l

a request that an AMR be sent for a job that has predetermined pickup and dropoff destinations (queuePickupDropoff ARCL command).
To complete the job the AMR requires no further job commands.

The Fleet Manager manages jobs associated with either a PICKUP or a DROPOFF goal. Any
AMR tasks that are associated with the goals are executed at the proper times, though they are
not managed as separate jobs in the queue.
We recommend that you use the task pause when an AMR arrives at its destination, although
this is not managed by queue. Use the associated pauseTaskCancel task to signal dismissal after
the AMR is loaded or unloaded. You can trigger this task either by a manually-activated button, or by an automated system event.
When the Fleet Manager receives a request, it does the following:
1. Queuing
l

The request is assigned a default priority (unless another priority is
specified) and put into the queue.
Pickup/Dropoff requests are entered as two separate jobs - a pickup, and a
dropoff.
Each segment has a unique queue ID, as well as a job ID that tracks the entire
pickup/dropoff sequence.

l

Queuing enables job cancellation.

2. Dispatching
l

An AMR is selected, based on the criteria you specified.

l

The AMR is sent to the goal.

3. Tracking
l

l

The queuing manager monitors the AMR and job status.
The job is deleted from the queue when the request is satisfied, or is requeued if
the job fails.

Jobs might be in one of six states:
l

Pending - new, unassigned jobs.

l

In Progress - jobs that are being actively processed.

l

Completed - jobs that were successfully processed.

l

Failed - jobs that failed, due to reasons such as a blocked path or E-Stop.

l

Canceled - jobs that were manually canceled with the queueCancel command.

l
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Interrupted - jobs that have been interrupted by an Operator manually controlling
the AMR. These jobs are reassigned after a brief pause.
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Queuing Examples
The following flowcharts represent sample usage scenarios, and require some application-layer
support to fully implement.
The following flowchart illustrates a simple pickup and delivery cycle. Other factors, such as
state of charge, can alter this flow.

Manual, Multi-stop Queuing Sequence

Operator
requests an
AMR for pickup

Operator
dismisses
AMR

Operator
dismisses
AMR

Manager selects
an AMR, and
sends it to the
desired location

AMR stops at
its next location
as determined by
the Manager

Last stop?

F

T
AMR stops at
desired location

Operator
loads/unloads
payload

AMR sent to
default location
or freed up for
new jobs

Operator
loads payload

Operator may
add new
payload

COMPLETE

Operator inputs
one or more
destinations
into AMR

Operator may
add destinations
into AMR

Operator refers to a human operator.
Manager refers to queuing manager software.

Figure 10-30. Manual Queuing Cycle
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Automated, Single-stop Queuing Sequence
WMS, MES, or other
custom application
requests AMR
for pickup

AMR goes
to the unloading
location

Manager selects
an AMR, and
sends it to the
desired location

AMR stops at
unloading location

Handshake

AMR stops
at desired location

Payload gets
unloaded

Handshake

Handshake

Payload
gets loaded

AMR sent to default
location or freed
up for new jobs

COMPLETE

Handshake
Handshake refers to some form of communication between the AMR and
the automated factory equipment.
The form of this handshake will vary, depending on the equipment in use.

Figure 10-31. Fully-automated Queuing Cycle

Queuing Parameters
You configure various parameters to specify how the Fleet Manager processes queued requests.
You set most of these parameters from within MobilePlanner. See Using MobilePlanner Software on page 50.
To access these parameters from the Fleet Manager:
1. In MobilePlanner, open the Config tab.
2. Select Robot Operation and then Queuing Manager.
The parameters that control the way that the Fleet Manager handles queuing are:
l

IdleTimeUntilResume - Number of minutes to wait, after an AMR becomes available,
before automatically resuming an interrupted job.
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If an AMR has recently booted, or recently operated manually, then this is the number
of minutes that the queuing manager waits before assigning any new jobs to this AMR.
The parameter supports decimal numbers (such as 0.1 minutes for 6 seconds).
l

LowStateOfCharge - This is the state-of-charge (SOC) below which the queuing manager no longer assigns new jobs to that AMR. If an AMR is below this state of charge
when it completes a job, it is sent to dock.
The AMR continues its assigned jobs until it reaches the SOC limit set by the value of
the AutoDockStateOfCharge parameter. Consider the following constraints:

l

l
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o

An AMR drives to a docking station any time that its state of charge falls below
the limit set for AutoDockStateOfCharge even if it is performing a job. This is an
AMR-level parameter, not visible or settable on the Fleet Manager.

o

We recommend that at least a 10% difference between LowStateOfCharge and
AutoDockStateOfCharge, to make sure that the AMR does not drive to a docking
station while performing a job.

o

An AMR docks only if you set AutoDock to True.

DefaultDropoffPriority - The default priority to use in all dropoff requests to the
queuing manager.
DefaultPickupPriority - The default priority to use in all pickup requests to the queuing
manager.

l

DeleteCompletedItemsMinutes - Number of minutes to keep completed jobs.

l

MaxNumberOfCompletedItems - Maximum number of completed jobs to keep.

l

EnableParking - Sends the AMR to a standby goal after it completes its jobs.

Fleet Operations Workspace Core User's Manual

20569-020 Rev. D

The following screen shows configuration parameters for queuing:

Figure 10-32. Queuing Manager Parameters
The following list shows the commands available for queuing.
l

CancelQueueId

l

CancelQueueJobId

l

DisplayDeliveryQueue - Presents a pop-up window showing the delivery queue.

l

DisplayShowRobot - Presents a pop-up window that shows the status of all AMRs in
the fleet.

l

QueuingLog

l

QueuingStats

To find these parameters in MobilePlanner, click Config and Robot Operation and then
Queuing Manager.
NOTE: A red plus sign (+) preceding a command indicates that it accepts an
argument.

Manually Clearing (Flushing) the Entire Queue
Use MobilePlanner to set the configuration parameters that apply to your fleet. For some parameters, you must also make corresponding changes to the configuration on the individual
AMRs. Use these parameters only in limited circumstances, typically when working with your
OMRON representative. For some parameters, you must also make corresponding changes to
the configuration on the individual AMR.
To clear the entire queue, temporarily add a special startup argument to MobilePlanner. The
following procedure clears the queue:
1. In MobilePlanner select the Config tab.
2. Select Fleet and then Fleet Config Management.
3. Under SectionsToSeparate, increment Count if there are no empty SeparateSectionX
rows, where ‘X’ is a number, with an empty Value fields.
4. Enter the string "EnterpriseManagerFlush" in an empty Value field.
5. Click Save.
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6. Wait for MobilePlanner to restart.
7. Use the command in MobilePlanner to verify that the queue is cleared.
a. Select EnterpriseManagerDisplayDeliveryQueue from the Command field dropdown list.
b. Click the Command icon.
The queue should now be empty.
8. Reconnect to MobilePlanner, and remove the "EnterpriseManagerFlush" entry.
9. Click Save.
10. Wait for MobilePlanner to restart.
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Chapter 11: Traffic Management
This section describes managing traffic flow in your operating environment. Whether you are
using a single AMR or a fleet of AMRs, defining how the AMR moves within the space allows
you to better control the AMR's behavior. As a result, you can prevent the AMR from running
into problems, allowing it to complete the tasks assigned to it more efficiently.
In MobilePlanner, you can add objects and areas to the map and manage how the AMR
moves through its environment. You can add areas that direct or restrict traffic, and that control speed and docking behavior.

11.1 Understanding Traffic Control
MobilePlanner provides traffic control guidelines for the AMR to determine the best path
through the operating space. You can control AMR traffic by adding areas to the map that tell
the AMR which direction to go, how fast to drive, or how many AMRs you want to allow in
an area at one time. With MobilePlanner, you can add these features and more to the map.
This section discusses the following traffic control features:
l

Using Preferred Lines on page 209

l

Using Preferred Directions on page 211

l

Using Forbidden Lines and Areas on page 216

l

Adding Switchable Forbidden Lines and Areas to the Map on page 217

l

Using Resisted Lines and Sectors on page 220

l

Using Need-to-Enter Sectors on page 223

l

Using Single AMR Sectors on page 225

l

Controlling AMR Speed on page 214

11.2 Traffic Control Concepts
In environments with more than one AMR, managing traffic becomes increasingly more critical. The main goals in managing traffic flow are safe and efficient operations, and minimizing
traffic jams and collisions. The following sections describe some of the more important traffic
control concepts.

Taxi Line (Multi-Robot Standby Goal)
Much like a row of taxis waiting outside the airport, the concept allows multiple AMRs to
approach and arrive at the same Standby goal (called a ‘Multi-Robot Standby’ goal), in
sequence, without bunching up and causing a traffic jam.
The Multi-Robot Standby (MRS) goal acts as a traffic control tool. The MRS goal extends the
standard Standby map object to enforce sequenced queuing for multiple AMRs at a single start-
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ing point, each of which then moves linearly, in sequence to an end point. Along the way, the
AMRs become available as they reach the end of their ‘after’ task.
The following figure shows the general design. The MRS start point is at the left, the MRS end
point is on the right.

Figure 11-1. Taxi Stand (Multi-Robot Standby) Goal Design
An ideal implementation is at a map corridor that frequently becomes congested with multiple
AMRs. By placing the start point some distance from the goal (for example, at the corridor
entrance), the AMRs move through the corridor in sequence and reach the end point of the
‘after’ movement near the corridor’s exit. Another ideal implementation is for high throughput
sources of parts that need to go to many places (like a plant that has a few gantries serving a
few hundred goals. The AMRs waiting in line near the source means a much higher throughput.
Implementing Taxi Line

Using this feature requires setting the Boolean ‘AllowMultipleRobots’ on standard standby
objects (standbys with this Boolean flag active become Multi-Robot Standbys), and each goal
using a nearby MRS must also have a Managed Destination sector placed over it, with the
‘AlwaysBuffer’ parameter enabled, and the sector’s ReservedBuffer parameter set to the name
of the MRS.

Figure 11-2. Taxi Stand Implementation Example
NOTE: You can only use MRSs as ReservedBuffers. An MRS with no sector referencing it as a ReservedBuffer will display an error when saving the map, and
will be ignored during normal operations. Each MRS can only be reserved by
one map object.
A typical implementation is to place a standard goal on the map to use as the end point of the
buffering line. The figure below shows how this would work with a single AMR (the dashed
lines are for illustrative purposes only - they do not appear in the map).
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Figure 11-3. Taxi Stand (Multi-Robot Standby) Goal Design, Single AMR Use
As shown above, each AMR drives to the MRS start point (line 1), rotates to the correct pose
(line 2), signals the Fleet Manager of its arrival, then executes an ‘after’ task (in this case, a
‘gotoStraight’) to the associated goal (lines 4 and 5).
With multiple AMRs, the sequence works as shown below. In line 1, a second AMR is moving
towards the end goal, which is already occupied by another waiting AMR. It assumes a position behind the first AMR (line 2), and is then joined by two more AMRs (line 3).

Figure 11-4. Taxi Stand (Multi-Robot Standby) Goal Design, Multiple AMR Use

Managed Motion Sectors
Certain situations might require that multiple AMRs drive in narrow spaces, like hallways
and aisles. Without proper management, the AMRs could bunch up and cause traffic deadlocks. The Fleet Manager uses managed motion sectors to control AMR traffic flow in difficult
areas, by directing the AMRs to wait at standby goals while awaiting permission to enter the
sector. It allows only one AMR to drive autonomously through the sector at a time, while still
performing tasks (such as pickup/dropoff) without requesting Fleet Manager permission. Managed Motion can use Taxi Line queuing, with each sector capable of having up to four
reserved buffers.

Standby Buffering
Standby buffering is another type of ‘StandBy’ behavior in which an AMR must wait for
another AMR to clear a sector or goal. The awaiting AMR can automatically select and move
to a nearby ‘StandBy’ goal to wait.
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Preferred Lines and Directions
You can specify preferred lines, and directions that govern how your AMRs move through
their environment. Once placed on a map, the AMRs will, if possible, use the preferred areas.
If something prevents an AMR from keeping to the preferred line or direction, it will seek out
another path.

Resisted Areas and Lines
You can also place areas and lines on the map that you want your AMRs to avoid If the AMR
is unable to complete a goal without moving into, or crossing over, one of these areas, it will
do so, with a higher cost. Typically, resisted areas, lines, or directions are for special cases,
such as setting up travel lanes in which moving is allowed but should be avoided. For an
explanation of cost-based path planning, see Cost-Based Path Planning on page 205.

Forbidden Areas and Lines
As the name implies, these areas, lines, and directions are areas or lines the AMRs must never
enter or cross over. These could be loading docks (or other areas that might lead outside),
stairs, internal structures with walls, or other areas where the AMR could pose a hazard. Refer
to Using Forbidden Lines and Areas on page 216.

DistanceUncrossable and DistanceAdjustment Lines
If the path between the AMR and its goal intersects a DistanceUncrossable line, the AMR will
alter its path. You can use these lines to guide an AMR to the appropriate dock or standby
goal. The DistanceAdjustment line artificially increases the distance calculation between two
points. Queuing uses the distances to determine actions such as which dock to go to.

11.3 Path Planning and Collision Avoidance
MobilePlanner’s tools allow you to plan the most expedient routes for your AMRs, while keeping them from running into objects in your facility and each other. There are may traffic control mechanisms associated with path planning.
This section discusses cost-based path planning, difficult spaces, and virtual doors.

Cost-Based Path Planning
ARAM uses a path planning scheme called Cost-Based Path Planning. In this scheme, an
AMR instructed to proceed to a goal searches the map for the most efficient path from its current location to the goal, based on what it knows about the map. This path, called the global
path, is the optimal path from point a to point b. The AMR then follows that path to the goal
while avoiding unmapped obstacles. If the AMR detects unmapped obstacles, it alters its local
path to avoid them. If unable to proceed along the global path, the AMR can re-plan a new
global path.
The Path Planning Grid

The ‘cost-based’ aspect of this path planning scheme breaks a map into discrete 100 mm
squares (typically sufficient), called the path planning grid (which is not the same as
MobilePlanner’s 1000 mm (1 meter) reference grid), and assigns a cost to each square. Free
(empty) squares (those not close to any obstacles) have a cost of 0.1. The cost for squares con-
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taining walls and other fixed objects is infinite (meaning the AMR will never enter those
squares because the cost is far too high).
NOTE: Although you can improve path planning accuracy by decreasing the
path planning grid squares (done in the PlanRes parameter), doing so increases
AMR processing time. For example, changing the PlanRes parameter (Config >
Robot Operation tab > Path Planning Settings section) from 100 mm to 50 mm
quadruples processing time.
Using cost-based path planning, the AMR plans a path with the lowest cost, and follows that
path to its goal. If it detects any unmapped obstructions, it alters its path to avoid them. And
while the resulting path deviation might be longer, the AMR will always choose the path of
lowest cost.
Factors Affecting Cost

Generally, a grid’s cost increases as its distance to an obstacle decreases, and occupied grid
squares have infinite cost. Preferred lines and directions generally have the lowest cost, while
resisted lines and areas have higher costs. Forbidden lines and areas (like those with walls or
other fixed obstructions, loading docks, etc.) have an infinite cost, meaning the AMR will
never cross or enter them.
For more information about preferred, resisted, restricted, and forbidden lines and areas, see
Understanding Traffic Control on page 202.

Path Planning Parameters
MobilePlanner has dozens of path planning-specific parameters that control how the AMR
moves through its environment, including (not an all-inclusive list):
l
l

l
l
l
l
l
l

The AMR’s maximum traveling and rotating speed
Turning radius (radius needed to safely pivot in place, without forward or backward
movement)
Grid resolution
Fast and slow speeds
AMR padding and clearances (at fast and slow speeds)
AMR rotational speeds at goals
The amount of resistance for resisted sectors and lines
Preferred and resisted lines, areas, and directions

To view and set these path planning parameters (when connected to an AMR), click the Config button, then click the Robot Operation tab, and select Path Planning Settings.
NOTE: MobilePlanner has the most complete and up-to-date descriptions of all
path planning parameters, which will not be repeated here.
Version Information: The default values of the two following Path Planning
Parameters have changed from Mobile Software Suite 4.9.x to FLOW Core:
l
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SmoothingWt
Default value for FLOW should be 1.0 (ARAM 4.9x was 0.0)
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l

ObsThreshold
Default value for FLOW should be 0.3 (ARAM 4.9x was .33).

Robots running FLOW Core will drive poorly if you copy your existing 4.9x path
planning configuration values to a new FLOW Core robot, as the default values
of the two parameters listed above have changed.

Dealing with Difficult Spaces
Clearance settings limit how close the AMR can move to detected obstacles. You can increase
or decrease the required clearance based on the AMR's speed, and have the software stop the
AMR if it will come too close to an obstacle in its path before it can stop by decelerating.
Changing clearance settings alters the AMR's behavior if it moves very slowly through doorways or other tight spaces, or stops too quickly when it senses an approaching obstacle. Conversely, if your AMR moves too close to obstacles or doesn't slow down rapidly enough, these
settings can improve its behavior.
You can set the clearance and padding parameters in MobilePlanner by clicking the Config
button, then clicking on the Robot Operation tab, and selecting Path Planning Settings.
l
Front Clearance: a narrow (100 mm/ 3.9 inches default), fixed buffer zone at the front of
the AMR that does not change with AMR translational velocity.

Figure 11-5. Front Clearances
l
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Side Clearance at Slow Speed (75 mm/ 2.9 inches default) is the minimum side clearance applied at any translational velocity.
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Figure 11-6. Side Clearances
l

Front Padding and Side Clearance grow as AMR speed increases if you set these parameters. This is done as a safety precaution for faster-moving AMRs. The values for
Front Padding at Slow and Fast Speeds, as well as Side Clearance at Slow and Fast
Speeds can be set larger or smaller than the values shown in the figure above based on
your facility, the expected level of traffic, and the general nature of the environment the
AMR will be working in.
As the AMR accelerates, Front Padding and Side Clearance increase from Slow Speed
size towards Fast Speed size.
NOTE: If side clearance at high speed is set too large, the AMR will
speed up and slow down in hallways and similar spaces. This is because
the side clearance grows until it touches the wall, forcing the AMR to
slow down until its side clearance shrinks. It is best to have a small gap
between sideClearanceAtSlowSpeed and sideClearanceAtFastSpeed.

Virtual Doors
Virtual doors (DefaultDoorWithGoals, for example) are areas on the map that allow the AMR
to drive, automatically and seamlessly, through special areas. For instance, they allow an
AMR to drive through plastic curtains that it would normally avoid.
When an AMR plans a path through a virtual door, it instead drives to a specified goal beforehand, and optionally to another specified goal afterward. As with normal goals, tasks can be
done at the goals associated with virtual doors.
The following dialog opens when you insert a virtual door in a map:
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Figure 11-7. Edit Advanced Area, DoorVirtual

11.4 Directing Traffic
With MobilePlanner, you can direct AMR traffic by adding preferred lines and directions to
your map.
Preferred lines make the AMR drive as though it’s on a virtual rail, and reduce the ‘cost’ of
grid squares it crosses. Though a preferred line might be longer than a straight path from Point
A to Point B, the preferred line reduces the cost of each cell it crosses (the Preference parameter
divides the cost of each cell the line crosses by 2, which means it costs half as much to drive
close to the line), so it could be the least expensive in terms of the cost.

Using Preferred Lines
Before adding a preferred line to the map, enable (click the checkbox for) the PreferredLine parameter (in Config > Robot Operations > Map Features, PreferredLine row):
1. Click the Map button to open the map you want to edit (see Using MobilePlanner Software on page 50 for details).
NOTE: You can have MobilePlanner add grid lines to the map to help
you place lines and areas more accurately. In MobilePlanner’s main
menu, click Map > Grid.
2. In the Draw pane, click Advanced Lines, then select PreferredLine from the list (the
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cursor changes to indicate it is in drawing mode).
3. Place the mouse cursor on the map where you want the preferred line to start.
4. Click and hold the left mouse button, drag the mouse to where you want the preferred
line to end, then release the mouse button.

Figure 11-8. Edit Advanced Line, PreferredLine
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The following table describes the parameters available on the Edit Advanced Line dialog box.
Parameter

Definition

Name

An optional name for the preferred line.

Description

An optional description for the preferred line.

Type

Set to PreferredLine. Selecting a different type from the pulldown menu changes the map’s highlighted area to the selected
type and updates the dialog box.

Start Point

X and Y coordinates of the PreferredLine starting point.

End Point

X and Y coordinates of the PreferredLine end point.

UseDefaultPreference

True or False (Boolean) value. If set to:
l
True: uses the default preference setting, ignores the
Preference value.
l

False: the AMR overrides the path planning settings with
the value of the Preference parameter.

Use Path Planning Settings to specify default settings (see Path
Planning and Collision Avoidance on page 205 for details).
Preference

Integer representing the line’s preference. A normal line has a
cost of ‘1’, so a setting of ‘1’ turns off the line’s preferred behavior. A line with a preference of ‘2’ means driving on the line
costs half as much. Higher preferences yield a lower cost. Applies
only when UseDefaultPreference is false. See Cost-Based Path
Planning on page 205 for more information.

Using Preferred Directions
Preferred directions cause the AMR to attempt to drive on the specified side. In the image
below, the AMR does not move directly down the center of the hall, but along the right wall
(the preferred directions).

Figure 11-9. Preferred Direction
If the AMR cannot drive in the preferred direction for some reason, it will change its path to
reach its goal, including driving against the preferred direction on the left side of the hallway
(above). MobilePlanner allows you to add the following preferred directions to the map:
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NOTE: You must enable each of the preferred directions listed below (Config
button > Robot Operation tab > Map Features) and Save before they will appear
in the Advanced Areas pulldown menu (in the Draw tab).
l

l

l

l

PreferredDirectionLeft: Places an area on the map that tells the AMR to drive on the
left, in both directions.
PreferredDirectionLeftSingle: Places an area on the map that tells the AMR to drive on
the left, in one direction only. If you use this option and have two of these areas next to
each other, align the two areas carefully. This is an advanced option. Use PreferredDirectionLeft for most applications.
PreferredDirectionRight: Places an area on the map that tells the AMR to drive on the
right, in both directions.
PreferredDirectionRightSingle: Places an area on the map that tells the AMR to drive
on the right, in one direction only. If you use this option and have two of these areas
next to each other, align the two areas carefully. This is an advanced option. Use PreferredDirectionRight for most applications.

Adding a Preferred Direction to the Map

1. Click the Config button, then click on the Robot Operations tab, and select Map
Features.
2. In the PreferredDirection (Right or Left) row, enable the PreferredDirection parameters
you want to use, then Save the map.
3. Click the Map button to open the map you want to edit (see Using MobilePlanner Software on page 50 for details).
NOTE: You can have MobilePlanner add grid lines to the map to help
you place lines and areas more accurately. In MobilePlanner’s main
menu, click Map > Grid.
4. In the Draw pane, click Advanced Areas, then select the PreferredDirection from the
list.
5. Place the mouse cursor on the map where you want the preferred direction to start.
6. Click and hold the left mouse button, drag the mouse to where you want the preferred
area to end, then release the mouse button.
The new area appears on the map, and the Edit Advanced Area dialog box appears.
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Figure 11-10. Edit Advanced Area, PreferredDirectionLeft
Edit Advanced Line
Parameter

Definition

Name

Optional name for the preferred area.

Description

Optional description for the preferred area.

Type

Set to the type of preferred area you selected.

Angle

The preferred area’s rotation angle.

Corner

The X and Y coordinates of the preferred area’s starting corner.

Opposite

The X and Y coordinates of the preferred area’s ending corner.

UseDefaultSideOffset

True or False (Boolean) value. If set to:
l

l

True: uses the default side offset.
False: the AMR overrides the path planning settings
with the value of the PreferredDirectionSideOffset parameter.

Use Path Planning Settings to specify default settings (see Path
Planning and Collision Avoidance on page 205 for details).
PreferredDirectionSide
Offset
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Edit Advanced Line
Parameter

Definition

!

CAUTION: Setting this value too low can
cause the AMR to drive out of the preferred
area.

11.5 Controlling AMR Speed
You can control the AMR’s speed in certain areas by adding Movement Parameter Areas to
the map.

Adding Movement Parameter Areas to the Map
NOTE: Movement parameters take effect after the AMR is in them.
1. In MobilePlanner, click the Config button, then click the Robot Operations tab, then
select Map Features, then scroll down and click in the checkbox to enable MovementParameterSector.
2. Click the Map button to open the map you want to edit (see Using MobilePlanner Software on page 50 for details).
3. In the MobilePlanner main menu bar, click Map > Grid to display the grid lines on the
map.
NOTE: You can have MobilePlanner add grid lines to the map to help
you place lines and areas more accurately.
4. In the Draw pane, click Advanced Area, then select MovementParameters from the
pull-down menu.
The cursor changes to indicate it is in drawing mode.
5. Place the mouse cursor on the map where you want the area to start.
6. Click and hold the left mouse button, drag the mouse to where you want the sector to
end, then release the mouse button.
The new area appears on the map.

Editing Movement Parameter Areas
1. In the Draw pane, click Select, then click on the area you want to edit to highlight it.
2. Right-click on the highlighted area, and select Edit from the pop-up menu.
The Edit Advanced Area dialog box appears.
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Figure 11-11. Edit Advance Areas, MovementParameters
The following table describes the parameters available in the Edit Advanced Area dialog box.
Parameter

Definition

Name

An optional name for the area.

Description

An optional description for the area.

Type

Set to MovementParameters. If you select a different type of advanced
area, the highlighted area on the map changes to the selected type and the
dialog box updates.

Angle

The angle the area is rotated within the map.

Corner

The X and Y coordinates of the starting corner of the area.

Opposite

The X and Y coordinates of the ending corner of the area.

Parameters

Parameters that affect the AMRs’ behavior in the sector you drew on the
map. A value of 0 means use defaults.

11.6 Restricting Traffic
You can restrict the AMR's movement by adding forbidden lines and areas to the map. These
areas typically correspond to an area of the operating environment that you don't want the
AMR to enter, or in which you want to restrict the number of AMRs operating at the same
time (managed motion sectors). You can also add advanced features to the map that control
traffic flow based on certain conditions. For example, you might want the AMR to avoid an
area during monthly maintenance. You can set that up using switchable forbidden areas. You
might also have an area in which you want only one AMR at a time.
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You can set the parameters for these features in MobilePlanner by clicking the Config button,
then clicking the Robot Operations tab, and selecting Map Features.
The following features allow you to restrict AMR traffic in your operating space:
l
l
l
l

Adding Switchable Forbidden Lines and Areas to the Map on page 217
Using Resisted Lines and Sectors on page 220
Using Need-to-Enter Sectors on page 223
Using Single AMR Sectors on page 225 (helpful when you have multiple AMRs operating in the same environment)

Using Forbidden Lines and Areas
You can place lines and areas on the map that correspond to places in your operating environment where you do not want the AMR to go. You can also add lines and areas that can be
temporarily forbidden.
Forbidden lines are invisible barriers (virtual walls) in the operating space that the AMR will
not cross when driving in Autonomous Drive mode (the default driving mode). The cost of
map squares under a forbidden line is infinite. For more information see Manual Override on
page 80.
Forbidden areas are places in the map that you do not want the AMR to enter. For example, if
your operating environment has a loading dock that is open to the outside you might not want
the AMR to accidentally drive outside, and off the loading dock. The area might be accessible
on three sides, so you could place forbidden areas on the map corresponding to the loading
dock.
You can also add forbidden lines and areas that you can turn on and off (switchable forbidden
lines and areas).
Adding Forbidden Lines and Areas to the Map

NOTE: There are no required parameters for Forbidden Lines and Areas, which
are always enabled.
1. Click the Map button to open the map you want to edit. Refer to Using MobilePlanner
Software on page 50 for details.
NOTE: MobilePlanner can add grid lines to the map to help you place
lines and areas more accurately (main menu, click Map > Grid). Also,
ensure Show Robot is OFF.
2. In the Draw pane, click on either Forbidden Line or Forbidden Area.
The cursor changes to indicate it is in drawing mode, using a box around the icon to
indicate an area.
3. Place the mouse cursor on the map where you want the forbidden line or area to start.
4. Click and hold the left mouse button.
5. Drag the mouse to where you want the line or area to end and release the button.
The new forbidden line or area is selected and displayed in the map.
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Adding Switchable Forbidden Lines and Areas to the Map

You can have certain tasks activate switchable forbidden lines and areas. These tasks can
toggle individual lines and areas or they can toggle groups of switchable forbidden lines and
areas.
1. To enable the SwitchableForbiddenAreaAndLine parameter, click the Config button,
click on the Robot Operation tab, select Map Features, and click the checkbox to the
right of the SwitchableForbiddenAreaAndLine parameter.
NOTE: The server will automatically restart when you change the parameters.
2. Click the Map button to open the map you want to edit. See Using MobilePlanner Software on page 50 for details.
NOTE: You can have MobilePlanner add grid lines to the map to help
you place lines and areas more accurately. In MobilePlanner’s main
menu, click Map > Grid. Also, ensure Show Robot is OFF to enable the
Draw tools.
3. In the Draw pane, click Advanced Lines or Advanced Areas, depending on what you
want to add to the map.
4. Select SwitchableForbiddenLine or SwitchableForbiddenArea from the corresponding
pull-down menu.
The cursor changes to indicate it is in drawing mode, using a box around the icon to
indicate an area.
5. Place the mouse cursor on the map where you want the line or area to start.
6. Click and hold the left mouse button, drag the cursor to where you want the line or area
to end, then release the mouse button.
The new switchable forbidden line or area appears on the map, and the Edit Advanced
dialog box appears.
Editing Forbidden and Switchable Areas

NOTE: The following procedures only apply if you want to edit an existing
advanced area.
1. Verify Show Robot is OFF then, in the Draw pane, click Select.
2. Either double-click on the area or line in the map, or right-click and select Edit from the
pop-up menu.
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Figure 11-12. Edit Advanced Area, SwitchableForbiddenArea
The following table describes the options available in the dialog box.
Parameter
Name

Definition
A name for the forbidden area.
NOTE: Since you switch forbidden areas by name, it’s useful to use a common prefix when naming the ones you
want to group together.

Description

An optional description for the forbidden area.

Type

Not displayed for ForbiddenLine. If you select a different type of
advanced area in the drop-down list, the highlighted area on the map
changes to the selected type and the dialog box updates accordingly.

Angle

The forbidden area's rotation angle (in degrees) in the map.

Corner

The X and Y coordinates of the forbidden area's starting corner.

Opposite

The X and Y coordinates of the forbidden area's ending corner.

Editing a Forbidden Line or a Switchable Forbidden Line

1. Verify Show Robot is OFF then, in the Draw tab, click Select.
2. Either double-click on the line in the map, or right-click and select Edit from the pop-up
menu.
If you selected a forbidden line, the Edi Forbidden Line dialog box appears. The Edit
Advanced Line dialog box appears if you selected a switchable forbidden line.
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Figure 11-13. Edit Forbidden Line Dialog
Edit Forbidden Line
Parameter

Definition

Name

An optional name for the forbidden line.

Description

An optional description for the forbidden line.

Type

Displayed for SwitchableForbiddenLine. If you select a different
type of advanced line from the drop-down menu, the highlighted line changes to the selected type and the dialog box
updates.

Start Point

The X and Y coordinates of the starting point of the forbidden
line.

Opposite

The X and Y coordinates of the ending point of the forbidden line.

Switchable Forbidden Lines and Areas

There are two ways to turn on or off a Switchable Forbidden Line or Area:
l

Tasks

l

ARCL
NOTE: ARCL is outside the scope of this manual. Refer to the corresponding reference guides for those products.

There are four tasks you can use to turn a Switchable Forbidden Line or Area ON or OFF:
l

switchForbiddenOff

l

switchForbiddenOn

l

l
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switchForbiddenOffByPrefix (you can specify a text prefix that turns all switchable areas
with that prefix OFF)
switchForbiddenOnByPrefix (you can specify a text prefix that turns all switchable areas
with that prefix ON)
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Driving into a Forbidden Area

Occasionally you might need the AMR to drive into a forbidden area. You can make the AMR
do this by turning ON Manual Override mode, or using the pendant (even with Autonomous
Drive mode ON).
1. Click the Map button to open the map containing the forbidden area.
2. Attempt to drive the AMR into the forbidden area from multiple sides - the AMR
should slow down and stop just before the forbidden area.
3. Click Robot > Robot Tools > Manual Override to turn Autonomous Drive mode OFF.

!

WARNING: Turning Autonomous Drive mode OFF disables the AMR's
obstacle-avoidance (of obstacles detected by the navigation laser) at
speeds under 300 mm/s. Use extreme caution when driving the AMR
under these circumstances.

4. Select Yes to turn Autonomous Drive mode OFF.
5. Drive the AMR into the forbidden area. This time the AMR should drive into the area.
NOTE: Manual Override must remain ON to drive the AMR out of the forbidden area. Notice that the background color of the map changes to yellow
when Manual Override is turned ON.

Using Resisted Lines and Sectors
You can add lines and areas to the map, called resisted lines and sectors, that the AMR will
attempt to avoid because they cost more to drive through. The AMR's path planning system is
similar to a GPS system that recalculates a route to avoid road construction. However, if
another route is not available, the AMR follows the original. Similarly, the AMR will resist
entering a sector or crossing a boundary if it is possible to avoid it; however, if it needs to
drive through a resisted sector to reach its goal, it will.
Adding Resisted Boundaries and Sectors to the Map

1. In MobilePlanner > Config > Robot Operation > Map Features, enable ResistedSectorAndLine. See Setting the Configuration Parameters on page 142
2. Save your change to the AMR.
3. Click the Map button to open the map you want to edit.
NOTE: You can have MobilePlanner add grid lines to the map to help
you place lines and areas more accurately. In MobilePlanner’s main
menu, click Map > Grid.
4. Ensure Show Robot is OFF, then click Draw > Advanced Lines or Draw > Advanced
Areas, depending on what you want to add to the map.
5. In the pull-down menu, select ResistedLine or ResistedSector, and note that the cursor
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changes to indicate that it is in drawing mode (has a box around the icon to indicate an
area).
6. Place the mouse cursor on the map where you want the resisted line or sector to start.
7. Click and hold the left mouse button.
8. Drag the mouse cursor to where you want the line or sector to end and release the button to display the new resisted line or sector in the map, and the Edit Advanced Area
dialog box.
Editing Resisted Sectors

1. Verify that Show Robot is OFF and, in the Draw tab, click Select.
2. Either double-click or right-click on the sector in the map and select Edit from the popup menu.

Figure 11-14. Edit Advanced Area, ResistedSector
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Edit Advance Area
Parameter

Definition

Name

A name for the resisted sector.

Description

An optional description for the resisted sector.

Type

Set to ResistedSector. If you select a different type of
advanced area, the highlighted area changes to the new type
and the dialog box updates.

Angle

The rotation angle of the resisted sector in the map.

Corner

The X and Y coordinates of the resisted sector’s starting corner.

Opposite

The X and Y coordinates of the resisted sector’s ending corner.

UseDefaultResistance

(Boolean) value. A True setting uses the default resistance setting , and ignores the Resistance value (default settings are set
using the Path Planning Settings - see Path Planning and Collision Avoidance on page 205).
If this is False, the AMR overrides the path planning settings with
the value of the Resistance parameter.

Resistance

(Integer) Determines the cost of crossing the area. Defines how
much the AMR will resist driving through a particular sector, and
find an alternative path. The cost of driving through a resisted
sector is multiplied by its resistance value. A normal area or sector has a cost value of 1. Set this value to 1 to turn off the resistance behavior.

Editing Restrictive Lines

1. Verify that Show Robot is OFF and, in the Draw tab, click Select.
2. Double-click (or right-click) on the boundary in the map, and select Edit from the popup menu.

Figure 11-15. Edit Advanced Line, ResistedLine
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Edit Advanced Line
Parameter

Definition

Name

A name for the resisted boundary.

Description

An optional description for the resisted boundary.

Type

Set to ResistedLine. If you select a different type of advanced
area, the highlighted area changes to the new type and the dialog box updates.

Start Point

The X and Y coordinates of the starting corner of the resisted
boundary.

End Point

The X and Y coordinates of the ending corner of the resisted
boundary.

UseDefaultResistance

(Boolean) A True setting uses the default resistance setting (set
in the Path Planning Settings in the Advanced Areas pull-down
menu). See Path Planning and Collision Avoidance on page 205
for details. If False, the AMR overrides path planning settings
with the Resistance parameter value.

Resistance

(Integer) Determines the cost of crossing a boundary, how much
the AMR resists driving across it, and finds an another path. The
cost of driving across a boundary is multiplied by its resistance
value. A normal area has a cost of 1, so set this value to 1 to turn
off the resistance behavior.

Using Need-to-Enter Sectors
You can add areas to the map that only allow the AMR to enter if the goal the AMR is trying
to reach is inside the sector. These are referred to as need-to-enter sectors. If the AMR is already
in a need-to-enter sector, it can drive around in the sector or drive out of it.
Need-to-enter sectors are useful in (for example) cases in which there are loading or unloading
areas where another AMR could cause congestion if it tries to pass through.
Adding Need to Enter Sectors to the Map

1. In MobilePlanner > Config > Robot Operation > Map Features, enable NeedToEnterSector. For details on how to do this, see Configuring the AMR on page 140.
2. Save your change to the AMR.
3. Click the Map button to open the map you want to edit.
NOTE: You can have MobilePlanner add grid lines to the map to help
you place lines and areas more accurately. In MobilePlanner’s main
menu, click Map > Grid. Also, ensure that Show Robot is OFF to enable
the Draw tools.
4. Click Draw > Advanced Areas.
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5. Select Need to Enter from the pull-down menu, and note the cursor changes to indicate
it is in drawing mode.
6. Place the mouse cursor on the map where you want the sector to start.
7. Click and hold the left mouse button.
8. Drag the mouse cursor to where you want the sector to end and release the button. The
new need-to-enter sector highlights and appears in the map, and the Edit Advanced
Area dialog box appears.
Editing Existing Need-to-Enter Sectors

1. Click Select.
2. Either double-click on the resisted sector in the map, or right-click on the sector and
select Edit from the pop-up menu to display the Edit Advanced Area dialog box.

Figure 11-16. Edit Advanced Area, NeedToEnter
The following table describes the options available on the Edit Advanced Area dialog box.
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Parameter

Definition

Name

A name for the need-to-enter sector.

Description

An optional description for the need-to-enter sector.

Type

Set to NeedToEnter. If you select a different type of advanced area, the
highlighted area on the map changes to the selected type and the dialog
box updates accordingly.

Angle

The angle the sector (rectangle) is rotated within the map.

Corner

The X and Y coordinates of the starting corner of the sector.

Opposite

The X and Y coordinates of the ending corner of the sector.

Using Single AMR Sectors
Single AMR sectors allow you to add areas to the map that only allow one AMR at a time to
be in the specified area. This is useful for narrow hallways or narrow areas with only one
entry/exit.
Adding Single AMR Sectors to the Map

1. In MobilePlanner > Config > Robot Operation > Map Features, enable SingleRobotSector. See Configuring the AMR on page 140 for details.
2. Save your change to the AMR.
3. Open the map you want to edit. See Using MobilePlanner Software on page 50 for
details.
4. Ensure Show Robot is OFF, then click on the Grid toolbar icon to display the grid lines
on the map. This helps you to place the lines and areas more accurately.
5. Click Draw > Advanced Areas.
6. Select SingleRobot from the pull-down menu (the cursor changes to indicate that it is in
drawing mode).
7. Place the mouse cursor on the map where you want the single AMR sector to start.
8. Click and hold the left mouse button.
9. Drag the mouse cursor to where you want the sector to end and release the button to
highlight the new area in the map.
Editing Existing Single AMR Sectors

1. Click Select.
2. Either double-click on the sector in the map, or right-click on the sector, and select Edit
from the pop-up menu to display the Edit Advanced Area dialog box.
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Figure 11-17. Edit Advanced Area, SingleRobot
The following table describes the options available on the Edit Advanced Area dialog box.
Parameter

Definition

Name

A name for the single AMR sector.

Description

An optional description for the single AMR sector.

Type

Set to SingleRobot. If you select a different type of advanced area from
the pull-down menu, the highlighted area on the map changes to the
selected type and the dialog box updates accordingly.

Angle

The angle the sector is rotated within the map.

Corner

The X and Y coordinates of the starting corner of the area.

Opposite

The X and Y coordinates of the ending corner of the area.
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When a moving AMR is operating in an environment such as an office building or a warehouse, it must have some way of tracking its position and orientation on a map. This tracking
is called localization. Accurate localization is a prerequisite for autonomous navigation.
This section discusses the types of localization your AMR uses. For more information, refer to
the following:

12.1 What is Localization?
Localization is the way in which the AMR knows its location on the map. It is a process the
AMR uses to estimate its position in its environment based on data collected during operation.
Currently, the AMRs can use two types of localization:
l

l

Laser localization uses data from the AMR's laser in conjunction with the map to calculate the AMR's position. This is the default way the AMR keeps track of its position
in the operating space and is most useful in a static environment such as an office
building or hospital.Using Laser Localization on page 231.
Optionally, an AMR can use overhead lights to track its position in the environment.
This localization process is often used in dynamic environments, such as a warehouse,
where objects move too frequently for the AMR to localize based on their past positions.
Using Acuity For Light Localization on page 235.

The key to localization is obtaining an accurate map of the environment (see Working with
Map Files on page 90). The AMR compares the map to the data collected from its sensors to
correct its position. With this information, the AMR knows its position on the map.
NOTE: The AMR combines data collected with either of these methods with
data from encoders on its wheels and the gyroscope in its core to determine its
location.

Overview of Localization Process
Localization requires an iterative process of correcting for errors in the AMR odometry. When
an AMR is powered up, it must determine its initial position (which could be its last position
when it shut down). During operation, the AMR calculates the current position based on its
last known position, along with the AMR's speed and direction. The AMR periodically recalculates its position to make sure it knows where it is. If the AMR cannot calculate a reliable
pose, it is lost and must stop. After the AMR recalculates its position, the current location
becomes the last known location.

12.2 Comparing Laser and Light Localization
The AMR can use data from its laser or from an upward-facing camera viewing the position
of overhead lights (or a combination of the two), to accurately determine where it is in its physical space and in the map.
The following table highlights the differences between laser and light localization. For more
information on each localization process, refer to the appropriate section.
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Laser Localization

Light Localization

Description

Uses a laser range finder
located on the AMR to
perform localization.

Uses a camera located on the AMR to
monitor overhead lights in the environment as points of reference to perform localization.

Equipment

Laser range finder (stand- Upward-facing camera option.
ard)

Accuracy vs. Reli- Provides more accurate
ability
location data, but the
AMR cannot deal with
highly dynamic environments.

Provides more reliable localization in a
dynamic environment, because there is
less chance for the AMR to get lost, but
the AMR positioning is less accurate.

Recommended
Environment

Dynamic (such as a warehouse)

Static (such as an office
building)

12.3 What Causes the AMR to be Lost?
When an AMR no longer has enough confidence in its position, it broadcasts that it is lost,
and stops driving until a human intervenes. When an AMR is lost, it stops moving and broadcasts a notification (in the form of the dialog box below) that it needs attention.

Figure 12-1. Localization Dialog - Lost Robot
Localizing a Lost AMR

1. Click Localize to Point in the lost AMR dialog box.
2. Click and hold the mouse on the map where you want to localize the AMR (at the
AMR’s current physical location) and, while holding the left mouse button, drag the
mouse cursor to set the AMR's heading.
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The Localization Score (or confidence threshold) should be 80% or better for optimum
navigation.
3. Click Done when the AMR's localization score is where you want it to be.

Adjusting the Confidence Threshold
The PassThreshold and LostThresholdDistance parameters (for laser localization) and LockThreshold and LostLockUncertaintyThreshold parameters (for light localization) set the criteria
for when an AMR is lost. With each localization, the AMR generates a localization score. The
AMR is not considered lost until the localization score drops 20% below the PassThreshold
parameter (for laser localization) or -100 on the LostLockUncertaintyThreshold (for light localization), and fails to recover. Once the localization score drops below PassThreshold/LockThreshold, the AMR will move up to
LostThresholdDistance/LostLockUncertaintyThreshold, trying to raise its score. If it fails, it is
considered lost. You can adjust the parameter values as needed.
LostThresholdDistance is the maximum distance (in mm) that the AMR will move from the
last localized pose before the AMR will be considered lost. This parameter will only come into
play if none of the samples during the sensor correction is higher than PassThreshold. As soon
as this happens, the position uncertainty distance will grow based on the movement from the
last localized pose.
1. In MobilePlanner, click the Config button, then click the Robot Operation tab, and
select Localization settings (or Light Localization settings).
2. Click on the PassThreshold Value (or LockThreshold value for light localization) field
and enter a new threshold value (the minimum score to consider the AMR localized ).
3. Click on the LostThresholdDistance Value (or LostLockUncertaintyThreshold value for
light localization) field and enter a new distance value if desired.

12.4 Optimizing Localization
Localization accuracy depends on the accuracy of the map and sensor measurements. Typically, the AMR should be able to localize in most indoor environments. Occasionally, however, the AMR encounters situations in which it has trouble localizing, which can impact its
ability to navigate.
The most common problem with localization is map accuracy. It might not have been accurate
enough to begin with, or the environment might have changed enough (partitions moved, etc.),
that the map no longer reflects the working environment.
You can improve localization accuracy, to some extent, by adjusting the localization parameters. However, changing one parameter generally affects other parameters. Therefore you
will likely need to adjust several parameters to fine tune the localization score.
Laser and Light Localization use different parameters that you can adjust. Those parameters
are discussed in Localization Parameters on page 232 and Light Localization Parameters on
page 238 respectively. However, there are a few general guidelines to consider before you
change parameter values.

Before Changing Parameter Values
Before changing any parameters (localization or other), make sure your map contains as much
accurately scanned data as possible. The more static features the map has (walls, doors,
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shelves, etc.), the better the AMR is at navigating its way through the space.
l

l

l

Don't erase any data from the map unless those points really do not correspond to any
real, fixed object.
Re-scan areas where features have been removed from or added to an area in the environment.
If there were errors in the map-making process, and your map does not match the real
space, re-scan the area again more carefully.

!

CAUTION: Before changing parameters, save a copy of your current
config file. When experimenting with parameters, try one parameter or a
small combination of parameter changes at a time. Revert to your saved
config file if the AMR's performance does not improve. See Configuring
the AMR on page 140.

12.5 Using Laser Localization
OMRON AMRs use one of two methods to locate their position in their environment: laser or
light localization. For more information on using light localization, refer to Using Acuity For
Light Localization on page 235.
Laser localization uses a laser range finder, located on the AMR, to detect walls and other
objects in the environment. The data collected from the laser is combined with the AMR's odometry information and the map, which enables the AMR to determine its location.

Overview of Laser Localization
The most common way to localize an AMR in a given space is to use a laser range finder. The
laser range finder takes a planar snapshot of the environment, then compares this with the
map of the environment to determine the AMR's position. This is a relatively accurate method
of localization for environments that tend to be static, such as an office space.
If the laser localization cannot match the laser readings to the map, it does have some logic
that allows the AMR to drive for a while before reporting that it is lost. However, this is only
useful in temporary situations, such as the AMR driving through a small area where a group
of people have gathered.
In a dynamic space where unmapped cargo and equipment move in and out of the area (such
as in a warehouse), data from the unmapped objects can easily overwhelm the mapped data,
causing the laser localization to fail. In these situations, it is better to use light localization. See
Using Acuity For Light Localization on page 235 for details.
Key Features
l

231

Laser localization gives accurate positioning data for precise navigation, particularly in
a relatively static environment.

l

No potentially expensive retrofitting required to use laser localization.

l

The map only needs to be updated if there is a change in the static environment.
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l

The AMR continues to operate even if some of the map features have changed, resulting
in a flexible solution.

Limitations of Laser Localization
Laser localization is an accurate method of localization in a static environment such as an
office, but has some limitations to consider:
l

l

l

The laser cannot see glass, mirrors, or shiny objects. Environments with a lot of these
objects make it difficult for the AMR to localize.
In dynamic environments in which objects frequently change positions (such as a warehouse), laser data might not match mapped data closely enough for the AMR to localize. In these areas, the map won't contain objects added or moved after you created
the map.
In an environment with a lot of high racks for the AMR to navigate through, the confidence threshold could fall below 20% and cause the AMR to become lost.

Localization Parameters
In MobilePlanner, you can access the AMR's localization parameters and adjust them as
needed.
To access the laser localization parameters, click the Config button, then click the Robot Operation tab, and select Localization settings.
Improving Accuracy and CPU Usage

For laser localization, two settings directly affect the CPU usage for each localization:
l

l

GridRes represents the size of the grid used for localization. The smaller the value is,
the more accurate the localization score.
NumSamples represents the number of poses sampled (or checked) each time the AMR
moves; this number scales linearly, so adjusting a value of 2000 to 3000 takes up 1.5
times more processing power.

Other factors, such as TriggerDistance and TriggerAngle determine how often it attempts to recalculate (or re-localize) its position. Recalculating uses a lot of CPU so, if the value of
NumSamples is set too high, the AMR will localize less often. This can actually cause more
problems than an AMR that localizes less accurately, but more often.
The K parameters (KMmPerMm, KDegPerDeg and KDepPerMm) are error parameters, and are
explained below.
Using Laser Localization Parameters

With MobilePlanner, you can access the AMR's configuration parameters and adjust them as
needed.
To access the laser localization parameters, click the Config button, then click on the Robot
Operation tab, and select Localization settings.
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In general, high CPU use for one laser scan might prevent the AMR from scanning as often as
needed. Setting these parameters requires balance.
You can change parameters that affect the level of detail in an AMR's scan, how many possible locations (poses) the AMR will compare those results with, and how frequently, both in
time and travel, it rechecks its location. There are also parameters to adjust the amount of
expected error, both linear and rotational.
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Localization Parameters and Effects on CPU Use
Parameter

Description

Effect(s) on Localization

AdjustNumSamples
Flag

Varies the number of
samples based on the
localization score.

When enabled, lowers the number of
samples when the AMR is moving and
the localization score is high. Reduces
CPU demand.

AngleIncrement

Separation (in degrees) Discards readings too close together.
required between laser Reduces CPU demand.
settings used for localization.

GridRes

Resolution (in mm) of
map grids.

Scan resolution. Decreasing this value
increases localization accuracy, but
increases demand on RAM.

KMmPerMm

Millimeters of linear
error per linear millimeter of travel.

Allowed percentage error (in mm) of the
AMR’s linear odometry readings. If set
too high, sample poses are too spread
out for the AMR to determine its location. If set too low, the AMR might not
be able to localize.

KDegPerDeg

Degrees of error per
degrees rotated.

Allowed percentage error (in deg) of the
AMR’s rotational odometry readings. If
set too high, sample poses too spread
out for the AMR to determine its location. If set too low, the AMR might not
be able to localize.

KDegPerMm

Degrees of error per lin- Allowed error (in deg) of the AMR’s rotaear mm traveled.
tion per one mm of linear travel. If set
too high, sample poses too spread out for
the AMR to determine its location. If set
too low, the AMR might not be able to localize.

NumSamples

Number of pose
samples AMR uses for
localization.

Scan resolution. Increasing this value
increases localization computations. If
too low, the AMR fails to localize.

TriggerDistance

Distance AMR travels
(in mm) before localizing.

How often to localize – helps reduce CPU
demand. The AMR only localizes when it
travels beyond listed value.

TriggerAngle

Angle (in deg) AMR
turns before triggering
localization.

How often to localize – helps reduce CPU
demand. The AMR only localizes when it
rotates beyond the listed value.
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12.6 Using Acuity For Light Localization
Light Localization uses a wide-angle camera mounted on the AMR to detect the fixed overhead lights in the operating environment. After combining light position data with its odometry readings and map data, the AMR knows where it is in physical space on its map.
NOTE: The navigation laser remains active for obstacle avoidance even when
not being used to for navigation.
NOTE: Acuity Localization is not yet available for the HD-1500 AMR.

Overview of Light Localization
Using overhead lights as landmarks, the AMR is able to reliably calculate its position within
its environment.
Light Localization allows the AMR to localize in a dynamic environment where change is frequent. A warehouse, for example, includes many boxes, pallets, vehicles and people that move
frequently. In this situation, the AMR can use the overhead lights to determine its position in
the environment. The AMR uses both camera and odometry data to calculate its current position.
Key Features

Key features of light localization include:
l

No expensive retrofitting required to use light localization.

l

The lights do not require special maintenance.

l

l

l

Because the lights are overhead, they are not blocked by ground level obstructions that
could prevent laser sensors from working.
The map does not need to be updated because the light positions typically do not
change.
Even if some lights have failed, the AMR still has a reliable solution and continues to
operate.
NOTE: Using light localization in spaces with lights at different heights, or
places with lights visually behind others, can require different scanning techniques not covered in this guide. For details, see the Mobile Robots - LD Platform
Peripherals Guide.

Creating the Light Map
Before creating a Light Localization map, be sure you are familiar with creating an initial map
scan. Refer to Scanning the Operating Area on page 88 for more information.
NOTE: When scanning the operating environment using Light Localization, be
sure to drive under the lights or as close to the lights as possible. You need to do
this in more than one direction, to make sure the camera sees the lights from all
angles, collecting pan and tilt data along the way.
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Compared with laser localization scan files, Light Localization scan files contain additional
information about the AMR's operating environment and, therefore, require extra processing
steps. The resulting map files also contain information about the location and height of overhead lights detected during the scanning process.
Light Localization is only available on AMRs equipped with the Acuity option, and you must
enable the LightLocalization parameter in the MobilePlanner software to activate it. Refer to
Configuring the AMR on page 140 for details.
Adjusting the Light Analysis Parameters

1. In MobilePlanner’s Config window, select Robot Configuration.
2. Click on the Light Analysis section from the left window pane to view parameters associated with the light analysis in the right window pane.
3. Select Show Expert Parameters to access the main light analysis parameters.
The following table describes the most important parameters for light analysis:
Parameter Name

Description

3d:MinLightHeight

Minimum height (in mm) of the lights above the floor. This value is
approximate and should be lower than the real value. It is used to
establish a valid range and eliminate false positives (Double).

3d:MaxLightHeight

Maximum height (in mm) of the lights above the floor. This value
is approximate and should be higher than the real value. It is used
to establish a valid range and eliminate false positives (Double).

3d:MinLightLength

Minimum length (in mm) of the lights. This value is approximate
and should be slightly lower than the real value. If -1, then this
value is ignored (Double).

3d:MaxLightLength

Maximum length (in mm) of the lights. This value is approximate
and should be slightly higher than the real value. If -1, then this
value is ignored (Double).

Set the 3d:MinLightHeight and 3d:MaxLightHeight parameters to a range that encompasses
the ceiling and light heights, but not too large.
If the lights are fluorescent tubes or the lights are partially hidden from the camera's view, you
may also need to adjust the 3d:MinLightLength and 3d:MaxLightLength parameters.
After making these adjustments, reprocess the light scan in MobilePlanner. This does not
require redoing the laser portion of the map creation, just reprocessing the light data.
Creating the Light Map

1. Turn all lights ON in the operating environment.
2. Open MobilePlanner and start the scan process. See Scanning the Operating Area on
page 88 for details.
3. Drive the AMR around the environment, paying special attention to the overhead
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lights. Drive under the overhead lights in several directions.
4. Stop the scan.
5. Turn the scan into a map (see Convert the Scan into a Map on page 89 for details).
6. Verify the scanned map shows overhead lights in the correct position and with the correct height.
You can view the height data by moving the mouse over the light icon on the map. The
overhead lights appear as blue squares, rectangles or points (depending on the type of
light), as shown below.

Figure 12-2. MobilePlanner Light Map - Detail
7. If the light map looks correct, click Finish on the Scan Tools toolbar.
8. If the light map does not look correct, you will need to adjust the light analysis parameters and reprocess the scan. See Adjusting the Light Analysis Parameters on page
236 for details.
By default, the overhead lights are hidden from the map after turning the light scan into a
light map. You can view the lights by selecting Map > Map Data > Light Items from the
MobilePlanner main screen.
The light map contains data (such as height) about the lights seen by the camera, but does not
contain images of the lights themselves.

Limitations of Light Localization
Light Localization is a reliable method of localization, even in a dynamic, frequently changing
environment such as a warehouse. The number of lights visible lights affects the accuracy of
the AMR's estimated position and, if the AMR travels for a long time in a sparsely lighted
area, it will end up with a low localization score. However, in general, the AMR tends not to
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get lost as often using light localization which is, therefore, more reliable in a dynamic environment.
Consider the following limitations:
l

The lights must be on and visible for light localization to work.

l

Skylights can be problematic.

l

l

l

l

l

l

l

Currently, light localization works with LED lights, can lights (displayed as squares on
the map) and fluorescent tube lights (displayed as rectangles).
The more lights visible to the AMR, the better. Light localization does not work well
with only one or two lights in an area.
The lighting must be direct. The AMR must see a bulb or diffuser, not just a light reflection off of another surface.
An environment that has lights of varying brightness might have problems.
The tilt of the camera is assumed to be fixed. A change to this, such as when the AMR
is on a tilted floor in the building, adversely affects the light localization.
The accuracy of the localization depends on the accuracy of the light map. If the lights
in the map are incorrect due to mapping errors, the localization will show a similar offset.
The vertical distance from the camera to the lights should be at least a couple of meters
for the light localization to work well. If the lights are too close to the camera, the error
will be more than when the lights are farther away.

Light Localization Parameters
In MobilePlanner software, you can access the AMR's configuration parameters and adjust
them as needed.
Accessing Light Localization Parameters

1. Select Config > Robot Operation from the main menu.
2. Click on the Light Localization settings section from the left pane to see parameters associated with the light localization in the right pane.
NOTE: The parameters for light localization are described in the software, and
are not repeated here.
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The following table lists acronyms and abbreviations, and defines key terms found in this user
guide:
Term

Definition

802.11a, b, g, n,
or ac

Standard for wireless local area networks (WLAN) in the 2.4GHZ and
5GHz frequency bands.

Acuity

AMR-mounted camera system for localizing the AMR using overhead
lights versus its laser.

AES

Advanced encryption standard

AIFF

Audio interchange file format

AMR

Autonomous mobile robot

ARAM

Advanced robotics automation management

ARC4

Alleged Rivest Cipher 4 (RC4)

ARCL

Advanced Robotics Command Language. A simple, text-based, command-and-response operating language. Used with the Fleet Manager,
ARCL can help manage a fleet of AMRs.

ARP

Address resolution protocol

A/V

Audio/Visual

Boolean

A type of data with two possible values, usually ‘true,’ or ‘false.’

CA

Certificate Authority

CAPS

Cell Alignment Positioning System. A software option that uses a fixedmount target in the workspace to provide more accurate AMR positioning
when approaching a destination.

CCMP

Counter mode with Cipher block chaining message authentication code
protocol.

Cost

An arbitrary numeric value assigned to map grids, lines, routes, etc. to
determine the cumulative, net effect of an AMR’s actions. Breaks maps
into discrete squares called grids. Squares with walls, etc. have an infinite
cost, and free squares, by default, have a value of 0.1. By design, AMRs
always seek to execute their assigned tasks and goals at the lowest possible cost.

Cost-Based Path

A method of planning optimal, ‘least expensive’ paths from “point a” to
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Planning

“point b” for the AMR to follow.

CPU

Central processing unit

DER

Distinguished encoding rules

DHCP

Dynamic host configuration protocol

DNS

Domain name service

Dock

Map location where the AMR “looks for” the charging station. Dock map
icon should be 1 to 1.5 meters in front of the charging station, with the
dock icon’s black line pointing to the charging station.

DROPOFF

Job segment classification - tells the Fleet Manager that only a specific
AMR can be assigned to the job segment.

EAP

Extensible authentication protocol

EAP-FAST

EAP flexible authentication via secure tunneling

EM2100

A network appliance that hosts the FLOW Core software. All fleet management capabilities of the FLOW Core software run on the EM2100 appliance.

Ethernet

A type of computer network used in local area networks. Typically uses a
Category 5 (CAT5) or (CAT6) Ethernet cable; supports data speeds up to
100 MHz.

FIFO

First-In-First-Out - refers to the method used to prioritize jobs (higher
number equals higher priority).

Fleet

A group of AMRs that operate in the same area, share the same map, and
are controlled by one standalone Fleet Manager or a Paired Primary Fleet
Manager, operating with a Paired Secondary Fleet Manager.

Fleet Manager

The set of capabilities within the FLOW Core software that executes all
fleet management activities. These include the management of maps,
AMR configuration, job queue management, and traffic coordination.

Forbidden (lines,
areas)

Lines or areas onto or into which the AMR must not drive or enter on its
own. In special cases, you can manually drive an AMR into a forbidden
area.

Goal

Map-defined virtual destination(s) for AMRs (e.g., pickup or drop-off
points).

GUI

Graphical User Interface

HAPS

High accuracy positioning system. Uses add-on sensors which detect and
follow magnetic tape applied to the floor. Allows for very precise AMR positioning.

IP

Internet protocol. IP address is a computer’s unique internet “address”.
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Job

An AMR activity, usually consisting of either one or two “job segments”.
(either PICKUP or DROPOFF). The Fleet Manager receives all job requests
from ARCL.

LAN

Local Area Network

LEAP

Lightweight EAP

License Dongle

A USB device that contains the software ( license key) required to run a
licensed program.

Localization

The process by which AMRs determine their location in their operating
environment. Laser localization uses the AMR’s laser to scan its environment which it compares to its internal environment map. In light localization, the AMR uses overhead lights to determine its location.

Macro

A virtual “container” with a series or sequence of nested tasks and/or
goals. Similar to routes. You can use macros as many times as needed to
perform the same sequence of discrete functions in different tasks.

MARC

The Mobile Autonomous Robot Controller (MARC) firmware computes and
reports the AMR's odometer (X. Y, and heading) readings and other lowlevel operating conditions to ARAM.

MobilePlanner

The primary software application for programming AMR actions.

MobilePlanner
(Operator Mode)

A limited-functionality version of the MobilePlanner software. Has tools to
monitor AMRs, AMR statistics, monitor and add jobs. Does not have tools
to create or edit maps.

MSCHAPv2

Microsoft challenge handshake authentication protocol version 2

MP3

Moving picture experts group (MPEG) -2Audio Layer III

OS

Operating system (e.g., Mac OS, Windows OS, MARC, SetNetGo OS, etc.).

Path

The manner in which the AMRs drive from place to place in their environment.

PEAP

Protected extensible authentication protocol (EAP)

PEM

Privacy enhanced mail

Pendant

A handheld, external input device for manually driving AMRs. Connects to
the AMR’s pendant connection port.

PICKUP

A job segment classification - tells the Fleet Manager that any available,
appropriate AMR can be assigned to the job segment.

PKCS

Public key cryptography standards

Platform

The base AMR (with or without payload) – includes chassis, drive train,
suspension, wheels, battery, safety scanning laser, sonar, on-board core
with gyroscope and software to navigate, interface connections for payload, and covers.
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Pose

An AMR’s position (location and heading).

PrecisionDrive

Using a target in the environment to aid in more accurate maneuvering.
Targets can be placed on charging stations and other locations where you
need accurate positioning. Associated with certain tasks.

Preferred (lines,
directions)

Lines, directions you want the AMR to travel.

PSK

Pre-shared key

RC4

Rivest Cipher 4 (aka ARC4 – Alleged RC4)

Resisted (lines,
areas)

Lines and/or areas the AMRs resist (attempt to avoid) crossing or entering, unless it must drive over/through resisted lines/areas to reach a
goal.

Route

A “to do” list or series of tasks, goals, or macros for the AMR to follow.

Safety
Commissioning

Allows testing and commissioning (verification of proper function) of an
AMR's on-board safety systems. Uses a wizard to test E-Stop (tests brake
activation) and Safety Laser (tests max speed limits and obstacle detection). Per EN-1525, Commissioning must be done by specially trained
people.

Sector

Map areas that direct specific AMR actions, like ignoring sensor readings,
driving on the right or left, limiting the number of AMRs in the area at one
time, etc.

SetNetGo

Software OS, resides on AMRs and the Fleet Manager appliance. Used to
configure AMRs’ communication parameters. Accessed via the SetNetGo
tab in MobilePlanner.

SNG

SetNetGo.

Spline

Mathematical function for smoothing arcs and curves.

SSID

Service Set IDentification – identifies a wireless LAN

Tasks

Instructions for the AMR to perform certain actions like reading inputs,
setting outputs, movement commands, talking, waiting, etc. Tasks have
adjustable parameters, which can be individually set for each copy of the
task. There are two types of tasks; instant (allows concurrent processing
of tasks while original task is executing), and non-instant (can interrupt a
currently running task).

TCP

Transmission control protocol

TKIP

Temporal key integrity protocol

TLS

Transport layer security

Virtual Doors

Specially designated areas on the AMR’s map which the AMR performs certain tasks (like ‘move’ or ‘say’ tasks, flashing lights, etc.) and/or allow the
AMR to drive through special areas (e.g., plastic curtains).
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WAVE

Waveform audio file format with an extension of .wav.

WEP

Wireless equivalent privacy

WPA

WiFi protected access
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